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1 Introduction
This is the user guide for Viz World Classic (previously known as Viz Curious Maps). It is designed 
to fit people with no or little experience in using the Viz World Client and Server. The purpose of 
this document is to help new users become familiar with the client; to illustrate the client’s editor, 
and to show the available options.

This guide provides reference information about the program’s more advanced features. These 
include selecting map details, working with style sheets, importing and working with street data, 
adding text and graphics, creating drawings from vector shapes, adding effects with lighting and 
effects, and controlling animation.

1.1 Document Structure
Title Content

Quick Tour Provides a complete introduction to using Viz World Classic on the PC, and is 
the recommended starting point for anyone learning to use the program. It 
provides a series of short worked examples, each of which takes you on a quick 
guided tour of the program’s key features to show what it can achieve and help 
you become familiar with the user interface.

Working with 
Maps

Explains the options for creating and working with map layers, including using 
the Properties panel to define the projection, and using the Contents panel to 
select countries and places for incorporation into the map.

Working with 
Styles

Explains how to use the style sheets to make it easy to set up a series of house 
styles, and convert projects between house styles with a single click. It also 
explains how style sheets help to establish consistency across projects, or 
between designers.

Reusing 
Design 
Elements

Explains how you can easily reuse styles, layers, and colors created in 
earlier projects and gives recommended techniques for setting up and sharing 
style sheets, templates, and projects between users.

Working with 
Street Maps

Explains how to import street data and draw it on your maps to create maps 
from the whole world, down to a single street corner or building.

Adding Text 
to a Project

Explains how to incorporate text into projects, and describes how to control the 
appearance of the text and the way it is animated.

Working with 
Images and 
Movies

Explains how to incorporate bitmap images and movies into animations, and 
describes the controls available for altering their appearance, and controlling 
the way they are animated.



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  20

•
•

•
•
•

Title Content

Working with 
Shapes

Explains how to add drawings to a map by creating vector shapes, either using 
separate shape layers or by adding shape details to map layers. It also explains 
how you can create and edit shapes, and change their appearance to achieve 
exactly the effect you want.

Working with 
ESRI Shape 
Files

Describes how to import map data in ESRI Shape File Format, and configure it 
for use with Viz World Classic.

Lighting and 
Effects

Explains how to use the lighting and effects features, to enable you to add 
shading and depth to your map animations and give them a unique and 
distinctive appearance.

Controlling 
Animation

Explains how to use the time slider to control the progress of an animation. It 
also describes how to use the tool to set up impressive animations with a few 
simple clicks, and the Keybars panel to provide individual control over each 
component of a project.

Rendering a 
Project

Explains how to render your animation as a preview, or as a finished movie. It 
also describes the options for exporting an image or a 3D model from a project.

1.2 Related Documents
For complementary information, see the following documents:

Viz Artist User Guide: Information on how to create graphics scenes in Viz Artist.
Viz World User Guide: Information on how to use Viz World Client and Server to setup a map 
server solution and build map template graphics for newsroom and control room systems.

For more information about all of the Vizrt products, visit:

www.vizrt.com
Vizrt Documentation Center
Viz University

1.3 Feedback And Suggestions
We encourage suggestions and feedback about our products and documentation. To give feedback 
and/or suggestions, please contact your local Vizrt customer support team at www.vizrt.com.

http://docs.vizrt.com/viz-artist.html
http://docs.vizrt.com/viz-world.html
http://www.vizrt.com/
http://documentation.vizrt.com/
https://www.vizrt.com/community/viz-university
http://www.vizrt.com/
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2 About Viz World Classic
Viz World Classic, formerly called Viz Curious Maps, is the standalone edition of Viz World that 
allows designers to create branded, animated 2D maps.

Viz World Classic is ideal for designers, program researchers, and producers who need to create 
high-quality map animations for news, documentary, promotional videos, and the World Wide Web.

It is designed to be simple and intuitive to use, so that users with no specific training in computer 
graphics or video editing can create professional maps on demand and at short notice.

This section contains information on the following topics:

Comprehensive Map Database
Street Data Configured Ready for Use
Projects, Layers and Other Elements
Establish House Styles for Consistency Across Projects
Shapes
Rotoscoping with Shapes
Animation
Compositing and Animation
Painting and Effects
Sophisticated Lighting and Filtering Effects
High-quality Output

2.1 Comprehensive Map Database
At the heart of Viz World is the comprehensive Collins Bartholomew database of the world, 
defining countries, towns, and other features such as lakes, rivers, roads and railways. You can 
choose between a range of alternative projections for each map, with control over the scale and 
viewpoint.

Individual items can be selected from the database and incorporated into the project with 
complete control over their appearance.

You can also combine maps at different scales, such as to include an inset showing an enlarged 
view of one region from another map.

The Viz World database also include height information, from satellite images, giving you the 
option of displaying mountain ranges in relief to give physical information about the area being 
displayed, or simply for an impressive visual effect.

2.2 Street Data Configured Ready For Use
In addition to the database, Viz World Classic can also import street data in its own street data 
format. This provides a wide range of roads, railways, rivers and lakes, parks, buildings, and other 
municipal features, labeled and configured ready for immediate use, so you can create maps and 
animations that take you down to the level of towns, street corners, and single buildings.
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2.3 Projects, Layers And Other Elements
Viz World Classic offers an integrated paint, rotoscoping, effects, compositing, and animation 
system. Designed around a powerful multi-layer approach, Viz World Classic is equally applicable 
to the creation of still images and movies.

When working in Viz World Classic, you are always working on a project. The resolution, bit depth, 
frame rate, and duration of the output movie are all settings of the project. These are set at the 
start, but may be changed at any time.

A project can be built up from an unlimited number of layers. There are five different types of 
layer: image layers (still images), movie layers, text layers, rotoshape layers, and map layers. All 
layer types have two components: the RGB image itself, and an alpha channel which determines 
how the layer is composited.

Image layers and movie layers also have an associated mask. The mask is essentially an additional 
single-channel image which can be painted and processed using the same tools as for the main 
image. Image layers have a single mask, while movies have a mask for each frame of the movie.

Masks can be used in several different ways: to protect portions of the image from change during 
painting or image processing operations, to define the arbitrary shape of an element to be cut 
from a layer (a cutout), to control the way in which the layer is composited, or to protect portions 
of the layer from change by other layers composited above.

Various other types of elements can be created and used within Viz World Classic. These are 
collectively referred to as overlays. There are three types of overlay: text, shapes, and cutouts 
(from an image, often using the mask to define the form). Overlays are not associated with any 
particular layer. They are retained as floating objects and may be stuck down at any time onto any 
image or movie layer. Alternatively any overlay can be converted to a layer for animation, and 
cutouts can also be converted into brushes for painting.

2.4 Establish House Styles For Consistency Across Projects
The Viz World Classic style sheets make it a simple matter to create map animations to a specific 
house style, and once you have created an animation changing it to a different house style is 
simply a matter of loading in the appropriate style sheet. Style sheets control all the important 
aspects of a map animation, including the color schemes, typefaces, line weights, and lighting or 
relief effects. The style sheets also maintain consistency across projects or between designers.

You can also create template files containing predefined elements, such as background maps, 
standard graphics, logos, and titles for reuse in a range of related animation projects.

2.5 Shapes
Viz World Classic includes a complete range of drawing tools to allow you to create and edit 
drawings directly within the program. You can create drawings by combining shapes in one or 
more shape layers, with complete control over the animation and appearance of each shape in the 
drawings. You can also add shape overlays to map layers, to allow you to highlight or annotate any 
features of the map, with a powerful tracing tool to allow you to construct shapes by tracing map 
features.
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2.6 Rotoscoping With Shapes
Viz World Classic allows you to create, edit, and animate vector shapes. These may be polygons, B-
Spline or Bezier curves, or freehand shapes. They can be used to create masks, rendered directly 
into images, or exported for use at a later time.

Shapes can be animated using a combination of key-framing of individual points and the 
movement, rotation, and scaling of complete shapes. This gives great flexibility when using shapes 
to create rotoscoped mattes for moving elements. The underlying movement of a feature can be 
captured by setting a few key-frames for complete shapes and then the shapes can be refined at 
any frame by editing individual points.

You can also soften specified edges of each shape, which is invaluable when making mattes to 
match something that is moving quickly and has motion blur on each frame.

2.7 Animation
Viz World Classic provides an Auto Animate feature that lets you add animation to your project by 
selecting a few simple options. You can fade objects in or out of view, and slide objects in or out 
of frame, with acceleration or deceleration to give a natural appearance.

For more sophisticated effects Viz World Classic gives you complete control over each component 
of your animation, allowing you to animate objects along an arbitrary animation path with 
complete control over their shape and position.

2.8 Compositing And Animation
Straightforward compositing is simply at matter of arranging the layers in the order in which they 
are to be composited, by dragging and dropping. Sophisticated composites can also be created 
very easily by using masks and alpha channels, and their associated controls, to determine how 
layers interact.

All layers remain separate and editable right up to the point of generating the final artwork. Layers 
can be moved, scaled, rotated, and filtered independently, can have any number of animated 
effects applied. They can also have independent transparency settings, drop shadows, and 
lighting.

Every image and movie layer has a selection of built-in keyers available for direct compositing 
using either luminance, chroma, or color keying. The quality of the edges can be carefully 
controlled to achieve the most convincing

results possible.

Every image and movie layer also has an integrated Roto Matte which allows you to add rotoshapes 
directly to the layer to cut out selected features. The results are displayed dynamically as you 
adjust the shapes, and the same flexible range of editing and animation options as for shape 
layers is available.

You can change the source material or content of any layer in a single operation at any time, 
without losing any of the animation or other control settings. This makes it easy to set up 
templates and then generate a series of images or movies
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based on the same underlying design, but with varying content.

2.9 Painting And Effects
Viz World Classic provides a large range of painting, graphic, and image processing tools for use 
on image and movie layers. These are ideal for the freehand origination of artwork, or for 
retouching and editing existing material.

In contrast to the animatable transformations, lighting, and effects which can be applied to all 
layers, painting work explicitly changes the actual content of an image or movie layer.

A wide range of built-in and user-definable brushes are provided for work on images or masks, 
including color, offset merge, clone, drag, blur, and other effects. The brushes are pressure 
sensitive with user-definable profiles, and optional onion skinning facilitates accurate cloning, 
merging, and wire or rig removal.

Many tools are provided for creating, editing, and applying text, shape, and cutout overlays, and a 
very large number of different filters and effects can be applied. Any operations can be repeated 
over multiple frames using macros.

The changed material created by painting operations is stored independently, leaving your original 
materials unaffected. At any stage you can render a finished version, incorporating all your edits, 
or revert to your original material if you want to discard changes.

2.10 Sophisticated Lighting And Filtering Effects
Viz World Classic allows you to add lighting effects to each layer in your project to add realistic 
shading and highlighting to the images, or to emphasize specific features. You can also add one of 
a range of effects to the animation to blur images, or adjust the brightness or contrast.

2.11 High-Quality Output
As you create your animation the frame you are working on is rendered complete with anti-aliasing 
to show you the quality of the finished result. At any time you have the option of previewing the 
complete animation, or rendering it at high quality as single frames or as a movie file to create a 
finished broadcast quality video.

With suitable video output hardware the animations can be played out as broadcast-quality PAL or 
NTSC sequences. The following video hardware is supported: DPS Reality Studio Digital Disk 
Recorder, and video output boards capable of playing QuickTime or AVI movies, or accepting 
single-frame-per-file output. Contact your local Vizrt representative for updated information about 
supported hardware configurations.
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3 Installing Viz World Classic
Viz World Classic is installed in two steps; first the database and then the actual design 
application. 

This section contains information on the following procedures:

3.1 To Download The Software
While you have an active map support contract, you have a personal login to the Vizrt FTP 
server. Download the software from the Vizrt FTP at http://download.vizrt.com/ or ftp://
download.vizrt.com/ under the Viz World folder.

Please use the FTP server to find the latest Vizrt software releases, documentation, help files, 
drivers and more. You can also use the FTP to upload and exchange files with Vizrt.

3.2 To Install Viz World Data
Start the Viz World Data installer.
Click Next.
Click Install to begin the installation.
Click Finish.

3.3 To Install Viz World Classic
Before Viz World Classic is installed, you have to install the Viz World Data.

Start the Viz World Server installer VizWorld23.0.0.msi.
Click Next.
Read the End-User license agreement and accept it.
Click Next.
Select destination directory, and click Next. Default installation directory is: C:\Program 
Files\vizrt\Viz World
Click Install to start the installation.
Click Finish.
Optional: Install QuickTime if it is not previously installed. If a newer version of QuickTime is 
installed the installation is stopped.

Note: Exit all Windows programs before running the Setup Program.

Tip: If you do not already have QuickTime installed you can download the installer from 
the Apple website.



http://download.vizrt.com/
ftp://download.vizrt.com/


Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  26

1.
2.
3.
4.
5.

6.
7.

3.4 To Add The License File
Once Viz World Classic is installed, drop the supplied license into your license folder: C:
\ProgramData\vizrt\Viz World\Licenses\curiousmaps.lic.

3.5 To Add The License File Using Viz World Classic
When starting Viz World Classic without a license, a window appears telling that no license can be 
found.

Start the Viz World Classic application.
Click the License button to open the Software License window.
Click the Edit License File ... button to open the Edit License window.
Click the Add License from a File... button to browse for the License file (*.lic).
Select the License file and click Open. The license becomes visible in the Edit License 
window.
Click OK to save the License. The license is saved to the License folder.
Exit the application and run Viz World Classic.
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4 Quick Tour
This section provides a quick tour of the key features of Viz World Classic, including the 
components of the Viz World Classic window, and an explanation of how they are used in the 
creation of map animations.

This section contains information about the following topics:

Getting Started with Viz World
Toolbar
View Options
Viewer
User Interface Font
Layers List
Using the Content Manager
Controlling Layer Compositing
Animation Controls
Move/Pan Tool
Path Tool
Text Tool
Zoom Tool
Map Rectangle Tool
Browse Map Tool
Browse Street/Shape Data Tool
Ruler Tool
Pick Color Tool
Navigator
Panels

4.1 Getting Started With Viz World
This section contains information about the following topics:

Creating a New Project
Changing the Project Settings

4.1.1 Creating a New Project
When you run Viz World Classic the following Welcome dialog box is displayed to allow you to 
open an existing project, create a new default project, or use a project template:
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Select Create map project and click the OK button to continue.

4.1.2 Changing the Project Settings
When you create a new project it is created with the frame size, frame rate, and map database you 
last used; initially these default to:

Frame size: PAL 768 x 576
Rate: 25 frames per second
Database: World Database

To Change the Project Settings
On the File menu, click Project Settings.... The Project Settings dialog box allows you to 
specify the frame size, frame rate, and duration for the animation, in addition to several 
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other more advanced settings associated with the project:

Choose the settings as required and click the OK button to save the changes. The first time 
you create or open a project there is a short delay while the map database you have selected 
is loaded. The Viz World Classic window is then displayed, initially showing a map layer 
containing the world in a default globe projection, scaled to fit in the project area.

The following image shows the key features of the Viz World Classic window:
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Each component is described in greater detail in the following sections.

4.2 Toolbar

The toolbar provides toolbar button equivalents to the most frequently used menu commands.

The toolbar options, from right to left, are:

 New, open, and save project.

 Cut, copy, paste and delete selection.

 Refresh, load image, load movie, add map, and add text layers.

 Auto animate.

 Styles editor and project Settings.

 Street data and import map data.
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 Symbols.

 Render project and render preview.

 Movie player, Windows media player.

4.3 View Options
Viz World Classic allows you to choose whether or not to display the Layers list, Panels, Navigator, 
and Animation controls. You can also turn the Layers list, panels, or Navigator into floating 
palettes, so you can position them where you like on the screen. These options are particularly 
useful if you are working on a screen with a resolution of less than 1280x1024 pixels.

4.3.1 To Turn the Layers List, Panels, or Navigator into a Floating 
Palette

On the View menu, point to Layers, Panels, or Navigator as appropriate, and then click Floating.

4.3.2 To Hide the Layers List, Panels, or Navigator
On the View menu, point to Layers, Panels, or Navigator as appropriate, and then click Hidden. You 
can also hide a floating palette by clicking its close box.

4.4 Viewer
Displays the currently selected frame of the animation. You can display Viewer controls to allow 
you to scale or scroll the image displayed in the Viewer.

4.4.1 Keyboard Shortcuts
The following keyboard shortcuts can be used in the Viewer:

Pan: Hold down SPACE and drag with mouse.
Zoom In: Press CTRL + ARROW UP, or hold down ALT + SPACE or CTRL + SPACE and click or 
drag with the mouse.
Zoom Out: Press CTRL + ARROW DOWN, or hold down SHIFT + SPACE and click or drag with 
the mouse.
Zoom 1:1: Press CTRL + ENTER.
Next Frame: Press CTRL+ ARROW RIGHT.
Previous Frame: Press CTRL + ARROW LEFT.

To Show or Hide Viewer Controls
Click the Viewer controls button to the left of the Viewer.

The following Viewer controls are provided:
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Viewer Controls: Enables and disables the viewer controls bar and scroll bars.
RGB and Gray: Enables and disables the RGB values and grayscale value.
Scale: Scales the map according to the viewer.
Fit: Fits the map according to the viewer’s available space.
1:1: Fits the map according to the project’s frame size settings (the defined aspect ratio).

To Scale the Image in the Viewer
Edit the value in the scale box, or choose a predefined scale from the drop-down menu.

To Fit the Image to the Viewer
Click the Fit button.

To Restore the Scale to 100%
Click the 1:1 button. The scale is also restored to 100% if you hide the Viewer controls.

4.5 User Interface Font
Viz World Classic allows you to select the font used throughout the user interface. You should only 
need to do this if you are using international characters, such as accented characters, and they are 
not displayed correctly.
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4.5.1 To Change the User Interface Font

On the View menu, click Options...
In the Display section select International Font.
Select the font and size you want to use.

4.6 Layers List
Each of the layers in the project is shown in the Layers list to the right of the Viewer. For each layer 
this shows whether the layer is visible, the name of the layer, an icon representing the composite 
mask options, and a thumbnail image of the layer. For map and image/movie layers, a thumbnail 
image of the contents of the layer is shown.

 
A selected layer is highlighted, and the panels, controls, and tools all operate on the currently 
selected layer.

The order of the layers in the Layers list determines the order in which they are composited in the 
Viewer.

The displayed names for layers are as follows:

Layer type: Name displayed.
Map: Map layer.
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Image/Movie: The filename of the image.
Text: The text on the layer.
Shape: Shape.

For text, image, or shape layers a pin icon to the left of the name shows whether the layer is 
pinned to the map layer below it.

For map layers, a lock icon is displayed if the layer is locked to another map layer below it.

This section contains information about the following procedures:

To Display the Composite of All Layers
To Display an Individual Layer
To Show or Hide a Layer
To Create a New Layer
To Select a Layer
To Rearrange the Order of Layers
To Cut or Copy a Layer
To Paste a Layer
To Delete a Layer
To Duplicate a Layer
To Pin a Layer to a Map
To Lock Two Map Layers Together
To Rename a Layer

4.6.1 To Display the Composite of All Layers

Select the Composite display option above the Layers list. This displays the result of compositing 
all the layers in the project, taking into account the layer mask options for each layer.

4.6.2 To Display an Individual Layer

Select the Single Layer option above the Layers list. The Viewer then shows only the currently 
selected layer. This is convenient if you want to work on a single layer without seeing the effect of 
other layers within the project.

 
In single-layer mode the Layers list shows an eye-dropper icon to indicate which layer is used as 
the background layer, for operations such as onion skinning and the merge brush. Click the eye-
dropper icon to change the background layer.
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4.6.3 To Show or Hide a Layer
Click the eye icon to the left of the layer name.

4.6.4 To Create a New Layer
On the Layer menu, point to Add Layer, and then click the appropriate option. See the appropriate 
chapter Working with Maps, Adding Text to a Project, or Working with Images and Movies, or 
Working with Shapes for information about adding a map, text, image, or shape layer respectively.

4.6.5 To Select a Layer

Click the layer in the Layers list. The currently selected layer is shown highlighted in the Layers list.

4.6.6 To Rearrange the Order of Layers

Drag the layer to the new position in the Layers list.

4.6.7 To Cut or Copy a Layer
Either:

Select the layer.
On the Edit menu, click Cut or Copy, or click the Cut Selection or Copy Selection button on 
the toolbar.

Or:
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Right-click the layer and from the appearing context menu select Cut Layer or Copy Layer.

4.6.8 To Paste a Layer
Either:

Select the layer.
On the Edit menu, click Paste or Paste Insert, or click the Paste button in the toolbar.

Or:

Click the layer with the right mouse button, and click Paste Layer or Paste Insert Layer on the 
pop-up menu.

Paste Layer: Adds the layer to the top of the Layers list.
Paste Insert Layer: Adds the layer above the currently selected layer.

4.6.9 To Delete a Layer
Either select the layer, then in the Edit menu, click Delete Selection , or click the Delete Selection
button in the toolbar. Alternatively, you can click the layer with the right mouse button, and click 
Delete Layer on the pop-up menu.
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4.6.10 To Duplicate a Layer
Hold down CTRL and drag the layer you want to duplicate to the appropriate position in the Layers 
list.

4.6.11 To Pin a Layer to a Map

Click the pin icon to the left of the layer name. The text or image then moves (and optionally 
scales) with the map layer below it. To unpin the layer click the pin icon again.

4.6.12 To Lock Two Map Layers Together

Click the lock icon to the left of the layer in the Layers list. Locking a map layer fixes it at the same 
size, scale, and projection as the base map. This is useful for drawing selected regions of a map 
using a different style sheet from the main map. For more information see the chapter Working 
with Maps.

4.6.13 To Rename a Layer
Either:

Select the layer.
On the Layer menu, click Rename.

Or:

Right-click the layer and from the appearing context menu click Rename Layer. The 
above dialog box allows you to enter a new name for the layer.

Then enter the name and click OK.
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4.7 Using The Content Manager
The Content Manager displays an entry for each layer in the project, showing the image associated 
with the layer, the alpha channel, and the paint mask. The Animation controls in the lower right 
corner of the Content Manager allow you to select which frame is displayed.

4.7.1 To Display the Content Manager
Either:

On the Tools menu, click Content Manager.

Or:

Click the Content... button above the Layers list.

4.7.2 To Copy Content
You can copy any image, alpha channel, or mask within a layer or to another layer, by dragging 
and dropping it within the Content Manager.

Select Current Frame to affect only the current movie frame, or Multiple Frames to copy 
multiple frames.
Select the appropriate Destination option to determine how the dragged cell is combined 
with the destination cell.
Drag the required cell and drop it onto the required destination cell:

If you selected Multiple Frames the Copy Content dialog box is displayed to allow you to 
specify which frames to change.
Specify the range you want to change and click the OK button.
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Click the Close button to close the Content Manager. You can perform a range of useful 
functions within the Content Manager simply by dragging a cell and dropping it onto 
another cell. The following sections describe some typical operations:

4.7.3 To Create a Luminance Mask
Set the Destination option to Replace.
Drag an Image cell and drop it onto a Mask cell.

4.7.4 To Key an Image Using a Mask
Drag a Mask cell onto the Alpha Channel cell for the image you want to key.

4.7.5 To Create a Composite
Set the Destination option to Composite.
Drag an Image cell and drop it onto another Image cell.

The image you dragged is superimposed on the destination image, using the dragged image’s 
alpha channel as a key.

4.8 Controlling Layer Compositing
By default, layers are simply composited one over the other using only their own alpha channel to 
determine which parts are visible in the finished composite, and which are not.

More sophisticated levels of compositing can be achieved using the blend mode, opacity, and 
composite mask.

4.8.1 To Specify the Compositing Options
Each layer provides compositing options to allow you to specify how the layer is combined with the 
other layers in the project, and its opacity.

Select the layer in the Layers list, and click the Properties tab to display the Properties panel 
for the layer.
Click the right arrow button to the left of the Compositing Options heading to display the 
compositing options for the layer:

Blend Mode specifies how the layer is combined with the other layers, and can be one of:
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Normal, Add, Subtract, Difference, Multiply, Darken Only, Burn, Color Burn, Screen, Lighten Only, 
Dodge, Color Dodge, Hue, Saturation, Value, Color, Overlay, Soft Light, Hard Light, Pin Light, 
Exclusion, or Negation.

The Opacity determines the layer opacity, and can be animated.

Use Paint Mask as a Key (image layers only) and Obey Composite Mask are equivalent to the same 
options in the Composite Mask dialog box; see below.

4.8.2 To Specify the Composite Mask Options
The composite mask allows you to make one layer appear to pass in front of some parts of a layer 
below, but behind other parts.

For example, if you want to insert a character into a forest scene, you can make it appear behind 
some trees, but in front of others.

The composite mask is generated layer by layer as a composite image is built up, and can be used 
to protect parts of a layer from change by layers above in much the same way as the paint mask is 
used to protect images from paint operations.

For each layer, you can specify:

Whether the layer’s paint mask is used as a key for the layer.
Whether the layer makes any changes to the composite mask which is passed on for use by 
layers above.
Whether the layer obeys the composite mask (whether the composite mask is used to 
protect the layers below from change by this layer).

You set options for each layer using the Composite Mask dialog box which is displayed by clicking 
the mask icon to the right of the layer name in the Layers list. This allows you to set the 
compositing options for the layer.

4.8.3 To Use the Layer’s Paint Mask as a Key
This provides a quick way of cutting out a feature in an image.

Use the paint tools to create the mask:
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In the When Compositing this Layer section select Use the paint mask as a key. The layer’s 
paint mask is added to the alpha channel, and used to key the image:

4.8.4 To Specify whether the Current Layer Obeys the Composite 
Mask

In the When Compositing this Layer section: Select Obey the Composite Mask. To use the 
composite mask at least one layer should have this option selected. This option is irrelevant for 
the lowest layer in the Layers list.

4.8.5 To Specify whether the Current Layer Affects the Composite 
Mask

In the After Compositing this Layer section: Select Create new Composite mask to update the 
composite mask with the new composite mask.

To use the composite mask at least one layer should have this option selected. The default action 
is for the layer’s paint mask to replace the existing composite mask, making those elements of the 
layer that are covered by the mask appear in front of layers above that obey the mask.

Alternatively, you can specify that the paint mask is combined with the composite mask as 
described below. This option is irrelevant for the highest layer in the Layers list.

4.8.6 To Specify How the Current Layer Affects the Composite Mask
Click the right arrow button to the left of the Advanced Options to show the advanced options.

Once a layer has been composited, you can use either its alpha channel or, in the case of an image 
or movie layer, its paint mask to modify the composite mask. You can also choose to invert the 
mask or alpha channel before use:

In the Use this layer’s... section:

Select Paint Mask or Alpha channel.
Select Inverted to invert the paint mask or alpha channel before using it.
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The composite mask can also be affected in different ways. You can either replace the existing 
composite mask, or combine the composite mask with the mask or alpha channel of the current 
layer.

In the To... section:

Select Replace the existing mask to create a new composite mask which is a copy or inverted 
copy of the layer’s paint mask or alpha channel.
Select Add to the existing mask to add the layer’s paint mask to the existing composite 
mask.
Select Intersect with the existing mask to create a new composite mask which is an 
intersection of the existing mask and the layer’s paint mask or alpha channel If you do not 
select Create new Composite mask, the existing mask is left unchanged and may be used to 
protect the composite image from change by any number of layers above.

4.8.7 To Make an Image Go behind Selected Features in a Scene
The following example illustrates one of the most powerful uses of layer compositing to control 
how one image interacts with components of another image. In this example, we use composite 
masks to make a butterfly go behind the front most poppy in an image of several poppies.

In this example, both the images have alpha channels, to allow a background image to show 
through. The first step is to create a mask defining the foreground image; in this case the front 
most poppy:

This can be done using the mask extract tools on the Mask panel, followed by painting on the 
mask using the brushes on the Brushes panel.

Load the butterfly image, and create a mask for the butterfly.
Position the butterfly layer above the poppies image.
Load the clouds image, and move it to the bottom of the Layers list. The composite image 
reflects the order of the individual images in the Layers list:
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You can view the components of the project in the Content Manager:

Click the mask icon, to the right of the layer name on the poppies image layer in the Layers 
list, and select Create new Composite mask:
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Likewise, click the mask icon for the butterfly layer and select Obey the Composite Mask:

The composite mask is a copy of the mask on the poppies layer. This can then be used to protect 
the front most poppy from change by layers above. Since the butterfly is composited obeying the 
composite mask, the effect is that the area of the butterfly corresponding to the front most poppy 
is masked out, so the butterfly appears to go behind the poppy:

The Composite Mask options can be animated, so a butterfly could be made to fly behind the 
poppy in one part of the movie, and in front of the poppy in another part of the movie.

4.9 Animation Controls

The Animation controls allow you to select which frame of the animation you are working on in the 
Viewer, and preview the animation.

The following animation controls are available:

Start, step back, play, step forward, and end.
Show full frame, lower/odd and upper/even fields.
Current time, duration, display formats (timecode or frames).
Slider range.
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Previous and next key.
Time slider and last frame.

You can hide the Animation controls to give more space for the Viewer when working on a single 
frame of an animation.

This section contains information about the following procedures:

To Show or Hide the Animation Controls
To Specify the Time Display Format
To Move to a Specific Frame
To Move to the Next or Previous Key
To Expand the Slider Scale
To Show the Whole Project

4.9.1 To Show or Hide the Animation Controls

Click the Animation controls  button to the left of the Animation controls.

4.9.2 To Specify the Time Display Format
Choose the format as follows:

Timecode: Hour:Minute:Second:Frame
Frames: Frame number.

4.9.3 To Move to a Specific Frame
Either edit the Current frame field or drag the time slider.

4.9.4 To Move to the Next or Previous Key
Click the Next key or Previous key button in the Animation controls.

A key is a frame in which one or more properties have been edited; for more information see the 
chapter Controlling Animation.
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4.9.5 To Expand the Slider Scale

Click the Slider Range button. Either select Part of project, and specify the Start time, and 
the End time or Duration, of the section of the project you want to work on, or click the 
Match Movie... button to match the slider range and/or project settings to the movie in the 
currently selected layer.
Click the OK button.

4.9.6 To Show the Whole Project
Click the Slider Range button.
Select Whole project and click the OK button.

See Also

Controlling Animation

4.10 Move/Pan Tool

Map layers: Allows you to drag the map layer.
Image, text, and shape layers: Allows you to move, resize, or rotate the image, text, or 
drawing.

In a map layer, clicking the right mouse button displays a pop-up menu that allows you to add a 
country or region to the map, fit the map to a country or region, center the map on a country or 
region, add a new label to the map, or clear the selection:
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In an image/movie, text, or shape layer clicking the right mouse button displays a pop-up menu:

This section contains information about the following procedures:

To Resize an Object
To Rotate an Image, Text Item, or Drawing
To Temporarily Select the Zoom Tool
To Move the Pin Position

4.10.1 To Resize an Object
Drag one of the yellow handles at the corners or midpoints of the image or text item. The 
image or text item is resized about the pin position specified in the Transformation dialog 
box for the image or text layer.
To keep the aspect ratio fixed hold down CTRL while resizing.

4.10.2 To Rotate an Image, Text Item, or Drawing
Point to the rotation handle, which is a yellow square to the right of the pin position. The 
cursor changes to a rotation symbol.
Drag the handle to rotate the image, text item, or drawing about its pin position.

4.10.3 To Temporarily Select the Zoom Tool
Hold down CTRL until the cursor changes to the Zoom cursor to zoom in, or hold down 
SHIFT until the cursor changes to the Zoom cursor, and click to zoom out.

4.10.4 To Move the Pin Position
Hold down SHIFT + CTRL and drag the mouse pointer.

See Also

Working with Maps
Working with Street Maps
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4.11 Path Tool

 Allows you to edit the animation path along which a map layer, image, text item, or drawing 
is animated.

4.11.1 To Change the Animation Path
Point to a point on the animation path. The cursor changes to a triangle.
Drag the point with the mouse pointer.

4.11.2 To Change the Curvature of the Animation Path
Hold down CTRL and drag from a point on the animation path to extend tangent handles from that 
point.

4.11.3 To Move the Tangent Handles Independently
Hold down CTRL and drag one tangent handle.

4.11.4 To Move the Tangent Handles Symmetrically
Drag one tangent handle.

See Also

Controlling Animation

4.12 Text Tool

Map layers: Allows you to move, resize, or rotate the label of a map detail.
Text layers: Allows you to edit the text in a text item, or resize the box.

Right-clicking the layer displays a context menu that allows you to add a country or region to the 
map, fit the map to a country or region, center the map on a country or region, add a new label to 
the map, or clear the selection.
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See Also

Working with Maps

4.13 Zoom Tool

Map layers: Allows you to change the scale of a map layer.

Right-clicking the layer displays a context menu that allows you to add a country or region to the 
map, fit the map to a country or region, center the map on a country or region, add a new label to 
the map, or clear the selection.

4.13.1 To Zoom in
Either click with the Zoom tool to zoom in by a factor of two, or drag with the Zoom tool to select 
an area to fill the map rectangle.

4.13.2 To Zoom out
Hold down SHIFT and click with the Zoom tool to zoom out by a factor of two.

4.13.3 To Temporarily Select the Move/Pan Tool
Hold down CTRL and drag the mouse pointer.

4.13.4 To Move the Pin Position
Hold down SHIFT + CTRL and drag the mouse pointer.

See Also

Working with Maps
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4.14 Map Rectangle Tool

Map layers: Allows you to move or resize the map rectangle.

Right-clicking a map layer displays a context menu that allows you to move the center of the layer 
to the position of the mouse pointer:

See Also

Move/Pan Tool

4.15 Browse Map Tool

Map layers: Allows you to display the names of countries and regions in the map layer by pointing 
at them, and optionally add them to the Details list.

Right-clicking the layer displays a context menu that allows you to add a country or region to the 
map, fit the map to a country or region, center the map on a country or region, add a new label to 
the map, or clear the selection.

See Also

Working with Maps

4.16 Browse Street/Shape Data Tool
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Map layers: Allows you to display the names of features in imported data by pointing at them, and 
optionally label them or add them to the Details list.

As you move this over the map the tool tip shows you the name of each imported data feature.

Left-clicking the map layer displays the Street Highlight tool for adding streets in the area you 
clicked. You can add whole streets, sections of streets and show direction.

Right-clicking the map layer displays a context menu that allows you to filter the data, add a new 
label to the map, add the feature to the Details list, or label the feature:

If you are labeling a street the label is drawn aligned with the direction of the street. You can use 
the Text tool to move or rotate the label as desired.

4.16.1 To Add a Section of a Street
Click the Browse Street/Shape Data button.
Left-click the map layer to display the Street Highlight tool.
Select the street and click the Add section button.
Left-click the street on the map to set start and end points for your section. The street 
section is added to the Details list.
Close the Street Highlight tool.
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4.17 Ruler Tool

Map layers: Allows you to measure distances on maps, and displays other useful 
information.
Image and movie layers: Allows you to measure distances on images and movies.

4.17.1 To Measure a Distance
Drag from the start point to the end point of the distance to be measured. The display shows the 
location and height above sea level of the end point, and the distance between points:

4.17.2 To Specify the Distance Units

Right-click the map, point to Measure Distances in or Measure Height in on the context menu, then 
click the appropriate unit on the submenu.
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4.18 Pick Color Tool

Displays a window showing the color of the layer, and composite project, under the mouse 
pointer:

Clicking the mouse pointer copies the current color to the palette.

4.19 Navigator

Allows you to select which part of the map is displayed in the map rectangle. The view drop-list 
contains all defined preset views and the possibility to add Custom preset views.

See Also

Working with Maps

4.20 Panels
Allow you to control the characteristics of the object on the currently selected layer. The following 
panels are provided.

This section contains information about the following topics:

Properties
Contents
Lighting
Layer Fx
Keybars
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4.20.1 Properties
Shows settings affecting the entire layer including compositing options, transform options, drop 
shadow, frame, and trail.

4.20.2 Contents
Shows information about the contents of the layer. On a map layer it allows you to locate and 
select features from the map database or from imported street data, or add shape overlays. On a 
text layer, it allows you to add and edit text items. On a shape layer it allows you to draw and edit 
shapes.

4.20.3 Lighting
Allows you to add lighting effects to a layer. For more information see the chapter Lighting and 
Effects.

4.20.4 Layer Fx
Allows you to add image effects to a layer. For more information see the chapter Lighting and 
Effects.

4.20.5 Keybars
Allows you to control the animation of each feature of the currently selected layer that can be 
animated. For more information see the chapter Controlling Animation.
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5 Working With Maps
This section explains the options for creating and working with map layers. It describes how to use 
the Properties panel to define the projection, with advice on choosing the appropriate projection 
for specific applications.

It also explains how to use the Contents panel to select countries and places for incorporation into 
the map, and control their appearance using the style settings.

This section contains information on the following topics:

Creating a Map Layer
Map Rectangle
Setting the Map Properties
Locating Features by Country or Region
Locating Features by Name
Adding Map Details
Adding Features to the Map Database
Locating Features in Street Data
Locating Features in Imported Data
Adding Shape Overlays to Map Layers
Adding Satellite Imagery
Adding Symbols
Defining the Style of Details
Setting the Properties for Details
Setting Map Features
Displaying Disputed Regions
Using the Navigator
Measuring Distances on the Map

5.1 Creating A Map Layer
Most Viz World Classic projects will contain at least one map layer, containing the regions, 
countries, and other details you want to feature in the animation. You can include more than one 
map layer to show two areas of the world, or one area at two different scales, in the same 
animation. You can add a map layer when you create a new project, or using the appropriate 
option on the Layer menu.

The map layer will show the region detailed by the map database using the Globe projection.

This section contains information on the following procedures:

To Create a New Project with a Map Layer
To Add a Map Layer
To Insert a Map Layer between Existing Layers



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  56

1.
2.
3.

•

•

•
•

1.
2.

5.1.1 To Create a New Project with a Map Layer

When you start Viz World Classic, or create a new project by clicking New on the File menu, you 
can choose to include a map layer:

Select Create map project.
Choose the map database you want to use from the drop-down menu.
Click the OK button to create the project.

The first time you load a new map database there will be a delay while the data is 
loaded. All the map layers in one project use the same map database.
Earlier versions of Viz World Classic (Viz Curious Maps) supported having access to 
databases of the World, Europe, and USA, and a Combination database which 
combines these into a single database. More recent versions of Viz World Classic are 
only installed with the combination database; however, you can change this under 
View > Options... > Map Data > Locations.

5.1.2 To Add a Map Layer
On the Layer menu, point to Add Layer, and then click Map.

The new layer is added above the existing layers.

5.1.3 To Insert a Map Layer between Existing Layers
Select the layer in the Layers list above or below which you want to add the map layer.
On the Layer menu, point to Insert Above Selection or Insert Below Selection as appropriate, 
and then click Map.
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5.2 Map Rectangle
The map is drawn in a rectangular window called the map rectangle. You can change the size and 
position of the map rectangle to create inset maps in larger animations.

5.2.1 To Display the Map Rectangle

 Select the Map Rectangle tool: Handles are displayed on the edges of the map rectangle.

5.2.2 To Resize the Map Rectangle
Drag one of the handles.

5.2.3 To Move the Map Rectangle

Drag anywhere within the map rectangle. The above example uses a second map layer as an inset 
by resizing and moving the map rectangle to a corner of the main map.
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5.3 Setting The Map Properties

 
The options in the Properties panel allow you to specify the position and scale of the map, choose 
the map projection, and specify the style sheet.

This section contains information on the following topics:

Compositing Options
Transform Options
Drop Shadow Options
Frame Options
Trail Options
Locator
Map Legend
Projection
Automation

5.3.1 Compositing Options

 
Blend Mode specifies how the layer is combined with the other layers, and can be one of:

Normal, Add, Subtract, Difference, Multiply, Darken Only, Burn, Color Burn, Screen, Lighten Only, 
Dodge, Color Dodge, Hue, Saturation, Value, Color, Overlay, Soft Light, Hard Light, Pin Light, 
Exclusion, or Negation.

The Opacity determines the layer opacity, and can be animated.
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5.3.2 Transform Options

 
Allows you to specify the position, scale, rotation, and origin numerically. The following fields are 
provided:

Option Description

Locked When selected, this map layer is locked to the position and 
zoom setting of the map layer below it; see To lock the map 
layer to the map layer below it.

Map Center The longitude and latitude at the pin position, in degrees.

Revolutions The number of globe revolutions in each direction, to create an 
animation that spins the globe.

Pin Position The point, relative to the map rectangle, about which the map 
is centered, where X=0%, Y=0% corresponds to the bottom left-
hand corner of the map rectangle.

Scale The zoom ratio, where 1.00 corresponds to showing the entire 
globe.

Position The position of the center of the map rectangle, where X=0, 
Y=0 corresponds to the bottom left-hand corner of the project 
area.

Size The size of the map rectangle in pixels.

Curved Paths When selected, moves the camera in a smooth curve between 
keys when panning the map.
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Option Description

Set Using GPS Displays the GPS Position dialog box to allow you to center the 
map at a specific longitude and latitude; see To enter a GPS 
location.

Longitude and latitude values can either be entered in decimal degrees, such as 20.175, or in 
degrees, minutes and seconds, such as 20d10m30s.

To Lock the Map Layer to the Map Layer below
Select Locked in the Transform options.

Locking a map layer fixes it at the same size, scale, and projection as the base map. This is useful 
for drawing selected regions of a map using a different style from the main map.

 
In the above example the upper map layer has all styles other than Selected Region set to a Fill 
color of None, and no relief. The lower map layer has Relief and Ocean Contours selected.
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To Change the Pin Position
The map is centered on the pin position, which is drawn as a + symbol on the map when you select 
one of the map manipulation tools. Initially, the pin position is centered in the map rectangle, but 
you can change it to create an off-center globe in the map rectangle.

Either:

Select the Move/Pan or Zoom tool.
Hold down Sc and drag in the Viewer.

Or:

Edit the Pin Position values in the Transform options.

 
The above example was created using two map layers, each with a different pin position.

5.3.3 Drop Shadow Options
Allows you to add a drop shadow which is cast by the map layer onto other layers.

The following parameters are provided:

Parameter Description

Offset The offset of the drop shadow, in pixels.

Opacity The opacity of the shadow. 0% gives no drop shadow.

Softness Blurs the drop shadow to smooth the edges. Values in the 
range 0-5 are recommended.

Color The color of the drop shadow.
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5.3.4 Frame Options

 
The following options allow you to define the frame:

Parameter Description

Fill Color The fill color, for areas outside the globe if the edges 
of the globe are visible.

Border and Border Color The frame border color, and its shape: Rectangle or 
Circle.

Border Width The width of the frame border in pixels.
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For example, the above inset map uses a circular frame with a white 5-pixel border.

5.3.5 Trail Options

Use Trail Width and Trail Color to define the width and color of the trail.
Choose Behind, Ahead, or Full from the Trail drop-down menu to leave a trail behind, ahead 
of, or on both sides of the path.
Select Trail Above to display the trail above the layer.
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5.3.6 Locator

 
The map locator enables you to create a map that can be used to highlight the location of your 
main map.

To Create a Locator Map

From the main menu click Layer, and select Create Pre-rendered Map and then Locator...
From the Export Locator Map dialog box you can name the file, set format, image format/
quality options, frame size and alpha options
Click Render to render the locator image to disk
In the Locator options select the locator image from the Map drop-list
Set the parameters for the locator and save the map project

5.3.7 Map Legend
Map legend allows you to add a legend to the map, position and customize its design.
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Master Opacity: Sets the opacity of the legend.
Units: Defines the legend’s units in kilometers/meters, miles/yards and miles/feet.
Position: Defines the position of the legend. Available options are bottom and top left, right 
and center.
BG Offset: Defines the offset of the legend’s background.
BG Color: Defines the legend’s background color.
BG Opacity: Defines the opacity of the legend’s background.
Border Size: Defines the legend‘s border size (in pixels).
Line Length: Defines the legend’s length (in pixels).

Line Thickness: Defines the thickness of the legend’s line (in pixels).
Line Color: Defines the legend’s line color.
Type: Defines the type of line. Alternatives are line up/down, alternate filled and open and 
staggered open/filled.
Font: Defines the font and the font parameters.
Text Color: Defines the color of the text.
Default text: Allows you to enable and define the default unit text (for example, setting Km 
to km, kilometers, kilometros etc.).
Units Title: Allows you to manually enter the units title text instead of using the default text.
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Sub-units Title: Same as for Units Title.

Title Alignment: Aligns the unit titles. Available options are Left, Center and Right.
Halo Size: Defines the size of the legend’s halo. Note that the halo only has an affect on the 
legend itself and not the legend’s background (use shadow).
Halo Color: Defines the color of the legend’s halo.
Shadow On: Enables the legend’s shadow.
Shadow Position: Defines the (X and Y) position of the legend’s shadow.
Shadow Opacity: Defines the opacity of the legend’s shadow.
Shadow Softness: Defines the softness of the legend’s shadow. The higher the softness, the 
wider the shadow spreads.
Shadow Color: Defines the color of the legend’s shadow.

To Create a Map Legend
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Open the Properties panel.
Enable the Map Legend and set the parameters.
Save the map project.

5.3.8 Projection

To Choose the Projection
Choose the projection from the drop-down menu. Selecting a projection previews it in the 
window below the drop-down menu.
Click the Apply button to apply the projection to the map layer. Which map projection you 
choose depends on what you are using the map for, the part of the globe displayed, and the 
type of animation.

In the majority of cases the Globe projection is most suitable as it is ideal for zooming in 
animations, and land shapes look familiar when in the middle of the picture. Its chief 
disadvantages are that shapes get distorted near the horizon, and only half the world can be seen 
at any one time.

The other projections are divided into four main groups:

Cylindrical projections: Have shapes that look familiar for certain latitudes, but is more 
distorted at other parts.
Equal Area projections: Show the relative size of countries more accurately but the shapes 
can look unusual.
Conical projection: Is really only useful for maps of the Continental USA.
Stereographic projections: Have familiar shapes at the center of the image, but is very 
distorted at the edges. They can be useful for combining with satellite images.
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5.3.9 Automation

To Change the Stylesheet
Choose a style sheet from the Style sheet drop-down menu.

To Auto-animate the Map Layer

 Click the Auto Animate button:

See Also

Working with Styles
Automatically Animating a Layer

5.4 Locating Features By Country Or Region
The Explorer tab on the Contents panel allows you to explore the map database hierarchically, by 
country or region:

The left list displays an alphabetical list of countries, and regions within each country. The right 
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list displays specified features within a selected country or region, or a message explaining how to 
narrow the search to find an item of interest.

This section contains information on the following procedures:

To Scroll to Any Country in the List
To List Only Countries Visible in the Current Map View
To Show/Hide Regions
To Display a List of Features Contained in a Country or Region
To Display the Currently Listed Features on the Map
To Scroll Directly to a Feature

5.4.1 To Scroll to Any Country in the List
Type the first few letters of its name in the Find box above the list.

5.4.2 To List Only Countries Visible in the Current Map View
Select Visible regions.

5.4.3 To Show/Hide Regions
Countries shown with a + to the left of their name in the list are divided into regions.

Click the + to expand the list and show the regions.
Click the - to collapse the list and hide the regions.

5.4.4 To Display a List of Features Contained in a Country or Region
Select the country or region in the left list.
Select the type of features you want to list from the drop-down menu below the list. By 
default, Towns > 100k is selected, to show towns with a population greater than 100,000, 
but you can select from a range of alternative options.
Select Visible to show only features visible in the current map view.

5.4.5 To Display the Currently Listed Features on the Map
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Click the Locate Features button (see above). The currently selected features are labeled on 
the map:

Click a feature with the right mouse button and point to Add to map on the pop-up menu, 
and click the feature:
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5.4.6 To Scroll Directly to a Feature

Select United Kingdom as the region.
Select Mountain and check the adjacent Visible check-box.
Type the first few letters of a British mountain (for example, Snowdon) in the Find box above 
the list.

5.5 Locating Features By Name
The Search tab in the Contents panel is used for searching the entire map database for a feature, 
using a string or sub string typed in the Named text box. Search results can be filtered by using 
the radio buttons and the drop down list.

Searching is instant (after the first three characters) and optimized according to relevance; hence, 

if you search for Paris  your result shows all places named Paris, but if you search Paris TX
you will get Paris, Lamar County which is in Texas, USA.

Note: Searching for features in any country by selecting The World may give too 
many results. Try narrowing down the search by selecting a specific country or 
region, or by checking one or both of the Visible check-boxes.


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Select All or Visible to search all of the features of specified type in the database, or only 
those visible in the current map view.
Choose the type of feature you want to search for from the Type drop-down menu.
Enter the text you want to search for in the Named field. The text can include the wildcards 

?  or *  to match any single character, or any sequence of characters, respectively. For 

example, typing *erest  finds all features containing erest :

 
If you have street data (see Locating Features in Street Data) you can also search for crossroads 
using AND or & (for example, E Tudor RD AND Lake Otis Pky):

5.5.1 Search Parameters
Find All: When selected it displays all matching entries in the database.
Find Visible: When selected it only displays matching entries visible in the current map.
Addr and Cross st.: Enables the user to search for specific addresses.
Type: Limits the result list according to the selected Type. For example region, capitals, 
tourist attraction, and so on.
Named: Text box for entering search criteria. Can also use AND or & to search for 
crossroads/intersections.
Intersection: Searches for an intersection of the street entered in the Named field. This is an 
alternative to the search option described for the Named field.
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• Source: Searches the Viz World database.

5.5.2 To Display the Currently Listed Features

 Click the Locate Features button: The currently selected features are labeled on the map, and 
you can click on one to select it in the Search list.

5.6 Adding Map Details
The Details list on the Contents panel shows a list of all the details currently selected for 
incorporation in the current project:

 
Each entry shows an icon representing the type of feature, the name of the feature, and the name 
of the style applied to the feature. The icons are as follows:

Icon Description

Country

Region

Town

Place

River

Note: Searching for addresses requires licensed street data installed on the server.
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Icon Description

Mountain

The Details list also includes any area or line shapes drawn on the map layer:

Icon Description

Area shape

Line shape

This section contains information on the following procedures:

To Specify How Labels Scale with the Map
To Reorder the Map Details
To Remove a Map Detail
To Add a Feature from the Explorer or Search Panel to the Details List
To Add a Country or Region from the Map to the Details List
To Redraw the Map to Fit a Feature
To Center the Map on a Map Detail

5.6.1 To Specify How Labels Scale with the Map
Select Scale labels with map below the Details list to cause the labels of map details to remain the 
same proportion relative to the map’s scale. If you deselect this option the labels will remain fixed 
size irrespective of the map scale.

5.6.2 To Reorder the Map Details
Entries in the Details list are drawn on the map from the bottom of the list upwards, and you can 
change the order to determine how features overlap.

Either:

Select the detail you want to move.
Click the arrow buttons to move it up or down in the list:

 
Or:

Note: This option affects all labels on the map layer.
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Drag the detail to the required position in the list:

Or:

Click the detail with the right mouse button and click the appropriate Ordering option on the 
context menu.

5.6.3 To Remove a Map Detail
Either:

Select the detail you want to remove.
Press D.

Or:

Click the detail with the right mouse button and click Remove on the context menu.

5.6.4 To Add a Feature from the Explorer or Search Panel to the 
Details List

Either:

Select the feature in the Explorer or Search lists.
Click the Add Feature to Details button:

 
Or:

Click the detail with the right mouse button and choose Add to map from the context menu.

5.6.5 To Add a Country or Region from the Map to the Details List
Click the Browse Map tool:
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As you move the pointer over the map, the name of each country and region is displayed:

Click the map with the right mouse button and point to Add to map on the context menu, and 
click the feature you want to add:

5.6.6 To Redraw the Map to Fit a Feature

Click the feature in the Explorer, Search panel, or Details list with the right mouse button and click 
Fit map on the appearing context menu.

5.6.7 To Center the Map on a Map Detail
Click the feature in the Explorer, Search panel, or Details list with the right mouse and click Center 
map on the appearing context menu.

See Also

Working with Shapes

5.7 Adding Features To The Map Database
Viz World Classic allows you to add user-defined features to the map database. You can share user 
map details with other users; see the Sharing Databases section.

This section contains information on the following procedures:

To Define a New Feature on the Map



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  77

•

1.

2.

3.
4.

To Define a New Feature from the Explorer

5.7.1 To Define a New Feature on the Map
You can define a new feature at a specified map position and add it to the map database, 
associated with the country and region you clicked on.

Select any tool except the Path tool or the Map Rectangle tool.

Click the map where you want to add the feature with the right mouse button and click New 
Label... on the context menu. The following dialog box allows you to define the new feature:

Enter a name for the feature, and specify the style.
Click the OK button to add the new feature to the user map details database and Details list.

5.7.2 To Define a New Feature from the Explorer

 You can define a new feature of any type and add it to the map database associated with a 
specific county and region.
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Click the New Feature button in the top right corner of the Explorer panel. The following 
dialog box allows you to define the new feature:

Enter a name for the feature, and specify a category and style.
Enter the latitude and longitude, if you know them, or use the Text tool to move the new 
feature to the correct position after you have defined it. The Region list is identical to the 
left list in the Explorer and you can use the Find box to scroll to an entry, and the 
Visibleregions checkbox to show only regions visible in the image window.
Click the OK button to add the new feature. The feature is added to the user map details 
database and to the Details list.

See Also

Reusing Design Elements

5.8 Locating Features In Street Data
The Streets tab on the Contents panel allows you to explore imported street data, and add 
selected features to the Details list:
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It works in a similar way to the Explorer.

See Also

Working with Street Maps

5.9 Locating Features In Imported Data
The Imported Data tab on the Contents panel shows imported third-party map data in the widely-
used ESRI Shape File Format, and allows you to explore it by data set, data layer, and subset:

It works in a similar way to the Explorer.

See Also

Working with ESRI Shape Files

5.10 Adding Shape Overlays To Map Layers
The Overlays tab on the Contents panel allows you to add shape overlays to the map layer, either 
by drawing them, or by tracing map features:
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See Also

Working with Shapes

5.11 Adding Satellite Imagery
You can add geo-referenced satellite imagery to your base map. Other features like street data 
appear on top of it.

5.11.1 To Add Satellite Imagery to the Base Map

From the View menu select Options.....
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Select Locations and click Installed Imagery....
Click the + button and open the CMR files.
Click the Fit images to selected map button and close the window.
From the Styles menu select Styles Editor....
Select the Topography tab.
Select your style sheet and set it to Natural Earth. All satellite images appear as part of your 
map; however, they only appear if you use style sheets based on Natural Earth.

Optional: From the Contents tab select the Streets tab and load the street data for your 
region to see how streets are overlaid.

See Also

Working with Images and Movies
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5.12 Adding Symbols

 
Symbols can be added to map layers.

5.12.1 To Add Symbols

 

Click the Symbols button on the toolbar, or click Symbols on the Tools menu.

In the Symbols dialog box select the symbol and click the Add to Layer button or Drop 
Symbols button. All symbols are visible in the Details list.

5.12.2 To Manage Symbols
Click the Symbols button on the toolbar, or click Symbols on the Tools menu.
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Add a page to categorize symbols. Pages can also be renamed.
Click the Replace... button to replace the symbol.
Add symbols to the page by clicking the + button.
Delete symbols from the page by clicking the Delete button.
Set properties by clicking the Properties button. The Properties dialog box allows you to set 
the scale, fix the aspect ratio, set default text, set preferred style name, add and set drop 
shadow properties and set it to loop.

5.13 Defining The Style Of Details
The Style, Properties and Shape panels on the Contents panel allow you to define the individual 
appearance of each of the map details and shape details you have added to your project.

Each detail is initially drawn using the style defined in the Styles Editor for the corresponding type 
of object. These include:

Sea.
Unselected Land. 
Selected Region.
Place.
Latitude/Longitude.

You can redefine these styles in the Styles Editor, to change the appearance of all details of the 
corresponding type. You can also create your own named styles, and apply these to specific details 
to draw them in a specific style.

Finally, you can override the style of any selected detail to modify its appearance from that 
specified in the Styles Editor.

This section contains information on the following procedures and topics:

To Apply a Predefined Style to a Detail
To Redefine the Style Applied to a Map Detail
To Override the Style of a Map Detail
Color Panel
Text Panel
Strap Panel
Texture CC Panel

5.13.1 To Apply a Predefined Style to a Detail
Select the detail in the Details list.
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Click the Style tab and choose the style name from the Style list:

5.13.2 To Redefine the Style Applied to a Map Detail
Click the Style tab and select the style in the Style list.
Click the Edit... button.

The Styles Editor is displayed to allow you to edit the style. For more information see the Styles 
Editor.

5.13.3 To Override the Style of a Map Detail
Select the detail in the Details list.
Click the Override Style (+)… button.

The Settings dialog box displays to allow you to override the style:
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If the style has been overridden a +, it is displayed after the style name in the Details list. After 
overriding a style you can click the Add to Style Sheet… button to add the new style to the current 
style sheet, so you can use it for other details. 

The following dialog box displays to allow you to name the new style:

5.13.4 Color Panel

 
Allows you to specify the fill, border and coastline colors for the object, the width and line width 
limits, and an optional texture.

For more information see the Color Panel when Working with Styles.

5.13.5 Text Panel

 
Allows you to specify the color, font, size, style, alignment, and opacity of the feature’s label. For 
point styles it also allows you to choose the marker which is drawn at the location of the feature.



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  86

1.
2.

Select On to apply a default drop shadow.
Click the Drop Shadow… button to define the characteristics of the drop shadow:

For more information see Text Panel when Working with Styles.

5.13.6 Strap Panel

 
Allows you to draw a marker at the label position, and a background (strap) for the label with an 
optional frame and connector. You can also add a drop shadow to the strap in the same way as for 
the label.

After defining a strap with a connector you can move the end of the pointer using the Text tool.

For more information see Strap Panel when Working with Styles.
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5.13.7 Texture CC Panel

 
Allows you to color correct textures.

See Also

Texture CC panel when Working with Styles

5.14 Setting The Properties For Details
The Properties panel on the Contents panel allows you to change individual properties of a detail 
not defined by its style:

 
This allows you to specify the color and text opacity for the detail, and edit its label.

If the label for the feature is outside the project area you can make it visible by clicking the Make 
Label Visible button:

Set the size and angle of the label using the Scale and Label Rotation fields.

Alternatively you can scale and rotate a label using the Text tool.

Click the Fit Map or Center Map buttons to fit or center the currently select feature to the 
map.
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Click the Auto Animate button to auto animate the feature.

5.14.1 To Create Multi-line Detail Labels
You can include a \ (backslash) character in the label for map details to split the label onto two or 
more lines:

 
This gives greater flexibility in labeling small features on the map:

5.14.2 To Select an Alternative Label
Some features provide alternative labels; for example, Beijing (Peking). Select the alternative you 
want from the Label drop-down menu. You can also add your own alternative names; these get 
saved in an alternate names database so they are always available.

5.14.3 To Specify the Order of Alternative Place Names
You can specify the order in which alternative place and region names are shown.

On the View menu, click Options….
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In the Display section click Map Labels:

 
The 1st Choice, 2nd Choice, and 3rd Choice drop-down menus can each be set to one of the 
following options:

Option Description

Standard The standard name provided in the map database.

Alternate The alternate name provided in the map database.

Abbreviation The abbreviated version of the name in the map database.

User The user-defined alternate name defined on the Details 
Properties panel. It always uses the last entered name.

Map details are listed in the Explorer and Search panel as: 1st Choice (2nd choice). The First 
Choice is selected by default for new map details.

5.15 Setting Map Features
The style sheet selected for a map layer specifies a number of general settings. You can override 
these using the Map Features dialog box.

This section contains information on the following procedure and topics:

To Display the Map Features Dialog Box
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Global Map Data
Local Street Data
Scale Roads/Rail with Map and Rivers Master Scale
Physical Feature Animation

5.15.1 To Display the Map Features Dialog Box
Click the Map Features button in the top right corner of the map layer Contents panel. This 
provides the following sections:

Global Map Data

 
Allows you to specify the following settings for the selected map layer:

Parameter Description

Lakes, Rivers Allows you to specify which lakes and rivers are visible.

Roads Allows you to specify which roads are visible.

Rail Allows you to specify which railways are visible.
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Local Street Data

 
Allows you to specify which lakes, rivers, roads, and railways are visible in street data, and the 
opacity of roads and railways. The options are the same as for Global Map Data opposite.

Enable allows you to choose whether or not street data is displayed in the map layer.

The Street Data... button displays the Street Data Directory dialog box and is equivalent to the 
Street Data... command on the Import menu.

For more information see Working with Street Maps.

Scale Roads/Rail with Map and Rivers Master Scale

 
Determines how roads, railways, and rivers are scaled as the map is scaled.

The Scale Factor setting is used to scale all line features, such as road, rail, and rivers. You can 

adjust the value to achieve particular effects; for example, reduce it below 1.00  to make all line 

features thinner.

For line features, such as roads and rivers, a minimum and maximum line width is specified in the 
Styles Editor dialog box Styles Color panel to ensure that the features have an appropriate 
appearance at extreme zoom settings. However, it can look unnatural if a line feature reaches its 
maximum width before you get to the closest zoom point as you zoom in to a map.

To solve this problem, choose the closest zoom setting in your animation and click the appropriate 
Auto Fix… button. This automatically sets the corresponding scale value to scale the maximum 
line width so it only reaches its maximum width at the closest zoom point.
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Physical Feature Animation

 
Allows you to animate the relief height, relief DEM blend, ocean contour opacity, and land drop 
shadow.

Relief Height: Typically used to reduce the amount of relief at close zoom settings, when full 
scale relief can appear distracting.
Relief DEM Blend: Imported DEM (Digital Elevation Model) relief data does not always match 
up exactly with the built-in relief. As a result, seams may be visible where they meet. This 
control allows you to hide imported relief data until you are zoomed in far enough for the 
seams to fall outside the display window. For more information about importing relief data 
see how To import relief data.
Ocean Contour Opacity: Allows you to animate the intensity of ocean contours.
Land Drop Shadow: Allows you to animate the land drop shadow over time.

5.16 Displaying Disputed Regions
Viz World Classic allows you to choose how several disputed regions in the world are displayed 
and assigned to the appropriate countries. Any changes made to this setting apply to all projects.

5.16.1 To Change the Assignment of Disputed Regions

On the View menu, click Options….
Click Map Data, then the Database option, then click the Disputed Regions… button to 
display the Disputed Regions dialog box.
Choose the region you want to configure from the Region drop-down menu.
Choose one of the available configurations from the Configuration drop-down menu. As you 
select a configuration the map shows how the regions are displayed.

Note: You cannot make any changes to the disputed regions if your project contains map 
layers, so if necessary delete any map layers in your project.


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5.17 Using The Navigator
The Navigator allows you to select which part of the map is displayed in the image area.

This section contains information on the following procedures:

To Choose a View
To Change the View
To Choose a Preset View
To Define a Preset View
To Edit the Name of a Preset
To Delete a Preset
To Enter a GPS Location

5.17.1 To Choose a View

Drag across the Navigator to draw a rectangle enclosing the area of the world you want to display.

5.17.2 To Change the View
Drag a corner of the rectangle to resize it.
Hold down CTRL and drag the rectangle to move it.
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Move the scale control, to the right of the Navigator, to enlarge or reduce the size of the 
rectangle.

5.17.3 To Choose a Preset View

Choose a preset view from the View context menu.

5.17.4 To Define a Preset View
Define the view you want to save.
Click the … button to the right of the Navigator View menu. The Presets dialog box displays:

Click the + button. A new preset is created with a default name, such as Preset0.

5.17.5 To Edit the Name of a Preset
Select the preset in the Presets list.
Click the Rename... button.

5.17.6 To Delete a Preset
Select the preset in the Presets list.
Click the X button.
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5.17.7 To Enter a GPS Location

Click the GPS button below the Navigator. The GPS Position dialog box (depicted above) is 
displayed to allow you to specify that the map should be centered at a particular longitude 
and latitude.
Enter the longitude and latitude in the Long. and Lat. fields. Longitude and latitude values 
can either be entered in decimal degrees, such as 20.175, or in degrees, minutes and 
seconds, such as 20d10m30s.
Optionally enter the amount of the Earth’s surface you want to display in the Radius field. 
For creating animations of a revolving globe you can optionally enter a number of 
revolutions in the Revs fields.

5.18 Measuring Distances On The Map
The Ruler tool provides a convenient way of measuring distances on maps, and displaying other 
information.

5.18.1 To Measure a Distance

Select the Ruler tool.
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2. Drag from the start point to the end point of the distance to be measured.

The display shows the location and height above sea level of the end point, and the distance 
between points:

5.18.2 To Specify Distance Units

Click with the right mouse button, point to Measure Distances in or Measure Heights in on the 
context menu, then click the appropriate units.
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6 Working With Styles
This section explains how to use style sheets to make it easy to set up a series of house styles, 
and convert projects between house styles with a single click. It also explains how style sheets 
help you establish consistency across projects, or between designers.

This section contains information on the following topics:

How Stylesheets Work
Creating, Saving, and Loading Stylesheets
Styles Panel
Topography
Markers Panel
Textures Panel
Lighting Panel
Map Features Panel
Options Panel
Using Imported Relief Data

6.1 How Stylesheets Work
A stylesheet defines all the properties and design conventions used to draw a map. Each map layer 
has a stylesheet associated with it which determines its appearance.

The stylesheet defines:

The predefined styles, and any additional user-defined styles.
The markers used to identify map details.
The textures available for use as textures for regions.
One or more default lights for the map layer.
Additional properties of the map including land shadow, relief, and line widths.

Once created, a finished project can be changed to a different set of design conventions simply by 
loading in a different stylesheet.
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For example, the above project was created using the default stylesheet.

The project can then be instantly converted to a totally different house style simply by loading in a 
different stylesheet.
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For example, one stylesheet could include texturing and lighting effects.
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For another project loading a stylesheet could create a much simpler appearance with flat lighting 
and thick line widths.

6.1.1 Multiple Stylesheets
If your project includes more than one map layer you can apply a different stylesheet to each map 
layer. For example you might have one house style for the main map in a project and another 
house style for an inset map.
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6.2 Creating, Saving, And Loading Stylesheets

Styles are created and edited using the Styles Editor. You can leave the Styles Editor open while you 
work with the project and any changes you make in the Styles Editor are immediately reflected in 
the current map layer.

This section contains information on the following procedures:

To Display the Styles Editor
To Create a New Stylesheet
To Rename a Stylesheet
To Delete a Stylesheet
To Copy Stylesheets from Another Project
To Export an Individual Stylesheet
To Import a Stylesheet

6.2.1 To Display the Styles Editor
In the Styles menu, click Styles Editor.... When you create a new map layer it initially uses the 
stylesheet defined by the default project template. If there is no project template the stylesheet 
called Political is used. For more information about creating a default project template containing 
your own choice of styles see Reusing Design Elements.

You can create any number of new stylesheets, and modify the styles in those stylesheets to 
establish the design conventions you want to use. Stylesheets are saved with the project, and you 
can import stylesheets from another project. You can also save individual stylesheets in separate 
files.

6.2.2 To Create a New Stylesheet
Select the stylesheet you want to base the new stylesheet on in the Style Sheet list.
Click the + button.

Note: By default the style sheet is called StyleSheet, StyleSheet1, etc.
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6.2.3 To Rename a Stylesheet
Select the stylesheet you want to rename.
Click the Rename... button.

6.2.4 To Delete a Stylesheet
Select the stylesheet you want to delete.
Click the X button.

6.2.5 To Copy Stylesheets from Another Project
On the Import menu, click From Project....
Select the project file you want to import from. The following dialog box then allows you to 
specify the features of the project you want to import:

Click the Styles tab.
Select the stylesheets you want to import from the project, using SHIFT to select contiguous 
items, and CTRL to select non-contiguous items.
Click the Load button to proceed. The stylesheets are added to the list of stylesheets, 
replacing any existing stylesheets of the same name where appropriate.

6.2.6 To Export an Individual Stylesheet
In the Styles Editor click the Export... button. You are prompted to give the stylesheet a 
name.
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Enter a suitable name and click the Save button.

6.2.7 To Import a Stylesheet
In the Styles Editor click the Import... button. An Open dialog box displays to allow you to 
select a stylesheet to open.
Select the style sheet and click the Open button. The stylesheet is added to the list of 
stylesheets in the project. If there is already a style of the same name the stylesheet is 
renamed.

6.3 Styles Panel

 
The Styles panel allows you to edit the styles in the currently selected style sheet.

This section contains information on the following sections:

Predefined Styles
To Edit the Attributes of a Built-in or User-defined Style
To Create a New Style
To Edit the Name of a Style
To Delete a Style
Color Panel
Area Styles
Line Styles
To Use a Texture
To Transform a Texture
Text Panel
Drop Shadow

Strap Panel
Texture CC Panel
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6.3.1 Predefined Styles
Each style is identified by a name, such as Region, and specifies attributes such as fill color, border 
color, coastline color, marker color, text color, text typeface, and size. Applying a style to a map 
detail then sets its attributes to those defined by the style.

Viz World Classic provides a set of predefined styles for each of the different types of feature in 
the map database. These include: Sea, Unselected Land, Selected Region, Place, Latitude/
Longitude, and a number of default styles for use with street data.

This section contains information on the following procedures:

To Edit the Attributes of a Built-in or User-defined Style
Select the style you want to edit in the Styles list. The attributes of the style are shown on 
the Color, Text, Strap and Texture CC (color correction) panels:
Edit any attributes you want to change.

All objects in the selected style are updated to reflect the changes you have made.

Each predefined style is of type Area, Line, or Point as appropriate, and this determines the 
attributes displayed in the Color, Text, and Strap panels.

When you create a user-defined style you specify whether it is an Area, Line, or Point style, and this 
determines which features you can apply it to.

To Create a New Style
Select the style you want to base the new style on in the Styles list.
Click the + button. A new style is created with a default name; for example, Style1.
Select Area, Line, or Point to specify what the style applies to. This determines which options 
are available in the Color, Text, and Strap panels.
Edit the attributes of the style as required.

To Edit the Name of a Style
Select the style in the Styles list.
Click the Rename... button.

To Delete a Style
Select the style in the Styles list.
Click the X button.

Note: You cannot edit the names of built-in styles.

Note: You cannot delete the built-in styles.
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Color Panel
The options available on the Color panel depend on the selected style.

This section contains information on the following topics and procedures:

Area Styles

 
Provides some or all of the following options:

Attribute Description

Fill The fill color for the object.

Four Color Cycles between four different colors for the fill color so 
that adjacent regions can easily be distinguished. The 
Auto button automatically sets the alternative fill colors 
based on the current Fill color.

Mix with Topography Moving the slider to the right adds a proportion of the 
style color to land colored with topography.

Texture An optional texture for the object; see Using textures
below.

Border Specifies the border color.

Width Sets the line width for the borders of imported map 
features.

Internal Borders Displays the internal borders of the country in the 
specified color.

Disputed Borders Dashed Displays disputed borders dashed.
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Attribute Description

Coastline Specifies the coastline color.

Line Width Limits Restricts the range of line widths when zooming.

Line Styles
Provides the following options:

Attribute Description

Inner color and Width Color and width of the body of the line feature.

Outer color and Width Color and total width of the edges of the line feature.

Line Width Limits Restricts the range of line widths when zooming.

To Use a Texture
To fill the area with a texture select an existing texture from the drop-down menu, or use 
the + button to load a new texture from a file.

Any image can be used as a texture, including images in the CMR (Curious Multi-Res) 
format; this is ideal for using large files, such as satellite images, as textures. For 
more information see Working with Images and Movies.
The buttons to the right of the Texture drop-down menu can be used to determine 
how the texture is displayed:

Button Name Description

Add Texture Displays the Open dialog box to allow you 
to add a texture from a file.

Position Texture Click to position the texture on the map. 
You can then move or scale the texture in 
the same way as for images.

Position Texture (Arrows) Allows you to move and scale the texture by 
specifying how two points on the texture 
should be aligned with the map; see below.

Tile Specifies whether the texture should be 
tiled.
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To Transform a Texture
Click the Position Texture (Arrows) button.
Drag the circles to indicate which points on the texture you want to use as the reference 
points.

Drag the arrow heads to indicate where those points should be positioned on the map:
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Click with the right mouse button and click Apply transformation on the context menu to 
transform the texture.

Click the Position Texture (Arrows) button again to see the transformed texture. The Make 
Handles Visible option on the pop-up menu is useful if the handles are outside your current 
view.

Text Panel

 
The text panel provides the following options:

Attribute Description

Marker Point styles only: The image file used for the point. Select 
an existing marker from the drop-down menu, or click the + 
button to load a new marker.

Text Specifies the text color, font, size, and style (bold, italic) for 
labels.
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Attribute Description

Extra spacing Varies the character spacing to compress or expand the 
text.

Extra line spacing Adds extra line spacing.

Alignment Specifies the position of the label relative to the marker.

Distance Sets the distance.

All Caps All letters are written in upper case.

On Adds a default drop shadow.

Drop Shadow… Displays the Drop Shadow dialog box to allow you to define 
the characteristics of the drop shadow; see opposite.

Drop Shadow

 
Provides the following options:

Attribute Description

On Turns the drop shadow on.

X,Y Defines the drop shadow displacement, in pixels.

Opacity Specifies the drop shadow opacity.

Softness Allows you to blur the drop shadow.
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Attribute Description

Color Specifies the drop shadow color.

6.3.2 Strap Panel

 
The Strap panel allows you to add a background, frame, and/or connector to the label of a feature.

Provides the following options:

Attribute Description

Marker The image file used for the marker. Select an existing 
marker from the drop-down list, or click the + button to 
load a new marker.

Opacity The opacity of the body of the strap.

Fill, Margin, Margin Height The fill color, margin and margin height of the strap.

Frame The type, color, width, and opacity of the frame of the 
strap.

Connector The type, color, width and gap (to the marker) of the 
connector.

Drop Shadow Adds a drop shadow to the strap.

After defining a strap you can move the end of the pointer with the Text tool.

The following illustrations below show some examples of straps. Fill white and frame black, 
connector set to pointed border, and marker to image:



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  111

 

 

6.3.3 Texture CC Panel

 
Allows you to color correct textures.



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  112

•
•

1.
2.

3.

See Also

Texture CC panel when Working with Maps
Working with Images and Movies

6.4 Topography

The Topography panel allows you to add relief shading to give a three-dimensional appearance to 
the map, and color the land and/or sea using natural colors.

6.4.1 To Specify the Topography
Select Relief Shading to apply relief shading to the land.
In the Land section select Land Styles, Relief Color, or Natural Earth to specify how the land 
should be colored. If Relief Color or Natural Earth is selected, you can blend in a proportion 
of the land style color using the Mix with Topography slider on the Styles Color panel.
In the Oceans section select Natural Sea and/or Contours to specify how the sea should be 
colored.

The options are illustrated in the following examples:

Land Styles, no Relief Shading and Relief Shading:
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Relief Color and Ocean Contours, and Natural Earth and Natural Sea:
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The following sections give more information about each of these options:

To Specify the Topography
Shading Panel
Relief Color Panel
Natural Earth Panel
Natural Sea Panel
Ocean Contours Panel
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6.4.2 Shading Panel

The Shading panel allows you to define the scale of the relief effect and the light direction for the 
relief. The following image shows the map with and without maximum detail:
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Maximum Detail relief rendering is selected by default, and gives improved sharpness and detail, 
especially when zoomed in very close. However, in some situations the Maximum Detail option can 
produce images with a noticeable grid pattern, in which case you may prefer to deselect it.

The Highlight Size and Highlight Brightness settings allow you to control the appearance of the 
relief texturing on your maps.

The following illustrations give examples of the effect of each setting. Minimum highlight size, 
normal settings, and maximum highlight brightness:
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The Disable Imported DEM checkbox allows you to choose whether to use any DEM Relief data you 
have loaded in place of the built-in relief data.

6.4.3 Relief Color Panel

The Relief Color panel allows you to define the colors used for different terrain heights. Click the 
appropriate Scale button to change the color gradient scale to show heights from 0 to 8000m, 0 to 
800m, or 0 to 80m. To adjust the terrain height corresponding to a color, drag the dividing line 
next to the color square. To change a color, click on the corresponding color square and a color 
chooser is displayed. To add or remove colors, click on the color gradient with the right mouse 
button and click Add Point or Delete Point on the context menu:

You can save a gradient, or load a gradient saved on a previous occasion, using the Save Gradient 
and Load Gradient options on the color gradient context menu.
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6.4.4 Natural Earth Panel
The Natural Earth panel allows you to control natural earth land coloring, which shows the Earth 
with natural coloring determined from high resolution satellite imagery; for example, deserts are 
colored yellow, forests green, and ice caps white:

The Database option allows you to select different types of natural earth databases. The 
Brightness, Contrast, Gamma, and Saturation controls allow you to adjust the appearance of the 
natural earth coloring. Tint Color and Tint Opacity allow you to add a tint, such as to simulate 
sunset coloring. A Natural Earth stylesheet is provided with natural earth and natural sea styles 
already set up.

6.4.5 Natural Sea Panel

The Database option allows you to select different types of natural sea databases (for example, 
Digital Globe).

The Natural Sea panel allows you to control the appearance of the sea when colored with the 
Natural Sea option, which uses satellite imagery of shallow seas and reefs.

Note: Natural Earth is an optional feature that requires a separate license; ask your local 
Vizrt representative for more details.


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6.4.6 Ocean Contours Panel

The Ocean Contours panel allows you to define the ocean depths corresponding to each color.

The left ramp works in exactly the same way as the ReliefColor ramp. The right scale shows how 
the color ramp is applied to the ocean depth steps.

See Also

Setting Map Features

6.5 Markers Panel
The Text panel allows you to choose a marker to identify each point feature, and the Strap panel 
allows you to choose a marker to be drawn alongside the label.

The Markers panel allows you to display and edit the available markers, and specify the scale and 
position of each marker.

6.5.1 To Load an Image for Use as a Marker
Click the + button and select the image file you want to load.
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6.5.2 To Edit the Name of a Marker
Select the marker in the Markers list.
Click the Rename... button.

6.5.3 To Delete or Replace a Marker
Select the marker in the Markers list.
Click the X or Replace... button.

6.5.4 To Edit a Marker
Select the marker in the Markers list. The marker is displayed in the preview window to the 
right of the Markers list.
Specify the scale by editing the X, Y, Width, and Height fields, as required.
Select Fix aspect ratio to keep the aspect ratio fixed.
Click the + button and click on the preview window to set the origin for the marker.

6.6 Textures Panel
The Color panel allows you to choose a texture to color an area feature.

 
The Textures panel allows you to display and edit the available textures.

6.6.1 To Load an Image for Use as a Texture
Click the + button and select the image file you want to load.

6.6.2 To Edit the Name of a Texture
Select the texture in the Textures list.
Click the Rename... button.
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6.6.3 To Delete or Replace a Texture
Select the texture in the Textures list.
Click the X or Replace... button.

6.6.4 To Display a Texture
Select the texture in the Textures list. The texture is displayed in the preview window to the right 
of the Textures list.

6.7 Lighting Panel
Every style sheet can contain one or more lights, called style lights, which are used in addition to 
any lights you have added directly to an individual map layer. Since the lights are in the style sheet 
itself, they are applied to any map layer using the style sheet.

The Lighting panel allows you to define style lights, and specify their characteristics:

You can use the Light tool on the Lighting panel to edit style lights in exactly the same way as 
lights within the layer.

See Also

Lighting and Effects
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6.8 Map Features Panel

The Map Features panel allows you to define the map and street data to be included in the map 
layer, and the scaling of road and rail features.

You can override these for a particular map layer using the Map Features dialog box; see the 
Setting Map Features section.

6.8.1 Global Map Data
Allows you to specify which lakes, rivers, roads, and rail features are displayed by choosing the 
appropriate option from the corresponding drop-down menu.

6.8.2 Local Street Data
Allows you to specify which lakes, rivers, roads, and rail features are displayed in street data by 
choosing the appropriate options from the corresponding drop-down menu.

The Enable option allows you to specify whether or not street data is displayed in the map layer.

The Street Data... button displays the Street Data Directory dialog box, and is equivalent to 
choosing Street Data… from the Import menu.

For more information about working with street data see the Working with Street Maps section.

6.8.3 Scale Roads/Rail with Map
Determines how roads and railways are scaled as the map is scaled.

The Scale Factor setting is used to scale all line features, such as road, rail, and rivers. You can 

adjust the value to achieve particular effects; for example, reduce it below 1.00  to make all line 

features thinner.
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6.9 Options Panel

 
The Options panel allows you to control the land drop shadow, line widths, and the appearance of 
latitude and longitude lines.

Land Drop Shadow: Allows you to specify whether land is displayed with a drop shadow, and 
whether a drop shadow is also displayed for lakes/wide rivers and/or narrow rivers. Click the 
Settings… button to define the shadow.
Border Widths: Allows you to specify the line widths for country, region, sub region, and 
coast outlines.
River Widths: Allows you to control the width of lines used to draw rivers that are not wide 
enough to be drawn as area shapes.

Master Scale: Affects the width of all rivers drawn as lines.
Smaller Rivers Scale: Affects the width of rivers which are classified as minor rivers.
Max Width (Pixels): Determines the maximum line width at which rivers are drawn. 
This is useful if you wish to prevent rivers being drawn as very thick lines as a map 
zooms in.

Lat/Long Settings: Allows you to control the appearance of the latitude and longitude lines, 
drawn in the Latitude/Longitude style.
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To draw lines on both land and sea, select Draw lines on land as well as sea. If 
unchecked, the lines are drawn on the sea only.
To prevent longitude lines from drawing at the poles, where they are very close 
together and eventually meet, select Prune longitude lines at poles.

To alter the spacing of the longitude and latitude lines, choose an option from the 
appropriate line spacing pop-up menu, or choose Custom and click the Customize 
Spacings… button to specify the spacing or number of divisions and origin explicitly:
The color and width of the lines can be changed by choosing the Latitude/Longitude
style on the Styles panel.

6.10 Using Imported Relief Data
Viz World Classic allows you to import additional detailed relief data. A wide range of data is 
available directly from Vizrt and from third parties. Supported file formats include:

CDM (Curious DEM) from Vizrt.
Some types of DEM and SDTS from USGS, who provide data for most of the US and a number 
of other areas of the world.
Some BIL images from Global Terrain.
Some types of SRTM and DTED format data.

Please contact your local Vizrt representative for a full list of supported file formats and data 
products.

This section contains information on the following procedures:

To Import CDM Relief Data
To Import Relief Data
To Obtain DEM Data
To Undo DEM Imports
To Use Multiple DEM Databases
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6.10.1 To Import CDM Relief Data
On the Import menu, select Curious CDM DEM Data ....
Choose where the data is to be installed and click the Copy New Data… button.

For each set of CDM data you want to use you need to add a licence in the usual way. To show a 
list of the CDM data you have installed, and its license status, click the Check existing data for bad 
files or licences button.

6.10.2 To Import Relief Data
On the Import menu, click DEM Digital Elevation Model.... The Import Digital Elevation Model
dialog box is displayed.

This shows the contents of the relief database, and allows you to add new files to the 
database. The Import DEM... button allows you to import DEM files from external sources.

You can undo the most recent imports using the Undo Imports button, or fit the map to the 
selected imports using the Fit Map To Imports button.

Because imported DEM data does not always match exactly with the data provided as standard 
with Viz World Classic, seams sometimes are visible at the edges of imported data. To avoid this, 
you can animate the amount of imported relief to be used, so that the imported relief is only 
visible when zoomed in enough that no such edges are visible, using the Imported Relief Blend
control in the Map Features dialog box; for more information see the Setting Map Features section.

6.10.3 To Obtain DEM Data
Because DEM data for the whole world would occupy literally thousands of gigabytes, the data 
usually comes in tiles. You need to obtain several such tiles to cover the area you require.

For information about obtaining DEM data contact your local Vizrt representative.

6.10.4 To Undo DEM Imports
Because of the sheer amount of data involved with DEM files, and the unfortunate fact that DEM 
tiles need not actually have straight sides, providing a facility for undoing imports requires 
significant amounts of disk space.

Viz World Classic allows you to choose how much disk space to be allocated for undo information 
in the Options dialog box. You can only undo the most recent imports from the bottom of the 
import list, and it may not even be possible to undo these if there was insufficient disk space to 
hold the required undo information.

6.10.5 To Use Multiple DEM Databases
You can change the directory that Viz World Classic uses to store DEMs in the Options dialog box. 
Using several different directories allows you to have multiple DEM databases, each of which holds 
detailed relief data for a particular area. This can be useful if you need high-resolution relief data 
for a particular project, but do not want to keep using that imported data in your normal day-to-
day work.
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7 Reusing Design Elements
This section explains how you can easily reuse styles, layers, and colors which you have created in 
earlier projects. It also describes recommended techniques for setting up and sharing style sheets, 
templates, and projects between users.

This section contains information on the following topics:

Importing from a Project
Reusing Style Sheets
Using Templates
Reuse Design Elements
Using Color Palettes
Sharing Databases

7.1 Introduction
From the outset Viz World Classic has been designed to allow you to separate the design of the 
appearance and house style of your map animations from the creation of the individual maps 
themselves:

You can import styles, presets, color palettes, or layers from another project, to allow you to 
use them in a new project.
Style sheets record all the essential information describing how a map should look, and can 
be reused in different projects.
Templates allow you to set up blank projects containing selected styles, layers, and settings 
ready to be used for the creation of new projects.
User map details and alternate names databases allow you to standardize alternative 
spellings for place names and user added places.

Each of these features is a powerful tool for standardizing maps developed by a group of users, 
and they can be shared between users by saving them into a directory accessible by all users and 
machines.

7.2 Importing From A Project
The Project Import dialog box allows you to import styles, presets, colors or layers from another 
project.
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7.2.1 To Import from a Project
On the Import menu, click From Project.... The Open dialog box allows you to select another 
project to import from:

Select the project you want to use and click the Open button. The Project Import dialog box 
shows the reusable features in the project, and allows you to select which features you want 
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to import:

Click the Styles, Presets, Colors, or Layers tab as appropriate and select the features you 
want to import.
Hold down SHIFT to select multiple contiguous items, and CTRL to select multiple non-
contiguous items.
Click the Load button to import the specified features into the current project.

7.3 Reusing Style Sheets
Careful design of the styles you wish to use can greatly increase the speed at which high-quality 
maps can be created by a group of users. Users just need to select the correct style, and they can 
then create maps without having to be concerned with the design or appearance.

A number of sample style sheets are included with the software. You can import these as 
described below.

7.3.1 To Share a Stylesheet between Projects and Users
Once you have designed a style sheet that you would like to use in other projects, or make 
available to other users, you can save it to disk as follows:
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Click the Export... button in the Styles Editor dialog box to save a copy of the style sheet in a 
shared directory.

7.4 Using Templates
When you create a new project you can choose to base it on a project template which defines the 
default styles, style sheets, color palettes, and predefined layers and settings to be included. You 
can save any project as a template file and then use it as the basis for new projects.

If you create a new project without selecting a template, a default project template is used. A 
simple default project template is supplied and automatically used by Viz World Classic, but you 
can create a new default template of your own, containing all the settings you want to use on a 
regular basis.

This section contains information on the following procedures:

To Create a Project Template
To Specify a Template as the Starting Point for a Project
To Set the Default Project Template
To Share Project Templates

7.4.1 To Create a Project Template
Create a new blank project.
Define or import all the styles, color palettes, Navigator presets, and layers you would like to 
have in the template.

Note: Each user can then import styles from the style sheet file using Import... in the Styles 
Editor.


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On the File menu, click Save As....

In the Save As dialog box choose Project Template from the Save as type (PC) or Format
(Mac) drop-down menu.
Enter a name for the template and click the Save button. Opening the template then creates 
a new untitled project containing the contents of the project you saved, and you are 
prompted to give it a new name when you save the file.

7.4.2 To Specify a Template as the Starting Point for a Project
Select Use a project template in the Welcome or New Project dialog box, and select the particular 
template you want to use.
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7.4.3 To Set the Default Project Template

On the View menu, click Options....
Click the Template option to display the Template panel.
Click the Browse... button and select the appropriate template file. The default project 
template is used whenever you create a new project by selecting Create map project in the 
Welcome or New Project dialog box.

7.4.4 To Share Project Templates
To share project templates put them into a shared directory. All users can then use the same 
styles, colors, Navigator presets and layers by default.

7.5 Reuse Design Elements

7.5.1 Reuse of Stylesheets
Careful design of the styles you wish to use can greatly increase the speed at which high-quality 
maps can be created by a group of users. Users just need to select the correct style, and they can 
then create maps without having to be concerned with the design or appearance.
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7.5.2 Reuse of Layers
You can use templates to provide users with an initial set of layers for use in the maps they are 
creating. For example, if the users are creating maps, all of which contain the same logo and 
headline text, you could create a template containing the appropriate image and text layers.

7.5.3 Reuse of Navigator Presets
Templates include the Navigator presets, which are a quick way of defining a map’s position and 
scale. If you frequently use a small number of set map settings you can save these as a preset in a 
project template and make them available to all users.

7.6 Using Color Palettes
Templates include color palettes, which are selections of user-defined colors in the Color dialog 
box:

 
You can create several palettes and select the one you want to use from the pop-up menu above 
the palette.

This section contains information on the following procedures:

To Edit the Color Palette
To Select a Color
To Pick a Color from the Viewer
To Add the Current Color to the Palette
To Delete a Color from the Palette
To Create a New Palette
To Save or Load Palettes



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  134

•

•

•

7.6.1 To Edit the Color Palette

Click the Edit Palette button in the Color dialog box. The full Color editor is displayed (see above).

7.6.2 To Select a Color
Either:

Click in the color space in the top left corner of the Color chooser.

Or:

Click the color sliders in the top right corner of the Color chooser.

Or:

Enter the color values in the fields to the right of each color slider.

You can change the color space displayed in the Color chooser by choosing an option from the 
pop-up menu. You can change the values shown on the color sliders, and the range of each value, 
using the two pop-up menus below the color sliders.

7.6.3 To Pick a Color from the Viewer

Click the Pick Color  tool. Click in the Viewer to select that color.

Tip: To cancel the operation / close the palette editor click Palette Only.
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7.6.4 To Add the Current Color to the Palette

Click the Add Color  button.

7.6.5 To Delete a Color from the Palette

Click the color to select it. Click the Remove Color  button.

7.6.6 To Create a New Palette
Click the New Palette button below the palette. The new palette becomes the current palette.

7.6.7 To Save or Load Palettes
Use the Save Palette and Load Palette buttons. This is useful for exchanging palettes between 
different users, archiving them for future reuse, or copying them from one style sheet or project to 
another.

7.7 Sharing Databases
New features, defined using the Add New Label or Add New Feature dialog boxes, are stored in a 
user map details database; for more information see how To Define a New Feature on the Map or 
how To Define a New Feature from Explorer.

Alternate names, defined using the Properties panel on the Contents panel, are stored in the 
alternate names database; for more information see the Setting the Properties for Details section.

The user map details, alternate place names and abbreviations databases can be shared between 
users by placing them in a shared directory. This allows users to benefit from any user map details 
and new names added to the database.

This section contains information on the following procedure and topic:

To Share User Map Details, Alternate Place Names
Editing User Map Details or Alternate Place Names

7.7.1 To Share User Map Details, Alternate Place Names
User map details and alternate place names are stored in text files, and can be shared among 
users by placing them in a shared directory. To modify the location of these files:
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On the View menu, click Options....

In the Options dialog box select Shared in the Map Data section.
Click the Browse... button and specify the new location for the appropriate file.

7.7.2 Editing User Map Details or Alternate Place Names
You can edit the user map details, alternate place name and abbreviations files using a simple text 
editing application such as Notepad, Notepad++ or SimpleText. This can be useful if places or 
names have been added incorrectly and need to be deleted or modified. You can find the path and 
filename of each file as described above.
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8 Working With Street Maps
Viz World Classic allows you to import street data for towns and cities, to create maps from the 
whole world down to a single street corner or building. The Street Data format is supplied and 
configured with appropriate labels for each of the features, and so using it is simply a matter of 
adding it to your map. Viz World Classic also supports map data in ESRI Shape File format; for 
more information see the Working with ESRI Shape Files section.

This section contains information on the following topics:

Using Street Data
Loading Street Data
Tracing Street Data

8.1 Using Street Data
A wide range of street data designed especially for use with Viz World Classic is available for most 
parts of the world from Vizrt.

For more details, and to order, please contact your local Vizrt representative.

8.2 Loading Street Data
To use street data for a particular town or city you first need to install the street data into an 
appropriate directory on your disk, and then add a license for the data. For more information 
about adding a license see the Installing Viz World Classic section.

This section contains information on the following procedures:

To Specify the Location of Street Data
To Load Street Data
To Use Street Data
To Display Street Data
To Highlight Individual Features
To Label a Feature

8.2.1 To Specify the Location of Street Data
When you install street data it is copied to the Street Data location specified in the Options dialog 
box. This is initially set to a default location, but you can change it as follows:

On the View menu, click Options..., then click the Locations tab to display 
the Locations panel of the Options dialog box. The Street Data field shows the directory 
used for street data files.
Click the corresponding Browse... button and select the appropriate location to change the 
directory used for street data files.
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8.2.2 To Load Street Data
On the Import menu, click Street Data... The Street Data Management dialog box shows the 
street data sets you have available:

Click the Install More Data... button to install additional street data sets from disk or CD-
ROM, or by scanning the street data directory for new data. The following dialog box is 
displayed:
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Either select Copy new data from some other directory or disk, click the Choose 
Folder button, and locate the source of the new data.
Or select Scan the directory where Street Data is already installed ... to automatically 
locate new data. Then select the data set you want to load and click the Load 
Now button.

Repeat for any other street data sets you want to load.
Click the Close button to close the dialog box.

8.2.3 To Use Street Data
Click the Streets tab in the map layer Contents panel to display the street data sets you have 
loaded.
Select the street data set in the left list to show the features it contains:

Select which features you want to display from the pop-up menu below the features list. This 
includes different road categories, railways, rivers and lakes, and a range of other urban 
features.

Tip:  You can also select  Always load at start-up to load the specified street 
data each time you run Viz World Classic.


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8.2.4 To Display Street Data

Click the street data set name with the right mouse button and click Fit map on the pop-up 
menu. The street data is drawn, scaled to fit within the image window:
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8.2.5 To Highlight Individual Features
You can add a feature to the Details list so you can modify its appearance, to highlight it on the 
map.

Either:

Select the feature in the features list and click the Add Feature To Details button.

Or:

Click the feature with the right mouse button and click Add to map on the context menu:

 
Area features, such as lakes and parks, are initially drawn with a label. Line features, such as 
roads and rivers, are initially drawn unlabeled. You can add a label at a specific position as 
described in the next section.

8.2.6 To Label a Feature

Note: The style sheet specified for the map layer determines which lakes, rivers, roads, and 
railways are drawn on the map. You can override this for the current map layer by clicking 
the Map Features button in the top right corner of the Contents panel.


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Select the Browse Street/Shape Data tool. As you move this over the map a tool-tip shows 
you the name of each street data feature:

Click with the right mouse button and choose the appropriate label option from the pop-up 
menu:

 
Add: Adds the feature without a label, so you can highlight it by editing its style.
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Label: Adds the feature with the label positioned at the point you clicked. If you are 
labeling a line feature the label will be drawn aligned with the direction of the feature.

Use the Text tool to move or rotate the label as desired.

8.3 Tracing Street Data
You can use the shape tools to trace street data in order to add lines and area shapes to your 
street maps.

For example, you could trace streets to draw a line shape showing the route of a carnival. 
Alternatively, you could trace an area of a city to create an area shape showing a proposed traffic-
free zone.

See Also

To Draw Shapes by Tracing Map Features
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9 Working With Images And Movies
This chapter contains information on the following topics:

Importing an Image or Movie
Moving, Resizing, or Rotating an Image
Specifying the Contents of the Image
Using the Keyer
Image Rotoscoping
Setting the Image Properties

Viz World Classic supports a wide range of alternative image and movie formats, summarized in 
the table below.

Extension Format

.avi Video for Windows movie

.bmp Windows bitmap

.cin Kodak Cineon image

.cmr Curious Multi-Resolution bitmap image

.exr OpenEXR image

.dpx DPX image

.gif Graphic Interchange Format

.iff Alias/Wavefront Paint Image

.jpg or jp2 JPEG compressed image

.mov QuickTime movie

.ntf National Imagery Transmission Format

.sid MrSID multi-resolution image (PC only)

.psd Adobe Photoshop image (supports transparency)

Note: Viz World Classic 64-bit version does not support movies added as layers.
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Extension Format

.pct Macintosh PICT

.png Portable Network Graphics (supports transparency, paletted, 
grayscale, and true-color images)

.sgi or .rgb Silicon Graphics Image (supports transparency)

.tga Targa bitmap

.tif or .tiff Tiff bitmap format

.qtif QuickTime image

9.1 Curious Multi-Resolution Format
Viz World Classic provides the proprietary CMR (Curious Multi-Resolution) image format, which 
allows very large images to be included in maps without the memory overhead normally associated 
with images in the standard file formats. CMR formatted images can be used in any context where 
an image file can be specified, including in image layers and as textures for maps. For example, 
satellite images and high-resolution photographs can be used to fill a region of a map. When you 
zoom in close, an appropriate high-resolution tile of the image is loaded, avoiding the need to 
have the whole high-resolution image loaded at all times.

An optional Convert Large Images tool allows you to convert an image into CMR format from any 
of the common file formats including Photoshop, TIFF, and BMP.

9.2 Cineon Files
Viz World Classic includes support for Cineon files, which use a logarithmic color space to provide 
a better representation of dark colors. Because Viz World Classic works in a linear color space, it 
allows you to specify how Cineon files are handled on loading and saving.

On the View menu, click Options....
In the Preferences dialog box select Cineon in the File Formats section. The following 
options are provided:

No conversion: The images are left in logarithmic space, so loading them and saving 
them again makes no alteration to the pixel values in the files. You can use the Viewer 
LUT Controls option to compensate for the darker appearance of Cineon files when 
working with them in the Viewer.
Convert to/from linear : Converts Cineon files from the logarithmic color space to the 
linear color space on load, and back again on save. An allow headroom option varies 
the conversion so that overexposed images retain more detail in the very bright 
overexposed regions.
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9.3 Importing An Image Or Movie
This section contains information on the following topic and procedures:

To Import an Image or Movie
To Convert an Image to a CMR Format
To Convert Multiple Geo-referenced Images to a Single CMR Image
Using Geo-referenced Images
To Add Geo-referenced Images
To Add Satellite Images

9.3.1 To Import an Image or Movie

On the Layer menu, point to Add Layer, and then click Image or Movie.
The following dialog box allows you to select an image to import, and optionally 
preview it.
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Select the image or movie file and click the Open button to import it.
A new image layer is automatically created for the imported image or movie. Note that 
each image or movie is contained in a separate layer.
If you open a project that uses images, or movies, that are no longer available they are 
displayed as a red cross.
If you import a movie the Match Time Range to Movie dialog box appears. This allows 
you to adjust the time slider’s range and/or the project’s frame size, rate and duration 
to match the clip you are importing.
If they have moved you can use the Change Image... button on the Contents panel to 
locate them.

9.3.2 To Convert an Image to a CMR Format

On the Tools menu, click Convert Large Images.... The following dialog box allows you to 
specify the image to convert, and a filename for the CMR (Curious Multi-Res) image:
Browse for and select the input image to be converted.
Browse for and select the location for the output image and specify a filename for the CMR 
image, which can be the same as the input image.
Click the Convert button to convert the image to the CMR format. You can then select the 
CMR image just as you would any other image in Viz World Classic. You can also make a 
compressed version in the following dialog box.

Note: Viz World Classic 64-bit version currently do not support movies added 
as layers.



Note: The Convert Large Images tool makes a copy of the original image; it therefore 
requires at least as much available disk space as the size of the original image.


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9.3.3 To Convert Multiple Geo-referenced Images to a Single CMR 
Image

The Convert Multiple Images tool allows you to convert a number of adjacent geo-referenced 
images into a single large image, in CMR (Curious Multi-Res) format.

On the Tools menu, click Convert Multiple Images. The Combine & Adjust Multiple Images 
dialog box allows you to specify the input and output images.

Intermediate Images: Allows you to specify where the intermediate CMR files should 
be stored, and whether they should be kept after the conversion is finished.
Adjust, Tint: Provides color correction options to allow you to make the resulting CMR 
file match other images you are already using.
Edging: Uses a soft edge when joining the individual tiles to obscure any seams that 
may arise.
Key: Allows you to key out, or remove from the image, areas of a particular color with 
a specified tolerance. For example, this allows you to make the sea transparent in the 
finished CMR image by specifying blue as the key color.
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9.3.4 Using Geo-referenced Images
Much satellite and aerial photography is now available in a geo-referenced format, which includes 
the precise location of the image on the Earth’s surface. Viz World Classic supports the following 
geo-referenced formats:

GeoTiff – where the data is embedded in a TIFF file.
Tiff World – where the data is in an accompanying text file.
Geo-referenced NITF

It is recommended that you convert large geo-referenced images to a CMR format before importing 
them.

9.3.5 To Add Geo-referenced Images
Either:

On the Layer menu, point to Add Layer, and then click Image or Movie.
Select the geo-referenced image file.

Or:

Add the image as a texture to an existing style in the Styles Editor.

The following dialog box allows you to pin the image to the correct location on the map:

Click the Yes button to pin the image using the georeference information.

Note: Viz World Classic 64-bit version currently do not support movies added as layers
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9.3.6 To Add Satellite Images

Select a map layer.
Select the Contents tab and then the Overlays tab.
Click the Add Satellite Image button.
In the Image Manager click the + button to browse for and add your image/CMR.
Click the Add to map button.
Close the Image Manager.

9.4 Moving, Resizing, Or Rotating An Image

The Move/Pan tool  allows you to move, scale, or rotate an imported image or movie.

This section contains information on the following topics:

To Move an Image
To Resize an Image
To Rotate an Image

Note: The imagery is not a part of the base map (see Working with Maps).
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9.4.1 To Move an Image

Position the mouse pointer within the image and drag the image to the required position.

9.4.2 To Resize an Image

Move the mouse pointer to one of the eight handles on the corners or midpoints of the 
edges.
Drag to resize the image.
Hold down CTRL to constrain the image to its original aspect ratio.
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9.4.3 To Rotate an Image

Point to the rotation handle, which is a yellow square to the right of the image center. The 
cursor changes to a rotation symbol.
Drag the handle to rotate the image about its center.

9.5 Specifying The Contents Of The Image

 
The Contents panel displays information about the image or movie, and provides options to allow 
you to change the contents.

This section contains information on the following topics:

Controlling Image Transparency
To Set the Start Time and Looping



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  153

9.5.1 Controlling Image Transparency
Images and movies used in an image layer may contain an alpha channel (or matte) which defines 
transparent areas of the image. You can specify how the alpha channel is interpreted to give 
greater control over the appearance of matted images.

Click the Alpha... button to display the Alpha Interpretation dialog box. By default Guess is 
selected, which automatically selects the best option in most situations. Choosing the correct 
option should produce an image without noticeable banding, fringes, or speckling around the 
edges. You can choose one of the other options if Guess does not give the results you expect, or 
Ignore alpha to treat the image as if it had no transparency.

The following illustrations show the effect of the options:. Correct (unmatted), incorrect 
(premultiplied) and alpha ignored:
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9.5.2 To Set the Start Time and Looping
Use the Hold frame options to specify what is displayed before the start time and after the 
end time.
Select Loop movie to play the movie in a loop.

Auto: Loops the entire movie, between its start and end frames.
Every: Allows you to specify the loop frequency.

Edit the Start at time value to determine the start time of a movie.

9.6 Using The Keyer

The Keyer creates a matte which is used to cut out the foreground from the background. Mattes 
created with the Keyer can be saved and reused in other projects or applications.
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9.6.1 To Key an Image or Movie
Click the Contents tab, to display the Contents panel for the image or movie.
Click the Keyer tab, to display the Keyer.
Select Color, Chrominance, or Luminance to determine how keying is performed.
Select the Pick Background or Pick Foreground tool, and click appropriate parts on the image 
to add the corresponding colors to the range defined as background or foreground.

You can drag to define a rectangle to average the colors in the rectangle.

The sliders provide an alternative way of adjusting the components you have selected.

Each slider has four handles:

The white handles specify the range of colors treated as background, and the black handles 
specify the range of colors treated as foreground. Between each black handle and the 
corresponding white handle there is a smooth transition between foreground and background.

Drag the Erode slider to reduce the size of the masked area, to hide edge effects, and add a 
softness to blur the edge of the image.
Use the Suppress Amount and Suppress To controls to reduce the amount of the keyed color 
from the image.

This is useful for hiding reflections from the blue or green screen.

9.6.2 To View the Effect of the Keyer
The paint controls to the right of the Keyer allow you to choose whether the Viewer shows the 
keyed image, Keyer matte, or both:
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9.6.3 To Render the Keyer Matte

Click the Render Matte... button in the paint controls.

This is equivalent to the Render Matte... command on the Layer menu, and displays the Render 
Layer Matte dialog box to allow you to render the Keyer matte and/or the roto matte as a separate 
movie.

9.6.4 To Cut an Image from a Blue Screen
The following example illustrates a typical application of the Keyer, to cut out a subject filmed 
against a blue-screen or green-screen background, so it can be superimposed on another 
background.

Load the image or movie into a new image or movie layer.
Click the Keyer tab to display the Keyer.
Click the Contents tab, to display the Contents panel for the image or movie.
Select Color to key on a specified color range.
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Select the Pick Background tool and drag to define a rectangle enclosing the blue-screen 
background:

When you release the mouse button the keyed image is displayed.

You can refine the keyed area by clicking or dragging with the Pick Background tool to increase the 
areas of background removed, or by clicking or dragging with the Pick Foreground tool to reduce 
the areas of background removed.

Alternatively you can adjust the key using the color, chrominance, or luminance sliders.

9.6.5 To Remove the Color Cast
Subjects filmed against a blue-screen or green-screen typically have a blue or green cast. The 
Suppress option enables you to remove this.

Drag the Suppress Amount slider until the cast is removed. Too high a value introduces a 
contrasting cast.
Optionally change the Suppress To color to suit the replacement background.

You can then superimpose the subject onto an alternative background:
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9.7 Image Rotoscoping

 
The Roto Matte panel on the Contents panel allows you to add one or more shapes to an image or 
movie layer to mask dynamically, tracking them as they move in successive frames. This is often 
referred to as a roto matte or rotoshape.

For more information about creating and editing shapes see Working with Shapes.
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9.7.1 To Create an Animated Shape
Move to the first frame of the movie.
Create one or more shapes using the shape tools to outline the feature in the movie that you 
want to process.
Move to the last frame in the movie, and adjust the shape so that it matches the feature.
Check the intermediate frames, and make any necessary adjustments to keep the shape 
tracking the feature.

9.7.2 To View the Effect of the Roto Matte
Select Apply Roto Matte. The roto matte dynamically cuts out the image to reveal the 
background:

The paint controls to the right of the Roto Matte panel allow you to choose whether the 
Viewer shows the keyed image, roto matte, or both:

9.7.3 To Render the Roto Matte
Click the Render Matte... button in the paint controls. This is equivalent to the Render Matte...
command on the Layer menu, and displays the Render Layer Matte dialog box to allow you to 
render the Keyer matte and/or the roto matte as a separate movie.
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9.8 Setting The Image Properties

 
The options on the Properties panel allow you to specify the compositing options for the image or 
movie, transform it, and add a drop shadow, frame, edging, or animation trail. It also provides 
several animation options.

This section contains information on the following topics:

Compositing Options
Transform Options
Drop Shadow Options
Frame Options
Edging Options
Trail Options
Export Producer Options
Instant Maps Export Options
Automation Options
Mask Options

9.8.1 Compositing Options

 
Blend Mode specifies how the layer is combined with the other layers, and can be one of.

Normal, Add, Subtract, Difference, Multiply, Darken Only, Burn, Color Burn, Screen, Lighten Only, 
Dodge, Color Dodge, Hue, Saturation, Value, Color, Overlay, Soft Light, Hard Light, Pin Light, 
Exclusion, or Negation.
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The Opacity determines the layer opacity, and can be animated.

Animating the opacity from 0% to 100% can be used to cause the image to fade in smoothly over a 
specified period of the animation.

9.8.2 Transform Options

 
These options allow you to specify the position, scale, rotation, and origin numerically.
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The Set Using GPS button is used to position the image using UTM coordinates, which are normally 
supplied with aerial photographs and satellite imagery, or using latitude/longitude coordinates.

Latitude and longitude coordinates can either be entered in decimal degrees, such as 20.175, or in 
degrees, minutes and seconds, such as 20d10m30s.

For images provided by Global Terrain Inc., the Use Metafile... button reads the UTM coordinates 
directly from the metafile provided with the image.

The Pinned on Map, Wrap on Map, and Scale with Map options duplicate the options in the Map 
Usage section of the Properties panel; for more information see how To choose how the image 
moves relative to the map.

To Change the Origin of the Image
The origin determines the point about which the image is rotated or scaled, and defaults to the 
center of the image. Edit the Origin values to specify the position in pixels relative to the lower left 
corner (south-west) of the image, or choose one of the predefined options from the Origin drop-
down menu.
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9.8.3 Drop Shadow Options

 
Select Drop Shadow to turn on a drop shadow for the layer. The following parameters are 
provided:

Parameter Description

Offset The offset of the drop shadow, in pixels.

Opacity The opacity of the drop shadow. 0%  gives no drop shadow.

Softness Blurs the drop shadow to smooth the edges. Values in the 

range 0–5  are recommended.

Color The color of the drop shadow.

The following example shows a drop shadow with offset X=3, Y=3, and Softness=2:
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9.8.4 Frame Options

 
Allows you to add a colored fill, and/or border to the layer. Border Width specifies the width of the 
border in pixels.

9.8.5 Edging Options

 
The Edging options allow you to add a vignette to the image or movie.

Choose Rectangle or Circle from the Type pop-up menu to vignette the image with a soft 
border of the corresponding shape.
Use the Size control to adjust the size of the shape.

This option is especially useful when superimposing one image on another, to hide the edges of 
the top image.

The following example shows a circular vignette with a size of 100:
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9.8.6 Trail Options

 
The Trail options allow you to leave a trail as the image animates. For more information see the 
Leaving an Animation Trail section.

9.8.7 Export Producer Options

Note: No longer supported.
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9.8.8 Instant Maps Export Options

 
Allows you to make maps available to the Viz World Instant Map tool.

9.8.9 Automation Options
The Properties panel includes an Image Placement tool, to help align images accurately to 
positions on another image.

Click the Image Placement tool in the Automation section of the Properties panel.

Two arrowhead controls are displayed in the Viewer to allow you to indicate the transformation 
you want.

Position the circles on two appropriate points on the image.
Position the arrowheads on the background to indicate where the points should be mapped 
to.
Click the Apply button.

The image is transformed to align the points on the image with the points on the background you 
have specified.

To Choose How the Image Moves Relative to the Map
Viz World Classic provides several options that allows you to control how the image moves relative 
to the map layer.

By default the image position is independent of the map position. Pin on map keeps the image at 
the same latitude and longitude as the map moves. Wrap on map projects the image onto the map, 
according to the map projection. Only available if Pin on map is selected. Alternatively, Scale with 
map scales the image as the map is zoomed. Only available if Pin on map is selected.

These options are selected in the Map Usage section of the Properties panel.

The images below show a map with default, pin, wrap and scale modes:
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9.8.10 Mask Options
See Controlling Layer Compositing.

See Also

Auto Animate and the Automatically Animating a Layer section.
Match rotation to path and how To Align the Image, Text Item, or Drawing to the Angle of 
the Animation Path.
Controlling Layer Compositing
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10 Painting
This section explains how to use the paint and image processing tools on the Paint and Graphics 
panels to paint directly onto image/movie layers, for retouching or enhancing an existing image, 
masking areas of an image, or creating original freehand artwork.

This section contains information on the following topics:

Paint and Image Processing Tools
Painting Onto an Image
Adding Graphics to Images

10.1 Paint And Image Processing Tools

 
Viz World Classic provides a wide range of paint and image processing tools divided into eight 
categories.

The Paint panel provides a selection of options for each category of paint and image processing 
tools. You can select a category by clicking the icon to the left of the Viewer, or by clicking the 
corresponding tab on the Paint panel. The following table describes the functions available within 
each category of paint and image processing tools:

 Brushes: Provides a selection of brushes to allow you to paint directly onto an image or 
movie, or its mask.

 Graphics: Allows you to paint geometric shapes onto an image or movie, or its mask.

 Shapes: Allows you to add drawings to the project by creating editable vector shapes.

 Text: Allows you to add text to an image or movie, or to the mask.

 Cutouts: Allows you to cut out part of an image to create a floating image overlay called 
a cutout.

 Fx: Provides a range of paint effects for color correction, filtering, keying, or procedural 
effects.

 Image: Provides image transformations.

 Mask: Provides a range of options for extracting a mask from an image based on the 
parameters of the image.

 Macros: Allows you to record a series of actions, and then replay them on several 
frames in a movie or in different projects.
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This section contains information on the following topics:

Paint Controls
Overlays
Undo and Restore Options for Painting

10.1.1 Paint Controls
The paint controls, displayed to the right of each of the Paint panels, allow you to specify how 
operations using the brushes, shapes, and text affect the current image and its mask:

 
The mask can be used to protect the image from changes when painting on the image using the 
brushes or graphics tools, and sticking shapes or text on the image.

At any pixel where the mask is at full density, the image is not affected by any operation. At pixels 
where the mask is completely transparent, operations are applied in full. Intermediate values result 
in a blend between the original image color and the changes.

To Protect the Image with the Mask
Select Protect with mask.

To Specify What is Affected by Painting Operations
Painting operations can be applied either to the image or to the mask or to both simultaneously: 
Select Paint Image and/or Paint Mask to affect the image and/or mask respectively.

To Specify Whether the Image or Mask Are Displayed in the Viewer
Select Display Image and/or Display Mask to display the image and/or mask respectively.
Use the slider below the Display Mask checkbox to change the opacity of the mask displayed 
on the screen.

Note: This only affects the screen display, not the actual density of the stored mask.
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To Use Onion Skinning
The Onion Skinning control allows you to reduce the displayed opacity of the foreground image in 
the Viewer to allow you to see the background while working on the foreground. A typical use is in 
wire removal when merging portions of a background image to replace unwanted elements in the 
foreground.

In Composite display mode, the background is the composite of the other layers.
In the Single Layer display mode, you can specify which layer to use as the 
background: Click the eye-dropper icon in the Layers list to indicate which layer you want to 
use as a background.

Selecting Invert allows you to invert the background, which is useful for highlighting the 
differences between two very similar frames.

To Fill or Clear the Image or Mask or Invert the Mask
The Fill Image and Fill Mask buttons allow you to fill the image or mask with a solid color. You can 
set the fill color by selecting a color and then clicking in the square to the right of the Fill Image or 
Fill Mask button.

The Clear Image and Clear Mask buttons clear the image or mask to transparent, and the Invert 
Mask button inverts the mask level at each point.

10.1.2 Overlays
The Shapes, Text, and Cutouts panels on the Paint panel allow you to create overlays as an 
intermediate step in constructing artwork. They are available to any of the image and movie layers 
in your project, and at any stage you can paint them onto an image or its mask; this is called 
sticking the overlays.

 
For more information about creating shape overlays see Working with Shapes.

Note: This only affects the display, not the stored image.
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To Show or Hide an Overlay
Click the eye icon to the left of the shape name in the Overlay list. The icon changes to show 
whether the shape is hidden:

 Shown
 Hidden

To Rename an Overlay
Click the Rename... button below the Overlay list.
Enter a name for the overlay and click the OK button:

To Change the Order of Shapes in the Overlay List
Either:

Select the overlay you want to move.
Click the up or down button below the Overlay list.

Or:

Click the overlay you want to move with the right mouse button and select one of the 
Ordering options from the appearing context menu.

Or:

Drag the shape to the new position in the Overlay list.

To Delete an Overlay
Either:

Select the overlay you want to delete and press the BACKSPACE button.

Or:

Click the overlay you want to delete with the right mouse button and click Remove from the 
appearing context menu.

To Copy an Overlay
You can cut, copy, and paste Overlays between layers or between projects. You can also export 
one or more shapes, and then import them into another layer or another project, using the 
Export... and Import... options from the Overlay list’s context menu.
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10.1.3 Undo and Restore Options for Painting
Viz World Classic allows you to undo brush strokes while painting, and you can also restore the 
image or its mask to the last saved version or to the original frame.

To Restore the Image or Mask
On the Layer menu, click Restore Image or Restore Mask, then click To Last Saved or To Original 
Frame on the submenu.

To Select the Paint Undo Options
By default, Viz World Classic allows you to undo each brush stroke while painting, to a limited 
undo depth, to minimize the amount of work you need to redo in the case of a mistake. However 
this level of undo control is memory intensive, and may cause noticeable delays when painting 
complex images. Viz World Classic gives you the option of reducing the degree of undo control for 
greater performance.

On the View menu, click Options....
In the Preferences dialog box select Undo in the Paint section.

The Undo drop-down menu lets you specify the degree of undo control provided. The options are 
explained as follows:

Every Stroke: Undo affects the previous painted stroke.
Similar Strokes: Undo affects all strokes made with the same brush and color settings.
Explicit: A Backup for Undo button appears in the paint controls, and Viz World Classic 
stores a snapshot of the painting each time you click it. Selecting Undo restores the previous 
snapshot.

The Memory setting allows you to allocate more memory to undo, which allows you to increase 
performance if you have sufficient memory available on your computer.
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10.2 Painting Onto An Image

 
The brushes on the Brushes panel allow you to paint directly onto an image or movie layer. You 
can paint onto the image, mask, or simultaneously onto both. Alternatively you can protect the 
image with the mask while you are painting onto the image.

In the case of a movie, painting affects the current frame of the movie, and the mask associated 
with the current frame, only. Painting can be applied automatically to multiple frames of a movie 
by recording and playing back a macro; see Automating with Macros.

A brush applies color, an image, or a filter directly onto the image or movie through a profile, 
which defines its shape.

10.2.1 To Paint the Image or Mask

Select the Paint brushes tool. This tool is automatically selected when you display the 
Brushes panel.
Select the brush you want to use in the Brush list.
Select a color for painting from the palette on the right of the Brushes panel.

Click on the image and drag to paint.

You can adjust the opacity of the paint with the Opacity slider. If you are using a pressure-sensitive 
input device, such as a tablet, the brush strokes respond to the pressure of your pen.

10.2.2 To Choose How the Mouse Cursor Displays while Painting
You can choose to hide the mouse cursor while painting, or display a colored circle or ellipse 
indicating the size of the brush:
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The images above depicts a normal cursor, hidden cursor and outlined cursor.

On the View menu, select Options...
In the Preferences dialog box select Brush Display in the Paint section:

You can set separate options for the Clone brush.

You can also turn the outline on or off, and specify its color, by clicking the buttons on the 
Brushes panel:

This section contains information on the following topics:

Specifying the Brush Settings
Creating and Editing Brushes
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1.

Defining the Brush Source
Defining Brush Filter Effects
Defining Brush Profiles
Managing Painted Materials

10.2.3 Specifying the Brush Settings
The Profile, Size, Opacity, and Settings are set to default values specified for the brush, but you 
can adjust them in the controls to the right of the Brush list.

To Define the Brush Profile
The brush profile defines the shape of the brush stamp. It is either a circle or an ellipse, with a 
falloff defined by a graph, or an arbitrary shaped cutout. There are also the special options: 
Texture, which creates a brush with a random fill pattern, and OnePixel, a one pixel solid 
brush. Select a profile from the Profile list. This gives a list of profiles defined in the Brush Editor.

To Define the Brush Size
Either:

Drag the Size slider.

Or:

Enter the size in the Size box:

Or:

Hold down CTRL and drag in the Viewer, or in the brush preview on the Brushes panel, to 
draw a circle defining the brush size.

To Define an Offset
Brushes that take paint from the image or background, such as the Clone and Drag brushes, allow 
you to define an offset.

Either:

In the Clone Offset section enter appropriate values in the X and Y fields:

Or:

Hold down SHIFT and drag in the Viewer to draw a line from the source to the destination to 
define the offset interactively.
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Click the Reset button to reset the offset to zero.

To Define the Background Transformation
Brushes that take paint from the background, such as the Merge brush, allow you to transform the 
background before using it for painting.

Set the Display option to Single Layer.
Select the image layer from the Layers list.
Click the image layer’s eye-dropper icon.

Click the Background Transformation Tool button in the Background Offset section to 
display an outline of the background image in the Viewer with handles so you can move, 
scale, or rotate it:

Once you have transformed the background close the Edit Merge Transformation to continue 
painting. You can store up to four transformations by clicking one of the > buttons and restore the 
transformation by clicking the 1, 2, 3, or 4 button.

To reset the transformation click the Reset button.

To Define other Brush Settings
Click the Settings... button to display more advanced settings for the brush. The brush settings are 
described in greater detail in the later sections of this chapter.

To Reset the Brush Settings to Default
Click the Restore Defaults button.

Built-in Brushes
The following pre-defined brushes supplied with Viz World Classic:

Color: Paints in a selected color.
Clone: Picks up paint from one area of the image and paints it to another position on the 
image, as defined by the offset.
Merge: Copies paint from a background image on to the current image.
Drag: Drags paint on the image, causing a smudge effect.
Repair: Picks up color from the image and paints with it; useful for painting over scratches 
and blemishes in an image.
Eraser: Erases pixels from the image, making them transparent. Equivalent to painting with 
the non-color.
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Chalk: Paints with a textured brush.
Blur: Blurs the image.
Oil Effect: Creates the effect of layered color in an oil painting.
Posterise: Similar to Oil Effect, but more severe.
Smooth: Similar to Blur but more dramatic.
Marble: Mixes up the pixels giving a marbling effect.
Black And White: Convert pixels to monochrome.

To Use the Clone Brush
Hold down SHIFT and drag in the Viewer to draw a line from the source point to the 
destination point:

 
The X Offset and Y Offset fields are set to the appropriate values.
Paint to create a clone of the image:

To Use the Merge Brush
The Merge brush allows you to copy paint from a background image onto the current image. For 
example, it can be used to paint out unwanted features of a scene by using a photograph of the 
background from the same position, called a clean plate.



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  180

1.

2.
3.
4.
5.

6.

7.
8.

Load the background image onto one layer:

Load the foreground image onto the current layer.
Set the Display option to Single Layer.
Click the eye-dropper icon in the Layers list to indicate which layer you want to merge from
Use the Onion Skinning control in the paint controls to reduce the opacity of the foreground, 
if desired:

Use the Merge brush to paint the background over the unwanted feature:

 
The Merge brush also allows you to scale or rotate the background image you are merging 
from.

Click the Background Transformation Tool button to transform the background.
Click the Reset button to reset the background to the original scale and position.



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  181

1.

2.

3.

To Protect Artwork with a Mask
You can use a mask to protect parts of an image while painting. For example, you could use 
a mask to protect the butterfly in the following image while painting over its shadow:

Create the mask by using a brush tool. Alternatively, you could mask the butterfly by 
drawing shape overlays and then sticking them onto the mask; for more information about 
creating shape overlays see Working with Shapes:

Set the paint controls to Protect with mask, Paint Image, and Display Image: 
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Paint the image as required; for example, use the Clone brush to paint over the shadow on 
the leaf by copying texture from the other side of the leaf:

Deselect Display Mask to show the final result:

10.2.4 Creating and Editing Brushes

 
Viz World Classic is supplied with a range of pre-defined brushes. You can edit some aspects of 
these brushes, or you can create your own completely editable brushes using the Brush Editor.
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A Brush Test window allows you to try out the effect of the brush you are designing as you edit its 
parameters.

How Brushes Work
Brushes work by performing the sequence of operations: Pickup > Filter > Stamp. These steps can 
be customized to determine the precise behavior of the brush, and are explained in greater detail 
in the following sections:

Pickup
The brush picks up paint from the specified source, which can be the current color defined in the 
Color Chooser, the image or background, or an image cutout. When picking up paint from the 
image or background, an offset can be added to the current brush position to clone one part of 
the image to another part. The paint is picked up through the selected profile, which determines 
the size of the brush, and the softness of its edges.

Filter
The paint is optionally filtered by a specified filter, such as to add noise or soften the image.

Stamp
The paint is stamped onto the image according to the decay and spacing parameters. If Protect 
with mask is selected, painting takes into account the density of the mask.

To Display the Brush Editor
Either:

On the Tools menu, click Brush Editor.

Or:

Click the Editor... button on the Brushes panel.

The Brushes list shows a list of the currently loaded brushes. Selecting any brush in the list shows 
its definition on the Source, Profiles, and Filters panels and allows you to edit it.

To Create a New Brush
Select the brush in the Brushes list that you want to base the new brush on.
Click the + button.

The new brush appears under the User heading and by default has Copy appended to its name, 
but you can rename it using the Rename... button below the Brushes list.

To Assign a Keyboard Shortcut to a Brush
You can assign up to ten keyboard shortcuts to the brushes you use most frequently so that you 
can select them with a single keypress.
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On the View menu, click Options....
In the Options dialog box select Shortcuts in the Keyboard section.
In the Paint section of the Keyboard Shortcuts list select one of the entries labelled Brush 
Named, enter the name of the brush in the Brush field, and enter the keyboard shortcut you 
want to use or click the Type Key... button and press the key combination on the keyboard:

If you assigned a keyboard shortcut to a brush it is displayed on the bottom line of the Brush 
Editor window.

To Test a Brush
While you are editing a brush in the Brush Editor you can test it in the Viewer, or in the Brush Test 
window. To display the Brush Test window, click the Brush Test button in the bottom right corner 
of the Brush Editor.

The Brush Test window displays. This includes a palette editor, to allow you to change the color of 
the brush, and controls to clear or change the image displayed in the brush test window:
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To hide the brush test window: Click the Brush Test button again.
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To Save a Brush
Click the Export... button below the Brushes list. The following dialog box allows you to 
browse a place to export the brush file to and name the brush file:

Enter a suitable name for it and click the Save button.
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To Load a Brush
Click the Import... button below the Brushes list. The following dialog box allows you to 
select the brush file to import:

Select the brush file and click the Open button. The brush is added to the list of brushes in 
the Brushes list.

10.2.5 Defining the Brush Source

 
The options on the Source panel in the Brush Editor allow you to define the source of color for the 
brush, and associated options.
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To Define the Paint Source
Specify the source for the paint by choosing an option from the Source pop-up menu. The options 
are explained in the following table:

Color: The brush paints in the currently selected color.
Clone: The brush takes the color from the image being painted. Useful in conjunction with 
an offset for cloning one part of the image to another part.
Background: The brush takes color from the composite background (Composite mode), or 
specified background layer (Single layer mode). Useful for copying from one image onto 
another image.
Image File: The brush paints with an image loaded from disk. Useful for painting with copies 
of a small image (for example, leaves).
Image Center: Colors the whole brush with the color at the center of the stamp.
Eraser: Makes pixels transparent by painting on the alpha channel.
Image: Takes color from the image.

The Image and Background Source options allow you to define an offset in the X Offset and Y 
Offset fields. This allows you to pick paint up from one position on the image or background and 
paint it in another position.

To Define the Brush Profile
Choose an option from the Profile pop-up menu. The profile determines how the paint fades away 
from the center of the brush to the edge of the brush, as defined by the Size parameter. You can 
define new profiles using the Profiles tab of the Brush Editor.

To Specify the Image Pickup
You can specify how the image is picked up by the brush using the Pickup options:

Normal: The image is picked up before each stamp.
Once: The brush is loaded once on the first stamp.
After Stamp: The image is picked up after the previous stamp.

To Define the Opacity and Decay
The Opacity and Decay define the density of the paint stamped by the brush, and the rate at which 

it decays as you drag. A Decay of 0  gives a brush that never dries out; larger values dry out 

faster.

To Define the Mode
The Mode pop-up menu allows you to specify how the paint is combined with the image; it 
provides the same options as the Blend Mode compositing option for layers.
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To Define the Spacing
The Spacing determines the spacing between brush stamps as a percentage of stamp size. A large 
Spacing gives visible gaps between stamps. A small Spacing gives a smooth stroke.

Choose Fixed from the pop-up menu to make the spacing independent of your stroke speed, 
Constant Density to increase the spacing as you drag faster, and Maximum Detail to ignore the 
spacing and paint with full detail.

To Paint with an Image
Any image file, preferably with an alpha channel, can be used as a brush; for example:

Choose Image File from the Source context menu.
Click the Browse... button and select the image file you want to use.
Select Match Path to automatically rotate the image to match the angle of your stroke.
Set the Spacing to an appropriate value to determine the distance between stamps. Choose 
Fixed for a fixed spacing irrespective of your speed of stroke:
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Drag the brush to paint with the image you have loaded:

Use the Jitter filter to add variations to each stamp.

To Load a Cutout for Use as a Brush or Profile
You can use a cutout as a brush; this works in exactly the same way as painting with an image.

Alternatively you can use a cutout as the profile for painting; the cutout defines the outline of the 
brush.

On the Cutouts panel click the Layout tab to display the Layout panel.
Select the cutout you want to use in the Overlay list. For more information about creating a 
cutout see Working with Cutouts.
Click the Use for Brush or Use for Profile button:

Use for Brush saves the cutout as a TIFF image which you can load in using the Image File option 
in the Brush Editor.

Use for Profile saves the alpha channel of the cutout as an image file which you can load in using 
the Create from Image button in the Profiles panel of the Brush Editor.

10.2.6 Defining Brush Filter Effects
The options on the Filters panel allow you to create brushes that selectively color correct, filter, or 
add an effect to the image as you paint:
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The filters are divided into the following categories:

Blurs: Soften or blur the image.
Color Correctors: Allow you to do local color correction to parts of an image.
Distort: Apply marble, jitter, or turbulence effects to the image.
Effects: Provide image effects, including noise and emboss.
Filters: Process the image according to the values of the pixels.
Multiple: effects are applied in the order they are specified in the list. To change the order:
Select an effect, and click the Up or Down arrow buttons to change its position in the list.

To Create a Brush That Applies a Filter

On the Source panel, set the Source to Image, the X Offset and Y Offset to 0  and the Pickup

to Normal.
On the Filters panel, add the effects you want to include in the brush, and for each effect set 
the parameters.

10.2.7 Defining Brush Profiles
The Brush Editor Profiles panel allows you to define a number of preset profiles, and then select 
these when you are using or defining a brush:

The profile determines how the paint dies away from the center of the brush to the edge of the 
brush, as defined by the brush size parameter.

The horizontal axis defines the radius of the brush (center on the right), and the vertical axis is the 
opacity of the brush stamp.

The following table shows some sample profiles together with the corresponding spread of paint 
they create:
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Description Profile Effect

Linear

Soft

Solid

Neon

The Create from Image... button allows you to load in an image and use its alpha channel as the 
profile.

You can also create a profile from a cutout; for more information see Moving and Transforming 
Cutouts.

To Create a New Profile
Click the + button below the Profiles list.
Edit the profile curve as required.

The profile you have defined is displayed in the Profile list on the Brushes panel, and the Profile 
pop-up menu on the Brush Editor Source panel.
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To Adjust the Profile Graph
Drag the point from the profile curve.
Click on the curve to add a new point to the curve.
Hold down CTRL and drag to extend tangent handles from a point on the curve.
Hold down CTRL to adjust one tangent handle independently of the other one.

To Rename a Profile
Select the profile in the Profiles list.
Click the Rename... button.

10.2.8 Managing Painted Materials
Working on a project often involves importing a number of images or movies and then making 
changes to the images, or to one or more frames in the movies, before rendering out a composite 
of the resulting project.

Changes you make to images or movies never affect the original source materials. Instead, a copy 
of every image is saved, and every modified movie frame, in a painted materials folder on your 
hard disk. Actions that cause painted materials to be saved include: painting on an image or its 
mask using the tools on the Brushes panel, drawing shapes using the tools on the Graphics panel, 
sticking shapes, text, or cutouts from the Overlay list, and applying image effects from the Image
panel.

You can conform an image or movie layer, or its mask, to incorporate all the changes painted onto 
that layer and create a new image or movie that reflects those changes. You can then incorporate 
the conformed image or movie, or the mask, into another project without requiring the saved 
painted materials.

You can also export, as an image sequence, just those frames of a layer that have been painted on. 
By default painted materials are stored in a PaintedMaterial folder, but you can change this to any 
desired location.

To Conform an Image or Movie Layer
Viz World Classic never changes original files on disk as they are painted. You can conform a layer 
to produce a new complete movie or sequence incorporating all the painted frames. The layer is 
then updated to use the conformed material.

Select the layer you want to conform.
On the Layer menu, click Conform Layer.... A warning confirms the Conform Layer... action.
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Click the OK button to continue. The Conform Layer dialog box then allows you to give a 
name to the movie and specify the format:

Check Render RGBA (Millions of Colors+) if supported by format to include the alpha channel 
in the conformed layer.
Click the Render button to render the layer.

The movie layer is updated to use the new conformed movie, eliminating the need for the painted 
materials.

To Conform a Mask
You can also conform the paint mask of an image or movie layer to create a movie or sequence on 
disk containing the paint masks for the layer. The mask is output at the size of the original 
material for the layer, without transformations or filters applied to the layer.

Select the layer whose paint mask you want to conform.
On the Layer menu, click Conform Mask....

A warning confirms the Conform Mask... action.

Click the OK button to continue.
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Proceed as described for conforming a layer.

To Export the Painted Frames from a Layer or Mask
On the Layer menu, click Export Painted Frames... or Export Painted Masks....
The Export Painted Frames dialog box then allows you to specify the filename for the image 
sequence, and the file format:

In the Render Range section specify the range of the project that you want to render.
Click the Render button to continue.

An image is created for each of the painted frames, numbered with the frame number.

To Specify the Location of the Painted Material
On the View menu, click Options....
In the Preferences dialog box select Material in the Paint section.

This allows you to change the location of the PaintedMaterial folder, and allows you to display the 
Painted Material Manager by clicking the Manage painted Material... button:
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To Display the Painted Materials
The Painted Material Manager displays all the material saved for the different projects you have 
worked on, and allows you to delete material you no longer need. It also allows you to rescue 
material, in the event that the original project has been accidentally deleted. On the View menu, 
click Paint Material Management.... The Projects list displays a list of the projects with saved 
painted material.

To Display the Materials for a Project
Select the project name in the Projects list. The Painted Material Manager shows the full path name 
of the project file, together with a list of the painted materials used by the project. Material that is 
no longer referenced by a layer in the project is drawn in red to indicate that it is in the trash.

To Delete Specific Material
Select the material in the Painted material list and click the Delete Selected button.

To Rescue Material from a Lost Project
If a project file is lost, the material it referenced is not available until it has been copied into a new 
project. Select the material in the Painted material list and click the Rescue Selected button. The 
original source material and any painted frames are copied into the current project.

To Remove Material from a Project That Is No Longer Referenced by a Layer
Click the Empty Trash button.
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To Delete All the Material in a Project
Click the Delete All button. You are not allowed to delete material in use by the current project.

10.3 Adding Graphics To Images

 
The Graphics panel allows you to draw simple geometric shapes directly onto an image, or a frame 
of a movie. These tools provide a convenient way of creating a solid area of color in an image or a 
simple mask, where you do not need the flexibility and editability provided by the options on the 
Shapes panel.

Like the tools on the Brushes panel, the tools on the Graphics panel affect the image immediately, 
without needing to be stuck to the image. If you want to create editable shape overlays use the 
options on the Shapes panel instead.

10.3.1 To Draw a Quick Shape
Use the paint controls to specify whether the shape is drawn into the image and/or mask, 
and whether it is protected by the mask.
Use the Color Chooser to specify the shape color.
Select the Circle, Ellipse, or Rectangle tool in the Quick Shapes section:

Drag to draw the shape. You can hold down CTRL to constrain the shape to a circle or 
square respectively.
Release the mouse button to draw the shape.

Warning: Do not delete materials in any project you still need, or you are not able to load 
the project in its last saved version.


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10.3.2 To Define the Drop Shadow
Click the ellipse (...) button to the right of the Drop Shadow checkbox. The following dialog 
box allows you to define the drop shadow:

10.3.3 To Flood Fill Areas of the Image or Mask
The Flood Fill tools allow you to fill a contiguous area of pixels with the current color:

Use the Color Chooser to specify the color to fill with.
The tools are described as follows:

Flood Fill: Flood fills areas of uniform color in the image.
Fill to Color: Flood fills the image up to the color specified by the Fill to Color box.
Magic Wand: Flood fills the paint mask based on areas of uniform color in the image.

After selecting the appropriate tool: click on a color to start filling from that color.
Move the Tolerance slider to the right to flood a larger range of colors around the color you 
first clicked on.
Select Antialias to blur the edges of the filled area.

Note: This only affects shapes you subsequently draw.
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With the Magic Wand tool you can click additional areas to add to the mask, or click with SHIFT to 
remove areas from the mask. The Magic Wand tool is particularly useful for making cutouts; see 
Creating Cutouts.

Transforming Images

 
The options on the Image panel on the Paint panel allow you to transform an image or movie. The 
Roll operation is designed to assist in creating textures that tile seamlessly.

To Flip the Image about a Vertical or Horizontal Axis
Click the Flip Vertical or Flip Horizontal button.

To Create a Seamlessly Tiling Image
The following example shows how to create a seamlessly tiling texture from an image.

Load the image into a new layer:
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Click the Roll button. This exchanges opposite quadrants of the image:

Use the painting tools, such as Blur and Clone, to make the joins look invisible:
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Click the Roll button again to create the image:

This image can then be used to tile seamlessly, without any visible joins:
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11 Adding Image Effects
Viz World Classic provides a wide range of image effects, including color correctors, filters, and 
procedural effects. You can apply effects to any layer using the options on the Layer Fx panel, and 
these effects can be animated. Alternatively, the Fx options on the Paint panel allow you to apply 
fixed paint effects to an image or movie layer.

This section contains information on the following topics:

Adding Image Effects to a Layer
Adding Paint Effects
Image Effects

11.1 Adding Image Effects To A Layer

11.1.1 To Apply One or More Image Effects to a Layer
Select the layer.
Click the Layer Fx tab to display the Layer Fx panel for the layer. Every parameter of an 
effect can be animated. For more information see Using the Keybars Panel.

11.1.2 To Add an Effect to a Layer
Click the arrow symbol to the left of a heading in the effects list to expand the list, and show 
the effects under that heading.
Select the filter and click the > button to add it to the right-hand list of effects to be applied 
to the layer. Each effect displays a set of controls to allow you to adjust its parameters.

11.1.3 To Determine the Order in which the Effects Are Applied
The order of effects in the list determines the order in which they are applied. Select an effect in 
the right-hand list and click the up or down arrow buttons to move it up or down in the list.
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11.2 Adding Paint Effects

11.2.1 To Preview a Paint Effect
Click the Fx tab on the Paint panel to display the paint effects.
Select the effect in the list. Each paint effect displays a set of controls to allow you to adjust 
its parameters, and these are displayed to the right of the effects list.

The effect is previewed in the Viewer as you change the parameters.

11.2.2 To Apply the Paint Effect Permanently to the Image Layer
Click the Apply button. To apply one or more paint effects to every frame of a movie you can 
record a macro; see Automating with Macros.

11.2.3 To Restore the Image to its Previous State
Click the Cancel button.

11.2.4 To Reset the Paint Effect Parameters to their Default Settings
Click the Reset button.

11.3 Image Effects
The image effects are divided into the following sections:

11.3.1 Backgrounds
Provides options for creating textured and patterned background images such as gradients or 
clouds.

11.3.2 Blurs
Allows you to blur or soften an image.
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11.3.3 Color Correctors
Provides controls for adjusting the color balance of the image, adding/subtracting colors, or 
correcting the image in any of the alternative color models.

11.3.4 Distort
Provides options for transforming or distorting an image.

11.3.5 Effects
Provides artistic effects including emboss, crystallize, motion blur, ripple, solarize, and stained 
glass.

11.3.6 Filters
Provides image effects such as edge detection, erode, and threshold.

11.3.7 Grain
Provides filters for removing or simulating film grain.

11.3.8 Sharpen
Provides options for sharpening images.

11.3.9 Transition
Provides wipes which can be animated to give a transition between two images or movies.

11.3.10 Video
Provides filters for broadcast video use.

11.3.11 Adobe After Effects Plug-ins
If you have Adobe After Effects-compatible plug-ins installed on your system, some of these can be 
used and are listed in the effects list. 

For details on which plug-ins can be used with Viz World Classic please contact your local Vizrt 
representative.
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12 Extracting Masks
This chapter describes the options in Viz World Classic for extracting a mask automatically from 
an image based on its colors. With certain images, where the foreground is very distinct from the 
background, this can provide an extremely quick way of creating a finished mask. With more 
difficult material it can often provide a useful starting point for painting a mask manually.

This section contains information on the following topics:

Introduction
Mask Extract Tools

12.1 Introduction

The mask extract tools are provided on the Mask panel on the Paint panel. Each tool includes its 
own set of controls to allow you to adjust its parameters, and these are displayed to the right of 
the mask extract tools list.

12.1.1 To Extract a Mask
The following image contains yellow poppies against a predominately blue background, and so is 
an ideal candidate for extracting a mask:

Select Component Extract, and choose Yellow from the Component drop-down menu to 
mask yellow areas of the image.
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Adjust the LUT graph to achieve an optimum mask:

The masked areas are displayed in the mask color:

Click the Apply button to apply the mask permanently.

12.2 Mask Extract Tools

12.2.1 Component Extract
Extracts a mask based on the level of a specified component: Red, Green, Blue, Cyan, Magenta, 
Yellow, Alpha, or Max:
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12.2.2 Luma Extract
Extracts a mask based on the luminance value of each pixel. The graph allows you to define the 
mapping between the luminance value and the output mask value.

12.2.3 Chroma Extract
Extracts a mask based on the minimum and maximum chroma levels.

12.2.4 Foreground Extract
Extracts a mask based on the predominance of the chosen component, red, green, or blue, in the 
foreground. The graph allows you to define the mapping between the raw values extracted and the 
output mask value.

12.2.5 Background Extract
Extracts a mask based on the predominance of the chosen component, red, green, or blue, in the 
background. The graph allows you to define the mapping between the raw values extracted and 
the output mask value.

12.2.6 Color Extract
Extracts a mask based on a specified color level.

12.2.7 Hue Extract
Extracts a mask based on the proximity of the color at each pixel to a specified source color:

See Also

Painting



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  208

1.
2.

13 Automating With Macros
Macros provide a convenient way of recording actions, such as painting or image processing, and 
then applying them to several frames of a movie. They also allow you to repeat the same sequence 
of actions in a series of different projects.

13.1 Using Macros

 
Macros allow you to record any of the painting or image manipulation actions, including painting 
with brushes, and then replay them on another image or each frame of a movie.

Features of the movie that should not be affected can first be masked using rotosplines.

13.2 To Record A Macro
The following example illustrates recording a macro, applying an image processing operation to 
one frame of the movie, and then replaying it on all frames.

Select Protect with mask in the paint controls, to use the mask to protect the image.
On the Macros panel click the Start Recording button. The panel displays RECORDING.
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On the Image panel select the image processing function, such as Black and White, and click 
the Apply button. The current frame will be converted to black and white outside the 
masked area:

On the Macros panel click the Stop Recording button.

13.3 To Replay A Macro
Click the Play On Range... button. The following dialog box allows you to specify which 
frames are affected:

Select Part of Project, enter the range omitting the first frame, and click the OK button.

You can now preview the movie to confirm that the operation has succeeded. Any number of 
different paint and image processing operations can be recorded into a single macro.

13.4 To Save A Macro
After creating a macro you can save it, and then reload it for use in another project.

Click the Save Macro... button.
Enter an appropriate name and click the Save button.
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13.5 To Load A Macro
Click the Load Macro... button.
Select the macro you want to load and click the Open button.
Click the Play Macro or Play on Range... button to replay the macro.
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14 Working With Shapes
This section explains how to add drawings to your map by creating vector shapes, either using 
separate shape layers or by adding shape overlays to map layers. It explains how you can create 
and edit shapes, and change their appearance to achieve exactly the effect you want.

This section contains information on the following topics:

Introduction to Shapes
Creating Shapes on a Shape Layer
Creating Shape Overlays
Shape Tools
Cutting/Pasting and Exporting/Importing Shapes
Editing Shapes
Editing Points
Defining the Appearance of Shapes
Animating Shapes
Specifying How Shapes are Displayed
Setting the Shape Layer Properties
Animating Shape Layers
Adding Shape Overlays to a Map Layer

14.1 Introduction To Shapes
Each shape consists of a number of points joined by straight lines or smooth curves. A range of 
shape tools is provided to enable you to draw shapes point by point, by drawing a freehand curve, 
or by drawing a precise rectangle or ellipse.

Each shape has a start point and an end point, displayed as circles; the intermediate points are 
displayed as squares. In a closed shape, the start and end points are joined:
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You can control the appearance of shapes by changing the border and fill colors, border thickness, 
opacity, and blur. Shapes can be edited or transformed after you have created them, and a series 
of tools are provided to allow you to move, edit, divide, or join shapes. You can also use a shape 
to cut a hole in the currently selected layer.

You can animate the entire drawing on the shape layer, the individual shapes in the drawing, and 
the individual points of each shape. So for example, a shape could be used to show the path of a 
hurricane, with the shape changing in size as it moves across the land.

14.1.1 Shape Layers
You can create shapes in one or more shape layers. Each shape layer can be animated as a single 
unit, pinned to a map layer, wrapped to the map, and scaled to the map. Typically you would 
create a new shape layer for each drawing consisting of several shapes. This makes it easy to 
transform the complete drawing as a unit, such as animating its position or fading it in by 
changing the opacity. Shapes can also be used to create holes in other shapes.

14.1.2 Shape Overlays in Map Layers
You can also add shape overlays to a map layer. Shape overlays are always wrapped to the map, 
and can be displayed in the same style as other map details. Shape overlays in map layers can be 
constructed by automatically tracing an existing map detail.

14.2 Creating Shapes On A Shape Layer

 
This section contains information on the following products:

To Create Shapes on a Shape Layer
To Show or Hide a Shape on a Shape Layer
To Edit a Shape on a Shape Layer
To Rename a Shape on a Shape Layer
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14.2.1 To Create Shapes on a Shape Layer
On the Layer menu, point to Add Layer, and then click Shape. A new empty shape layer will 
be created at the top of the Layers list:

Click the Contents tab to display the shape tools. The New Polygon tool is selected to allow 
you to create a shape.
As you add shapes to the shape layer they will be shown in the Shapes list on the Contents
panel for the layer.

14.2.2 To Show or Hide a Shape on a Shape Layer
   Click the eye icon to the left of the shape name in the Shapes list.

14.2.3 To Edit a Shape on a Shape Layer
Select the shape you want to edit in the Shapes list.
Use the options on the Shape, Points, Properties, Animation, and Display panels to edit the 
characteristics of the shape as required.

14.2.4 To Rename a Shape on a Shape Layer
Select the shape layer in the Layers list.
Click the Rename… button below the Shapes list.
Enter a name for the shape and click the OK button:
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14.3 Creating Shape Overlays

 
This section contains information on the following products:

To Create Shape Overlays
To Rename a Shape
To Change the Order of Shapes
To Delete a Shape
To Copy a Shape
To Edit a Shape Overlay

14.3.1 To Create Shape Overlays
Select a map layer in the Layers list.
Click the Overlays tab on the Contents panel to display the shape tools. As you add shape 
overlays they are shown in the Details list on the Contents panel.

14.3.2 To Rename a Shape
Select a layer (not a shape layer) in the Layers list.
Select a shape from the Details list.
Click the Properties tab and edit the Label field.

14.3.3 To Change the Order of Shapes
Either:

Select the shape you want to move from the Details list.
Click the UP or DOWN arrow button below the Shapes list or Details list.

Or:
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Right-click the shape you want to move and click one of the Ordering options on the pop-up 
menu:

Or:

Drag the shape to the new position in the Details list.

14.3.4 To Delete a Shape
Select the shape you want to delete and press the BACKSPACE key, or Right-click the shape you 
want to delete and click Remove from the appearing context menu.

14.3.5 To Copy a Shape
You can cut, copy, and paste shapes between layers or between projects using the Cut, Copy, and 
Paste options on the Edit menu or the Shapes list or Details list context menu. You can also export 
one or more shapes, and then import them into another layer or another project, using the 
Export... and Import... options on the Shapes list or Details list context menu.

14.3.6 To Edit a Shape Overlay
Select the shape you want to edit in the Details list and then use the options on the Shape panel to 
edit the characteristics of the shape as required.

14.4 Shape Tools
The following shape tools are provided for drawing shapes on shape layers, and overlays on map 
layers:

 New Polygon: Straight lines and polygons.
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 New Bezier: Smooth Bezier.

 New B-Spline: Smooth B-Spline.

 New Freehand: Freehand shapes.

 New Circle: Circles.

 New Ellipse: Ellipses and circles.

 New Rectangle: Rectangles and squares.

As you are drawing a shape a floating palette gives you options for completing the shape:

Alternatively, to cancel drawing a shape press the ESC key.

For more information about using each of these shape tools see the following procedures:

To Draw a Polygon, Bezier, or B-Spline Shape
To Complete the Shape to Make an Area Shape
To Complete the Shape to Make a Line Shape
To Draw a Freehand Shape
To Draw a Geometric Shape

14.4.1 To Draw a Polygon, Bezier, or B-Spline Shape
Select the New Polygon, New Bezier, or New B-Spline tool:

  
Click at the appropriate position to draw each point. As you draw the points, the shape is 
shown as straight line segments (New Polygon tool), smooth Bezier curves (New Bezier tool), 
or B-Spline curves (New B-Spline tool) determined by the point positions:

Note: All shape tools are available to map layers; however, not all features of all tools are 
(for example, the Points editor).


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The points are drawn in red with the two endpoints highlighted in yellow by default.

14.4.2 To Complete the Shape to Make an Area Shape
Either:

Click the Area button in the floating Shape palette.

Or:

Right-click and select Make Area Shape from the appearing context menu:

The shape is closed and displayed, drawn with the current area style:

14.4.3 To Complete the Shape to Make a Line Shape
Either:
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Click again on the last point you drew.

Or:

Click the Closed Line or Open Line button in the floating Shape palette.

Or:

Right-click the shape and select Make Open Line Shape or Make Closed Line Shape from the 
appearing context menu. The shape is drawn with the current line style:

14.4.4 To Draw a Freehand Shape

 Select the New Freehand tool.
Hold down the mouse button and drag to create the shape you want to draw:

 

Click Points tab and select Move Points. As you drag, points are added as necessary to create 
the shape you are drawing.
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Complete the shape as for drawing a point shape. The freehand shape is converted to an 
equivalent Bezier curve that uses as few points as possible.

14.4.5 To Draw a Geometric Shape

  

Select the New Circle, New Ellipse, or New Rectangle tool.
When using the New Ellipse or New Rectangle tool, hold down CTRL to constrain the shape 
to a circle or square:

When you release the mouse button the shape is filled with the current area style.

14.5 Cutting/Pasting And Exporting/Importing Shapes
Several options are available to help you reuse shapes within a project, or between projects. You 
can cut, copy and paste shapes within a shape layer, between shape layers, or between shape 
layers and shape overlays, to make multiple copies of a shape or use one shape as the starting 
point for another shape.

You can also export shapes to a file and then import them into a different project, to reuse 
artwork you have created on a previous occasion.

14.5.1 To Cut or Copy a Shape
Either:

Click the shape in the Shapes list or Details list with the right mouse button and select Cut
or Copy from the appearing context menu.

Or:

Select the shape in the Shapes list or Details list.
On the Edit menu, click Cut or Copy.

Cut deletes the original and puts it onto the clipboard.
Copy makes a copy of the original on the clipboard leaving the original unaffected.

Note: The Points tab is not available when drawing shapes on map layers.
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14.5.2 To Paste a Shape
Select the shape layer or image/movie layer on which you want to paste the copy.
On the Edit menu, click Paste.

If you pasted onto a shape layer the shape is added at the top of the Shapes list for 
the layer.
If you pasted onto an image or movie layer the shape is added to the top of the 
Shapes list or Details list for the layer.

14.5.3 To Export a Shape
Right-click to select the shape in the Shapes list or Details list and click Export... from the 
appearing context menu. The following dialog box allows you to give a name to the shape 
file:

Enter an appropriate name and click the Save button to save the shape.
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14.5.4 To Import a Shape
Right-click in the Shapes list or Details list and click Import... from the appearing context 
menu. The following dialog box allows you to select the shape you want to import:

Select the shape file and click the Open button to import it.

14.6 Editing Shapes
The options on the Shape panel allow you to edit the entire shape:

 
It provides the following options:

Move Shape: Allows you to move, stretch, or rotate a shape.
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Open Shape: Opens a shape at a selected segment or point.
Divide Shape: Divides a shape into two shapes.
Join Shapes: Joins two shapes.
Smooth: Converts all the points on a shape from corner points to curve points.
Sharpen: Converts all the points on a shape from curve points to corner points.
Filled/Outline: Specifies whether the shape is filled.
Open/Closed: Specifies whether the segment between the endpoints should be drawn.
Use To Cut Hole: Makes the shape cut a hole in shapes below it in the Shapes list.
Fix Shape: Adds a keyframe (for example, to an animated path).
Remove Keys: Removes a keyframe. Use Next and Prev Shape Key to jump between the 
keyframes.

These options are described in greater detail in the following procedures:

To Move a Shape
To Resize a Shape
To Rotate a Shape
To Move the Pin Position
To Open a Shape
To Divide a Shape
To Join Two Shapes into One

14.6.1 To Move a Shape

Select a shape from the Layers list.
Select the Contents tab, and then the Shape tab.
Select the Move Shape tool. The shape is shown with a dotted bounding rectangle.

Either:

Drag the shape by a point within the rectangle to move it to a new position.

Or:

Right-click at the destination and click Move here from the appearing context menu:

14.6.2 To Resize a Shape
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Select a shape from the Layers list.
Select the Contents tab, and then the Shape tab.
Select the Move Shape tool.
Move the mouse pointer to one of the eight handles on the corners or midpoints of the 
bounding rectangle.
Drag to resize the shape:

Hold down CTRL to constrain the shape to its original aspect ratio.

14.6.3 To Rotate a Shape

Select a shape from the Layers list.
Select the Contents tab, and then the Shape tab.
Select the Move Shape tool.

Point to the rotation handle, which is a yellow circle to the right of the pin position. The 
cursor changes to a rotation symbol.
Drag the handle to rotate the shape about its pin position.

14.6.4 To Move the Pin Position

Select a shape from the Layers list.
Select the Contents tab, and then the Shape tab.
Select the Move Shape tool.
Point to the pin position, which is initially at the center of the shape. The cursor changes to 
a pin symbol.
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Drag the pin position to move it.

14.6.5 To Open a Shape

Select a shape from the Layers list.
Select the Contents tab and then the Shape tab.
Select the Open Shape tool.

Either:

Click the border of the shape to open the shape with the start and end points either side of 
the corresponding segment:

Or:

Click a point to open the shape using that point as the start point.
Click the point a second time to use that point as the end point.

14.6.6 To Divide a Shape

Select a shape from the Layers list.
Select the Contents tab and then the Shape tab.
Select the Divide Shape tool.
Drag between two non-adjacent points on the border of the shape.

The shape is split into two shapes along the line joining the points.

14.6.7 To Join Two Shapes into One
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Select a shape from the Layers list.
Select the Contents tab and then the Shape tab.
Select the Join Shapes tool. The start and end points of each shape are displayed.
Click the start or end point on the first shape. A line extends to the cursor.
Click the start or end point on the second shape. The selected endpoints are joined to 
combine the two shapes into a single shape.

14.7 Editing Points

 
The options on the Points panel allow you to adjust individual points on a shape, and provides the 
following options:

Move Points: Allows you to move points, or adjust their tangent handles.
Transform Points: Lets you rotate one or more selected points as a unit.
Add Points: Allows you to add points to a shape outline.
Delete Points: Click a point to delete it from the shape outline.
Sharpen Points: Click a point to convert a curve point to an angle point.
Smooth Points: Click a point to convert an angle point to a smooth curve point.
Align Between Points: Click two points to align intermediate points into a straight line.
Shape Edge: Allows you to soften the edge of a shape.
Adjust Pulls: Allows you to adjust each point by pulling each point’s handle.
Fix Shape: Adds a keyframe (for example, to an animated path).
Remove Keys: Removes a keyframe. Use Next and Prev Shape Key to jump between the 
keyframes.

When any of the tools on the Points panel are selected you can also right-click and select an option 
from the appearing context menu:
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14.7.1 To Activate or Deactivate a Point

Select a shape from the Layers list.
Select the Contents tab and then the Points tab.
Select the Move Points tool.
Right-click and from the appearing context menu click Deactivate or Activate on the pop-up 
menu. A deactivated point is stored with the shape, but does not affect the shape.

14.7.2 To Move One or More Points on the Shape Outline

Select a shape from the Layers list.
Select the Contents tab and then the Points tab.
Select the Move Points tool.
Click the point you want to move. The point turns yellow to show it is selected.
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Drag the point to the new position:

To move several points at once, first select them by holding down SHIFT and clicking them, or 
drag to enclose them.

You can also move points with the Add Points tool selected by holding down ALT.

14.7.3 To Adjust the Curvature at a Point on a Bezier Curve
Every point on a Bezier curve has a pair of tangent handles. The angle of the tangent handles 
determines the angle of the curve through the point, and the length of the tangent handles 
determines the curvature.

Select a shape from the Layers list.
Select the Contents tab and then the Points tab.
Select the Move Points tool.
Hold down CTRL and drag a point up/down/left/right to adjust the smoothness at that 
point:

Drag one of the tangent handles to adjust the curvature at the point.
Hold down CTRL while dragging a tangent handle to make it independent of the other one.
Hold down SHIFT + CTRL to align both tangent handles.

14.7.4 To Adjust the Curvature at a Point on a B-Spline Curve
Every point has a pull factor which determines how close the curve gets to the point.
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Select a shape from the Layers list.
Select the Contents tab and then the Points tab.
Select the Move Points tool.
Hold down CTRL and drag a point up/down/left/right to adjust the pull factor at that point.

14.7.5 To Add Points

Select a shape from the Layers list.
Select the Contents tab and then the Points tab.
Select the Add Points tool.
Click on the shape outline to add a point.
Hold down CTRL to insert the new point equidistant from its neighbors. After clicking you 
can drag the new point to position it. You can also add points with the Move Points tool 
selected by holding down ALT.

14.7.6 To Delete Points

Select a shape from the Layers list.
Select the Contents tab and then the Points tab.
Select the Delete Points tool.
Click a point to delete it.

14.7.7 To Soften the Edge of a Shape

Select a shape from the Layers list.
Select the Contents tab and then the Points tab.
Select the Shape Edge tool.
Drag to extend a second outline around the section of the shape you want to soften. The 
edge of the shape fades smoothly between the two boundaries.

14.8 Defining The Appearance Of Shapes
The options on the Properties panel allow you to adjust the fill and outline styles of the shape, 
apply a texture to a shape, change its opacity and softness, transform it numerically, or add a drop 
shadow:
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This section contains information on the following topics:

Appearance Options
Transform Options
Drop Shadow Options (not Rotoshapes)
Motion Blur Options

14.8.1 Appearance Options

 
The Style pop-up menu lets you select a style for the shape.

Use the Opacity and Softness controls to adjust the opacity of the shape and the softness of its 
edge.

The Write On Amount allows you to animate the appearance of a line shape, such as to indicate the 
route of a journey. The line is animated from the starting point to the ending point with precise 
interpolation between points.

To Define a Shape Style
Click the Settings button. The Settings dialog box is displayed.

To Draw a Shape with a Brushed Outline
Choose Brushed from the Style pop-up menu.
Click the Settings button to select the brush to use.
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To Fill a Shape with the Background Image
Choose Merge from the Style context menu.

To Add a Texture to a Shape
Click the + button in the Settings dialog box to display an Open dialog box, and select a 
texture.
Select the texture from the Texture context menu.
Use the buttons to the right of the Texture context menu on the Settings dialog box to move 
or scale the texture. The texture is used as a fill for the shape.

14.8.2 Transform Options

 
Allows you to transform the shape numerically.

14.8.3 Drop Shadow Options (not Rotoshapes)

 
Select Drop Shadow to turn on a drop shadow for the shape.

The following parameters are provided:

Offset: The offset of the drop shadow, in pixels.
Opacity: The opacity of the drop shadow. 0% gives no drop shadow.



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  231

•

•

•

•

•
•
•
•
•
•

Softness: Blurs the drop shadow to smooth the edges. Values in the range 0-5  are 

recommended.
Color: The color of the drop shadow.

14.8.4 Motion Blur Options

 
Adds motion blur before and/or after a shape.

14.9 Animating Shapes

 
The options on the Animation panel allow you to animate individual shapes on a shape layer. This 
panel is not available for shape overlays.

Edit Shape Path: Enables you to edit the shape’s path by adjusting the points on the path (for 
example, the start and end points).
Edit Points Path: Enables you to edit the shape’s points (for example, giving the shape 
another shape during the animation).
Next Shape Key: Jumps to the shape’s next keyframe.
Prev Shape Key: Jumps to the shape’s previous keyframe.
Apply Track Data: Applies a tracking path to a layer in your project.
Auto Animate: Enables you to set animation properties like slide in/out and fade on/off.
Match rotation to path: Enables the object’s rotation to follow the direction of the path.
Smooth New Points on Shape Path: Converts an angle point to a smooth curve point on a 
shape path.
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Automatically Fix Shapes: Automatically makes the current frame a key frame for every point 
on the shape.
Fix Shape: Adds a keyframe (for example, to an animated path).
Remove Keys: Removes a keyframe. Use Next and Prev Shape Key to jump between the 
keyframes.
Show Keybars: Opens the Shape Keybars editor. This allows you to edit the shape’s 
animation properties (for example, transformation) on its timeline.

This section contains information on the following procedures:

To Fix a Shape
To Remove the Keys
To Animate an Individual Shape
To Animate Individual Points on a Shape
To Show the Keybars for a Shape

14.9.1 To Fix a Shape
Select a shape from the Layers list.
Select the Contents tab and then the Animation tab.
Click the Fix Shape button. This makes the current frame a key frame for every point on the 
shape.

14.9.2 To Remove the Keys
Select a shape from the Layers list.
Select the Contents tab and then the Animation tab.
Click the Remove Keys button. This removes all keys for the current frame.

14.9.3 To Animate an Individual Shape

Select a shape from the Layers list.
Select the Contents tab and then the Animation tab.
Select the shape in the Shapes list.
Select the Edit Shape Path tool.
Open the Animation Controls and set the marker where the animation should end (for 
example, 50 fps).
Drag the center of the shape to define its path throughout the animation.
Hold down CTRL and drag from a point on the animation path to extend tangent handles 
from that point and create a curved animation path.

14.9.4 To Animate Individual Points on a Shape

Select a shape from the Layers list.
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Select the Contents tab and then the Animation tab.
Select a shape in the Shapes list.
Select the Edit Points Path tool.
Drag the points to the positions you want them to have at each frame of the animation.

 

 

Hold down CTRL and drag from a point on the animation path to extend tangent handles 
from that point and create a curved animation path. The keys for individual points are not 
displayed in the Keybars panel.

14.9.5 To Show the Keybars for a Shape
Select the shape in the Shapes list.
Click the Show Keybars... button on the Animation panel. The Shape Keybars window shows 
a keybar for each shape in the Shapes list. You can click the arrow to the right of each shape 
to show a Transform bar showing the transformations applied to the entire shape, followed 
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by a keybar for each point on the shape:

Select All Points to include a keybar for every point in the Shapes list, or Selected Points to 
show only selected points on those shapes. The Shape Keybars window works in the same 
way as the Keybars panel; for more information see the Using the Keybars Panel section.

14.10 Specifying How Shapes Are Displayed
The options on the Display panel allow you to specify how shapes are displayed while they are 
edited:

Use the Editor Display options to specify which features of a shape are displayed during editing.

The Fill Points & Handles at Key Frames option displays each point filled if the frame is a key frame 
for that point, and is only available for shape layers.

Use the Shape Display options to specify how shapes are normally displayed.

Click the Tool Colors... button to define the colors for the editing features:
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14.11 Setting The Shape Layer Properties

 
The options on the Properties panel allow you to specify the compositing options for the shape 
layer, transform it, and add a drop shadow, or animation trail. It also provides several animation 
options.

This section contains information on the following topics:

Compositing Options
Transform Options
Drop Shadow Options
Trail Options

14.11.1 Compositing Options

 
Blend Mode specifies how the layer is combined with the other layers, and can be one of:

Normal, Add, Subtract, Difference, Multiply, Darken Only, Burn, Color Burn, Screen, Lighten 
Only, Dodge, Color Dodge, Hue, Saturation, Value, Color, Overlay, Soft Light, Hard Light, Pin 
Light, Exclusion, or Negation.

The Opacity determines the layer opacity, and can be animated.

The Obey Composite Mask specifies whether the current layer should obey the composite mask.

For more information see Controlling Layer Compositing.



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  236

•

•
•

•

•

14.11.2 Transform Options

 
These allow you to specify the position, rotation, scale, and origin of the entire shape layer 
numerically.

These options behave in exactly the same way as for image layers.

14.11.3 Drop Shadow Options

Select Drop Shadow to turn on a drop shadow for the layer.
The following parameters are provided:

Offset: The offset of the drop shadow, in pixels.
Opacity: The opacity of the drop shadow. 0% gives no drop shadow.

Softness: Blurs the drop shadow to smooth the edges. Values in the range 0-5  are 

recommended.
Color: The color of the drop shadow.
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14.11.4 Trail Options

 
The Trail options allow you to leave a trail as the shape layer animates. For more information see 
Leaving an Animation Trail.

14.12 Animating Shape Layers
In addition to being able to animate individual shapes, you can animate the complete set of shapes 
on the shape layer as a single entity.

This is useful if you have constructed a complex illustration from a number of separate shapes and 
want to animate it as if it were a single object.

Each shape can be given its own animation path with control over the following features:

Opacity.
Drop shadow opacity.
Offset color and softness. 
Position.
Rotation.
Scale.
Write on amount.
Softness.

14.12.1 To Auto-animate the Entire Shape Layer
Click the Auto Animate button on the Properties panel for the shape layer, or select the shape layer 
in the Layers list and click Auto-Animate... on the Layer menu.

The Automatic Animation dialog box allows you to automatically slide in, slide out, fade on, and/
or fade off the shape layer with specified timings.

For more information about using the automatic animation dialog box see section Automatically 
Animating a Layer.

14.12.2 To Animate the Entire Shape Layer

Select the Path tool:
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Drag the shape layer to the position you want it to have at each frame of the animation.

Hold down CTRL and drag from a point on the animation path to extend tangent handles 
from that point and create a curved animation path:

14.13 Adding Shape Overlays To A Map Layer
As well as constructing drawings out of shapes in separate shape layers, you can also add shape 
overlays to map layers. Shapes drawn on a map layer appear in the Details list on the layer’s 
Contents panel and are referred to as shape overlays. They include all the same features as shapes 
drawn in shape layers with some extra features that make them particularly useful for highlighting 
areas on maps:

You can draw shape overlays by automatically tracing borders, coastlines, built-in roads and 
railways, or imported lines on the map.
You can clip shape overlays to the land, so that any areas overlapping the sea are effectively 
transparent.
You can choose to draw shape overlays as land, water, relief, road, rail, or imported data to 
give the shape exactly the same scale and appearance as the corresponding features.

This section contains information on the following procedures:

To Define the Properties of Shape Overlays
To Draw Shape Overlays as Land, Water, etc.
To Clip a Shape Overlay to Land
To Draw Shapes by Tracing Map Features
To Zoom or Pan while Tracing

14.13.1 To Define the Properties of Shape Overlays
Select the shape in the Details list.

Tip: If you are creating a small graphic draw it in the center of the shape layer, as 
this makes its position correspond to the points on the animation path.


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Click the Shape tab to display the properties for the selected shape:

The options are the same as for shapes in shape layers, with the addition of Draw using style, Clip 
to land, and the edit tools of Shape, Points and Animation. All are described in the following 
sections.

14.13.2 To Draw Shape Overlays as Land, Water, etc.
Choose the appropriate option from the drop-down menu:

Treat as Land: Colors the land and relief.
Treat as Water: Colors the sea and depth contours.
Draw with Border line width: Scales with region borders.
Draw with Road/ Rail line width: Scales with built-in roads/railways.
Draw with Imported Data line width: Scales with imported data.

For example you can use a shape set to Treat as Land to mark out an area of a particular terrain 
type, such as desert:
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14.13.3 To Clip a Shape Overlay to Land

 

Select the shape detail in the Details list and select Clip to land in the Shape panel.

14.13.4 To Draw Shapes by Tracing Map Features

Select the map layer on which you want to create the shape.
Select the Add Point Shape tool and click the arrow to the right of the tool to display a 
submenu of options for the tool:

Note: You can only trace features on the map once the high quality rendering of the map 
layer has completed.


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Press ESC if you want to cancel the submenu without making a selection.
Select Trace borders & coastline, Trace global roads & rail, Trace river lines, or Trace streets/
imported data according to which features on the map you want to trace.

Move the mouse pointer near the feature you are tracing; for example, the coastline or 
border between regions.

The mouse pointer changes shape (cuts the tail) to show that the border has been 
detected:

Click to create a point, and then move to the next point along the border you are tracing.
A line indicates the outline of the shape being traced. If the line being traced follows 
the wrong path, take smaller steps between points.
As you are drawing the shape you can use the Add Point Shape tool to turn tracing on 
or off, or change the feature being traced, to achieve exactly the effect you want.

Finally complete the shape in the usual way, by clicking on the starting point to create an 
area shape, or clicking (for example, double-click) again on the previous point to create an 
open shape:

Note: River tracing cannot be used on rivers that are wide enough to be drawn as 
area shapes rather than simple lines.


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Once you have traced the shape, you can edit it or transform it in exactly the same way as 
for other shapes you draw.

14.13.5 To Zoom or Pan while Tracing
You can only trace areas of the map that are actually visible on the screen, but if necessary you can 
zoom or pan the map while you are tracing to change the part of the map that is in view

Type Z to temporarily select the Zoom tool or P to temporarily select the Pan tool while you 
are tracing.
Press either key again to switch back to the Add Point Shape tool.
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15 Working With ESRI Shape Files
This section explains how to import map data in ESRI Shape File format and configure it for use 
with your maps.

Although the Street Data format provides a more convenient way of creating street maps, a wide 
range of published data is available in ESRI Shape File format, and Viz World Classic allows you to 
import this data and configure it for use with your maps.

Viz World Classic supports ESRI Shape File format data in which the text and field data are encoded 
in an extended range of formats, including UTF-16 and various language-specific encodings 
including some Japanese, Hebrew, and Arabic encodings.

You can specify the encoding for each field of imported shape file data, allowing maps to be 
created in many different languages.

This section contains information on the following topics:

Setting up ESRI Shape File Data
Using ESRI Shape File Data

See Also

Working with Street Maps

15.1 Setting Up ESRI Shape File Data
Data in ESRI Shape File format may contain a large number of different attributes and values which 
describe the data contained in the file. In order for Viz World Classic to understand how to draw 
the data, you first need to create a data set definition that describes which features are to be 
drawn and in which style.

This section contains information on the following procedures:

To Create a Data Set Definition
To Edit the Data Set
To Add Subsets to a Data Layer
To Define the Style for Data Layers or Subsets

15.1.1 To Create a Data Set Definition
On the Import menu, click Map Data (Shape Files)... to display the Imported Data Sets dialog 
box.
Click the Create a Data Set Definition button:

 
The following dialog box allows you to select an existing data set definition as the basis for 
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the new one:

Click the Browse... button to specify the filename for the new data set definition.

If you want to base the data set definition on an existing one:

Click Base on the following data set definition and select a definition in the list.
Click the OK button to create the new data set definition. It is displayed in the Imported Data 
Sets dialog box.
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15.1.2 To Edit the Data Set

Select the data set definition in the Data Sets list.
Click the Edit Data Set Definition button. The Edit Data Set dialog box allows you to edit the 
data set definition.
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Click the Add Data Layer button.

Select the data file you want to add. Supported file formats are .shp (Shape File) and .csf
(Curious Shape File). The Data File Properties dialog box then allows you to specify how the 
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features in the data file you have loaded are labeled on the map.

Choose up to three fields from the Fields used to label features drop-down menus. Each 
street is labeled with the specified field values.
Click the Field Settings... button to display the following dialog box, which allows you to 
specify the encodings for each field in the file:

Select one or more fields in the Fields list, then choose the relevant encodings from the 
Name Encoding and Data Encoding pop-up menus. You can preview the effect of the 
encodings by clicking the View field… button.
Click the Close button to save the data layer in the data set definition.
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15.1.3 To Add Subsets to a Data Layer
You can create subsets of a database file based on the contents of a specified field. This allows 
you to filter the database, and display each subset in a different style.

Open the Data File Properties dialog box and choose the field you want to use to divide the 
database into subsets from the Field used to split features into subsets drop-down menu. 
For example, to divide states according to east and west coast states.
Click the Close button to close the Data File Properties dialog box.
Select the appropriate data layer in the Edit Data Set dialog box.
Click the Add Subset button.

The following dialog box displays a list of the available values for the specified field in 
the data file and allows you to select values to create the subset.

Select the values you want to use in the upper list and click the + button to add them to the 
lower list.
Hold down SHIFT to select multiple contiguous items, and CTRL to select multiple non-
contiguous items. For example, to create a subset containing only the East Coast states you 
could select and add those.
Enter a name for the subset in the Subset Name field.
Click the OK button to save the subset definition.
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15.1.4 To Define the Style for Data Layers or Subsets
You can define a separate style for each data layer or subset you have created, to distinguish them 
on the final map.

Select the data layer or subset in the Edit Data Set dialog box.
Select Draw layer with selected style from the How to draw selected layer or subset drop-
down menu.
Select the styles for drawing the selected layer or subset, and the style for drawing individual 
features, in the lists on the right side of the Edit Data Set dialog box:

Appropriate styles are listed in the Style lists depending on whether the type of the 
layer is Area, Line, or Point.
Alternatively, select Draw polygons/areas as Land, Draw polygons/area/lines as 
Rivers, Draw polygons/areas as Lakes or Draw polygons/areas as Sea from the How to 
draw selected layer or subset drop-down menu to treat the selected layer in the same 
way as the built-in land, rivers, lakes or sea respectively.
The Scale by box allows you to scale the line thickness defined by the style. For 
example, you can identify different types of roads by using the same Primary Roads
style but different Scale by settings for the line thickness.

Enter a value to scale the line thickness and press the RETURN key.
Repeat for any other data layer or subsets.

See Also
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How to edit any of the styles using the Styles Editor in the Working with Styles section

15.2 Using ESRI Shape File Data
Once you have created a data set definition, you can use this to load the ESRI Shape File data with 
the attributes you have specified.

This section contains information on the following procedures:

To Load a Data Set Definition
To Load the Data
To Use Imported Map Data
To Add Labels to Imported Data Features

15.2.1 To Load a Data Set Definition

On the Import menu, click Map Data (Shape files)... and click the Add a Data Set button.
Select the data set definition file and click the Open button to load it. The data set is 
displayed in the Data Sets list.
Click the Close button to close the dialog box.

Once you have added a data set, it is remembered for future use of Viz World Classic, so there is 
no need to add the data set to the list every time you start the software. If you want the data for 
the data set to be loaded automatically on start-up you can select the Always load the data for this 
set on startup box.
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15.2.2 To Load the Data
Adding a data set to Viz World Classic does not load the map data by default. This prevents very 
large data sets being loaded before you are ready to use them. You can instruct Viz World Classic 
to automatically load the data for a set, in the Import Data Sets dialog box (see how To load a data 
set definition), or you can load the data manually when you need it as follows:

Click the Imported Data tab in the map layer’s Contents panel to display the data sets you 
have imported. The data set definitions are shown in the left list.

Click the data set you want to import with the right mouse button and select Load Data from 
the appearing context menu.

You can unload a data set (for example to free up some memory to load a different set) at any time 
by clicking the set with the right mouse button and choosing UnLoad Data from the appearing 
context menu.

15.2.3 To Use Imported Map Data
You can expand the tree to show the data layers and subsets for each data set.

Select the data layer or subset in the Imported Data list to show the features it contains.
Click each data layer, subset, or feature with the right mouse button and select Add to map
from the appearing context menu, or click the Add To Map button to add it to the map layer.
You can also search for imported features in the Search panel, in exactly the same way as for 
built-in map data.

15.2.4 To Add Labels to Imported Data Features
Initially the features in imported data are drawn unlabeled, but you can add labels to selected 
features to label them on the map just as you would with other map details.
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Select the Browse Imported Data tool.

As you move this over the map the tool tip shows you the name of each imported data 
feature.

Right-click and from the appearing context menu click the appropriate label option.

If you are labeling a street, the label is drawn aligned with the direction of the street. You 
can then use the Text tool to move or rotate the label as desired.
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16 Adding Text To A Project
Each map detail you select in your project is automatically provided with a text label, pinned to the 
map. Viz World Classic also allows you to add independent text layers to the project, each 
containing one or more separate text items, with precise control over the appearance of each item 
and the way in which they are animated. For example, you could use a text object to add a title to 
the animation, add legends to graphics incorporated in the animation, or label map features not 
provided in the map database.

You could also use a text label to label a map detail instead of the default label provided with the 
detail, for greater control over its appearance and the way it is animated.

Viz World Classic allows you to use any of the TrueType fonts installed on your computer and 
supports text in many international character sets. You can change the font used in the Viz World 
Classic user interface to ensure that the international character set you are using is displayed 
correctly.

This section contains information on the following topics:

Creating Text on a Text Layer
Manipulating Text Items
Editing Text
Defining the Text Layout
Defining the Appearance of Text Items
Animating Text Items
Defining the Properties of the Entire Text Layer

16.1 Creating Text On A Text Layer

 
This section contains information on the following procedures:

To Create Text on a Text Layer
To Create Additional Text Items
To Define the Default Text Properties
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16.1.1 To Create Text on a Text Layer
On the Layer menu, point to Add Layer, and then click Text.
Click in the Viewer to define the position of the text item. Alternatively you can drag to 
define the width of the text item.
Type the text you want to add:

16.1.2 To Create Additional Text Items
Select the New Text Item tool on the Contents panel.
Click or drag in the Viewer and type the text. The text items are displayed in the text items 
list.

To enter international characters not shown on the keyboard, such as accented characters, use the 
standard procedure for your computer system. Once you have created one or more text items on a 
text layer you can edit them or change their appearance using the panels on the Contents panel.
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16.1.3 To Define the Default Text Properties

On the Styles menu, click Default Text Properties. The above dialog box allows you to specify the 
default font, size, style, spacing and color for new text layers.

16.2 Manipulating Text Items

16.2.1 To Move Text

Select the Text tool in the toolbar. This tool is automatically selected when you create a new 
text item.
Drag the text by the position handle.

16.2.2 To Resize a Text Item
Drag one of the handles on each side of the text item. The text is wrapped to fit in the text item.
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16.3 Editing Text

The options on the Edit panel (depicted above) allow you to edit the font, size, style, and color of 
selected characters, change the alignment of the text, and edit the stroke and keyline widths.

This section contains information on the following procedures:

To Edit the Text
To Specify Text Alignment
To Create Outlined Characters
To Add a Keyline around Characters

16.3.1 To Edit the Text
Either:

Select by marking the characters you want to edit in the Viewer.

Or:

Select the characters in the Edit panel.

Or:

Select the entire text by clicking the Select All  button in the Edit panel.
Select the font, size, style, fill color, and outline color using the controls at the top of the 
Edit panel.

16.3.2 To Specify Text Alignment
Click the appropriate button to the top right of the Edit panel.

16.3.3 To Create Outlined Characters
Select the Outline option.
Choose the stroke width from the Stroke Width pop-up menu. The character outlines are 
drawn with the specified stroke width in the fill/outline color.
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You can specify the fill and keyline colors individually for each character in a text item. 
Alternatively selecting Uniform Color makes all the letters have the same color. When Uniform 
Color is selected the text color can be animated.

16.3.4 To Add a Keyline around Characters
Choose the keyline width from the Keyline Width pop-up menu.
Select the characters you want to edit in the Viewer, or on the Edit panel, and click the 
keyline color box to specify the keyline color for the selected characters.

With filled characters the keyline is drawn as an outline around the characters:

With outlined characters the keyline is drawn as a double line around the outlines.

16.4 Defining The Text Layout

 
The options on the Layout panel (depicted above) allow you to move, scale, or rotate a text item, 
adjust the kerning, or align or space evenly multiple text items.

This section contains information on the following procedures:

To Move a Text Item
To Scale Text
To Rotate Text
To Adjust the Letter Spacing
To Align Several Text Items
To Space Several Text Items Evenly
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16.4.1 To Move a Text Item

Select the Move Text tool .
Position the mouse pointer within the text item.
Drag the text item to the new position:

 
This allows you to move a text item even if the position handle is out of view.

16.4.2 To Scale Text

Select the Move Text tool .
Drag one of the handles on the border of the text item:

Drag while holding down CTRL to scale the text proportionally.

16.4.3 To Rotate Text

Select the Move Text tool .
Point to the rotation handle, the yellow circle to the right of the center of the text item.
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Drag the handle to rotate the text item about its center:

16.4.4 To Adjust the Letter Spacing
Select the Text Kerning tool. The Viewer indicates the position of each character by a marker 
on the baseline:

Drag a marker to the left or right to adjust the spacing between the corresponding 
characters.
When you have finished kerning the text, click the Text Kerning tool again.

16.4.5 To Align Several Text Items

Select at least two text items in the list, using SHIFT to select multiple items.
Choose the appropriate alignment option from the Align context menu (see above).

Tip: You can reset the default kerning of the text by clicking the Reset button.
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16.4.6 To Space Several Text Items Evenly

Select at least three text items in the list, using SHIFT to select multiple items.
Choose the appropriate alignment option from the Space Evenly context menu.

16.5 Defining The Appearance Of Text Items
The options on the Properties panel allow you to specify, the appearance of individual text items, 
including the compositing options, spacing, transformation, drop shadow, frame, or animation 
trail:

 
This section contains information on the following topics:

Appearance Options
Spacing Options
Transform Options
Drop Shadow Options
Frame Options
Trail Options
Instant Maps Export
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16.5.1 Appearance Options

 
The Appearance options allow you to specify the rendering style of the text, apply a texture to the 
text, and animate its writing.

To fill the text with a texture choose Solid from the Style pop-up menu, and click the + button to 
select an image file for use as the texture:

 
Use the Opacity and Softness controls to adjust the opacity of the text, and blur the edges of the 
text.

The Write On options (text layers only) allow you to animate the way in which the text appears, to 
cause it to appear to be typed on as the animation progresses.

Choose Characters from the Write On Style pop-up menu to make the text appear character 
by character, or Words to make it appear word by word.

Set the Write On Amount to 0  at the frame where you want the animation to begin, and to 

100  at the frame where you want the animation to end.

16.5.2 Spacing Options

 
The Spacing options allow you to adjust the character and line spacing for the text item.
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16.5.3 Transform Options

 
The transform options allow you to specify the position, scale, rotation, and origin 
numerically. The Origin determines the point about which the text item is rotated or scaled, and 
defaults to North, or the top center of the text item.

Choose one of the predefined options from the Origin pop-up menu, or edit the X and Y origin 
values to specify the origin in pixels relative to the lower left corner of the text item.

16.5.4 Drop Shadow Options

 
Select Drop Shadow to turn on a drop shadow for the text item. The following parameters are 
provided:

Parameter Description

Offset The offset of the drop shadow, in pixels.

Opacity The opacity of the drop shadow. 0%  gives no drop shadow.

Softness Blurs the drop shadow to smooth the edges. Values in the 

range 0–5  are recommended.

Color The color of the drop shadow.
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16.5.5 Frame Options

 
Allows you to add a colored fill, and/or border to the text item.

Border Width specifies the width of the border in pixels.

16.5.6 Trail Options

 
The Trail options allow you to leave a trail as the text item animates.

16.5.7 Instant Maps Export

 
Allows you to make maps available to the Viz World Instant Map tool.

See Also

Leaving an Animation Trail
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16.6 Animating Text Items

The options on the Animation panel allow you to animate text items on text layers.

See Also

Match rotation to path and how To Align the Image, Text Item, or Drawing to the Angle of 
the Animation Path
Auto Animate and Automatically Animating a Layer
Edit Text Path and Animating an Image, Movie, Text Item, or Drawing Along a Path
Creating Tracking Paths

16.7 Defining The Properties Of The Entire Text Layer

In addition to being able to define the properties of individual text items, the Properties panel 
allows you to edit properties for an entire text layer.

16.7.1 Compositing Options

Blend Mode specifies how the layer is combined with the other layers, and can be one of:

Normal, Add, Subtract, Difference, Multiply, Darken Only, Burn, Color Burn, Screen, Lighten 
Only, Dodge, Color Dodge, Hue, Saturation, Value, Color, Overlay, Soft Light, Hard Light, Pin 
Light, Exclusion, or Negation.
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The Opacity determines the layer opacity, and can be animated.

16.7.2 Animation Options
Allows you to animate the entire text layer. The options are the same as for individual text items.
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17 Working With Cutouts
Viz World Classic allows you to cut out a selected area from the Viewer to create an image overlay 
called a cutout. You can use a cutout to paint onto an image or its mask, or you can convert one or 
more cutouts to a new image/movie layer.

This chapter contains information on the following topic(s):

Creating Cutouts
Moving and Transforming Cutouts
Defining the Appearance of Cutouts

17.1 Creating Cutouts

17.1.1 To Cut a Section of an Image

Select Cut: Image.
Select the New Cutout tool (button).
Select From: Layer to create a cutout from just the current layer, or From: Composite to 
create a cutout from the composited layers.
Drag to draw a rectangle defining the size of the cutout you want to create:
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The cutout is displayed in the Overlay list on the Cutouts panel:

You can then drag the cutout to displace it from the original image, or display it on another 
layer:

17.1.2 To Cut an Object Defined by a Mask
Draw a mask over the part of the image you want to cut out:

For more information see Specifying the Brush Settings.
Select Cut: Image and Cut: Mask
Select the New Cutout tool

Selecting Cut: Mask uses the image’s mask to cut out the image from its background.
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4. Drag to draw a rectangle defining the size of the cutout you want to create, enclosing the 
image:

The Move Cutout tool is automatically selected so you can drag the cutout to see it 
independently of the original image:

The cutout is available to any other layers in the project:

When using Cut: Mask, the Background removal options can be used to remove edge effects 
around the mask.

Assume Color allows you to specify a color to be removed from the edge of the mask, and 
Automatic uses the average color within the cutout rectangle, but outside the mask.
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17.1.3 To Create a Cutout Using the Magic Wand Tool
If the feature you want to cut out is clearly distinguished from its background, you can use the 
Magic Wand tool to mask the feature, and then create a cutout using the mask.

On the Graphics panel click the Magic Wand tool:

Display Mask is automatically selected in the paint controls to show the mask when you 
create it.
Click the feature you want to mask. If necessary, adjust the Tolerance control and click again 
with the Magic Wand tool until the feature is completely masked:

On the Cutouts panel select Cut: Image and Cut: Mask.
Select the New Cutout tool.
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Drag to draw a rectangle enclosing the feature:

Drag the cutout to see it independently of the original image:

17.1.4 To Stick a Cutout to an Image/Movie Layer
Select the cutout in the Overlay list.
Click the Stick button.

17.2 Moving And Transforming Cutouts
The options on the Layout panel allow you to move, scale, or rotate cutouts, or use them in other 
ways:
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17.2.1 To Move a Cutout
Select the Move Cutout tool. You can then move, scale, or rotate the cutout in exactly the same 
way as for images; see Moving, Resizing, or Rotating an Image.

17.2.2 To Flip a Cutout about the Vertical or Horizontal Axis
Click the Flip Vertical or Flip Horizontal button.

17.2.3 To Convert a Cutout to a Layer
Select the cutout in the Overlay list.
Click the Convert to Layer button. A new image/movie layer is created, above the current 
layer, containing the cutout.

17.2.4 To Use a Cutout for a Brush or Profile
Click the Use for Brush or Use for Profile button. The cutout appears in the Brushes or Profile list 
on the Brushes panel.

17.2.5 To Save a Cutout as an Image
Click the Save Image... button. You can save it in any of the standard image formats.

See Also

Moving, Resizing, or Rotating an Image
To Load a Cutout for Use as a Brush or Profile

17.3 Defining The Appearance Of Cutouts
The options on the Properties panel allow you to define the style, opacity, and softness of cutouts, 
add a drop shadow, and specify a transformation numerically:
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17.3.1 Appearance Options

 
The Appearance options allow you to specify the style of the cutout, and change its opacity or 
softness. Set the Style to Color to convert the cutout to a solid color, and use Fill Color to define 
the color. This is useful for creating shadows.

17.3.2 Transform Options

 
These allow you to specify the position, scale, rotation, and origin numerically. The Origin
determines the point about which the cutout is rotated or scaled, and defaults to Center.

Either:

Choose one of the predefined options from the Origin context menu.
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Or:

Edit the X and Y origin values to specify the origin in pixels relative to the lower left corner 
of the cutout.

17.3.3 Drop Shadow Options

 
Select Drop Shadow to turn on a drop shadow for the cutout.

The following parameters are provided:

Offset: Sets the offset of the drop shadow, in pixels.
Opacity: Sets the opacity of the drop shadow. 0% gives no drop shadow.

Softness: Blurs the drop shadow to smooth the edges. Values in the range 0-5  are 

recommended.
Color: Determines the color of the drop shadow.
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18 Lighting And Effects
Viz World Classic includes sophisticated lighting features and effects, to enable you to add shading 
and depth to your map animations, and give them a unique and distinctive appearance.

This section contains information on the following topics:

Using Lighting
Setting the Lighting Options
Changing the Position, Size, or Angle of the Light
Animating a Light
Using Style Lights
Add Image Effects to a Layer

18.1 Using Lighting
Each of the map, image, text or shape layers in your project can include one or more lights which 
you can use to focus the viewer’s attention, or add depth and perspective to the animation. Three 
different types of light are provided, and you can use these either individually or in combination to 
achieve a wide range of different effects.

Highlight: Gives the appearance of a light reflecting from a shiny surface.
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Spotlight: Casts a concentrated disc of light, with areas outside the beam remaining dark.

Diffuse light: Casts a diffuse disc of light, falling away gradually to the edges. For each type 
of light you can adjust the size and shape of the beam, the position, brightness, and color of 
the light.



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  277

•

1.

2.
3.

4.

5.

Combining lights: Impressive effects can be achieved by combining two or more lights on a 
single layer. For example, the image above uses a highlight combined with a diffuse light.

18.2 Setting The Lighting Options

The Lighting panel allows you to create and edit the lights on each layer.

18.2.1 To Add a Light to a Layer
Select the layer and click the Lighting tab to display the lighting options for the layer. 
Initially lighting is turned off, and no lights are defined.
Select Lighting on to turn lighting on for the layer.
Click the Add button to add a light to the layer. A new light is created with a default name, 
such as Light1.
Choose Highlight, Spotlight, or Diffuse from the Type drop-down menu to specify the type of 
light.
Use the Brightness control to adjust the brightness of the light.
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Use the Ambient Level control to adjust the background light level. This determines the 
brightness of parts of the layer that are not directly illuminated by one of the lights.

For map layers:

Click the Pin on map or Scale with map buttons to move and/or scale the light as the map 
layer is moved or zoomed.

18.3 Changing The Position, Size, Or Angle Of The Light
 When you add a light the Light tool is selected in the Lighting panel to allow you to move, 

scale, or rotate the light. The extent of the light is shown as a circle:

18.3.1 To Move the Light
Position the mouse pointer anywhere within the circle and drag the light to the required position.

18.3.2 To Change the Size of the Beam
Drag the outline of the surrounding circle.
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18.3.3 To Stretch the Beam in One Direction
Drag the light by one of the four handles on the surrounding circle:

18.3.4 To Change the Angle of the Light
Drag the handle extending from the center of the circle:

18.3.5 To Specify the Parameters of a Light Numerically
Edit the X, Y, Width, Height, and Angle values in the Lighting panel.



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  280

•

1.
2.

18.4 Animating A Light
 The Light Path tool allows you to manipulate the animation path along which a light is 

animated.

See Also

Animating an Image, Movie, Text Item, or Drawing Along a Path

18.5 Using Style Lights
You can make a particular combination of lights part of your house style by defining the lights in 
the Lighting panel of the Styles Editor. Any lights you define there are automatically applied to 
each map layer, with the names Style light 1, Style light 2, etc.

You can modify the characteristics of each style light within a particular layer to override the 
settings defined in the style sheet.

18.5.1 To Revert Style Lights to Stylesheet-defined Settings 
Click the Revert to Style or Revert All to Style buttons in the Lighting panel for the layer.

18.6 Add Image Effects To A Layer

18.6.1 To Apply One or More Image Effects to a Layer
Select the layer.
Click the Layer Fx tab to display the Layer Fx panel for the layer.

Every parameter of an effect can be animated. For more information see the Using the Keybars 
Panel section.
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18.6.2 To Add an Effect to a Layer
Click the arrow symbol to the left of a heading in the effects list to expand the list, and show 
the effects under that heading.
Select the filter and click the right arrow button to add it to the right-hand list of effects to 
be applied to the layer.

Each effect displays a set of controls to allow you to adjust its parameters.

18.6.3 To Determine the Order of Effects
The order of effects in the list determines the order in which they are applied. Select an effect in 
the right-hand list and click the UP ARROW or DOWN ARROW buttons to move it up or down in the 
list.

18.6.4 Layer Fx
The following layer effects are available:

Blur
Softness: Softens the layer, giving it an out-of-focus appearance.

Brightness/Contrast

Brightness: Adjusts the brightness, where 0.00  corresponds to normal brightness.

Contrast: Adjusts the contrast of the layer, where  0.00  corresponds to normal contrast.

Gamma: Adjusts the gamma of the layer, where  0.00  corresponds to normal gamma.

Saturation: Adjusts the color saturation of the layer, where  0.00  corresponds to normal 

saturation.
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Tint
Applies a tint color to the layer. The Tint Amount control allows you to adjust the degree of the 
tint.
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19 Controlling Animation
This section explains how to use the time slider to control the progress of an animation. It also 
describes how to use the Automatic Animation tool to set up impressive animations with a few 
simple clicks, and the Keybars panel to provide individual control over each component of a 
project.

This section contains information on the following topics:

Using the Animation Controls
Automatically Animating a Layer
Using the Keybars Panel
Getting Natural Motion
Displaying Detailed Information About a Feature
Animating an Image, Movie, Text Item, or Drawing Along a Path
Leaving an Animation Trail

19.1 Using The Animation Controls

 
The Animation controls allow you to choose which frame of the animation you are editing, and let 
you preview the finished project.

This section contains information on the following procedures:

To Specify the Time Display Format
To Move to a Specific Frame
To Move Frame by Frame
To Move to the Start or End of the Animation
To Move to the Next or Previous Key
To Expand the Slider Scale
To Show the Whole Project
To Select Continuous Playback

19.1.1 To Specify the Time Display Format
Choose the format as follows:

Format: Description
Timecode: Hour:Minute:Second:Frame.
Frames: Frame number.
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19.1.2 To Move to a Specific Frame
Either:

Edit the Current frame field.

Or:

Drag the time slider until the appropriate frame is displayed in the Current frame field.

19.1.3 To Move Frame by Frame

 Click the Step back or Step forward buttons.

19.1.4 To Move to the Start or End of the Animation

 Click the Start or End buttons.

19.1.5 To Move to the Next or Previous Key

 Click the Next Key or Previous Key button in the Animation controls.

19.1.6 To Expand the Slider Scale
Click the Range... button.

Tip: A key is a frame in which one or more properties have been edited.
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Select Part of project, and specify the Start time, and the End time or Duration, of the section 
of the project you want to work on:

Click the OK button.

19.1.7 To Show the Whole Project
Click the Slider Range button.
Select Whole project and click the OK button.

19.1.8 To Select Continuous Playback

 Click the Loop Play button to play repeatedly, restarting at frame 0 after the last frame.

 Click the Bounce Play button to play continuously, alternately forward and backwards.

19.2 Automatically Animating A Layer
Viz World Classic includes an automatic animation tool, to make it easy for you to add animation 
to any layer of your project.

It provides the following animations:

Slide: Allows you to slide the layer on and/or off in any direction horizontally, vertically, or 
diagonally.
Fade: Allows you to fade the layer on and/or off.
Write on: In addition, for text layers, you can animate the text so that it writes on, in 
characters or words.

This section contains information on the following procedures:

To Automatically Animate a Layer
To Animate the Position of the Layer
To Animate the Opacity of the Layer
To Animate the Writing of Text
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19.2.1 To Automatically Animate a Layer

 Select the layer you want to animate.

Either:

On the Layer menu, click Auto Animate.

Or:

Click the Properties tab to display the Properties panel for the layer.
In the Automation section click the Auto Animate button:

The Automatic Animation dialog box is displayed to allow you to specify how you want the layer to 
be animated:



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  287

1.
2.
3.

4.

5.

1.
2.
3.
4.

5.

1.

19.2.2 To Animate the Position of the Layer

Select Layer from the main menu and then Add Layer > Map.
Select the Properties tab and click the Auto Animate button.
In the Slide frame select Slide to current position and/or Slide from current position and 
choose the direction of the slide from the From and/or To drop-down menus.
Drag the keys on the time scale to adjust the extent of the slide. In the central white section, 
the layer is static at its current position, and in the black sections to the left of the first key 
or to right of the last key the entire contents of the layer are outside the image layer.
Select Cushion movement to include a smooth run-in and run-out.

19.2.3 To Animate the Opacity of the Layer

Select Layer from the main menu and then Add Layer > Map.
Select the Properties tab and click the Auto Animate button.
Select Fade on and/or Fade off.
Drag the keys on the time scale to change the rate the fade occurs. The white central area 
corresponds to 100% opacity and the black regions to the left of the first key and to the 
right of the last key correspond to 0% opacity.
Select Cushion fade to include a smooth run-in and run-out.

19.2.4 To Animate the Writing of Text

Select Layer from the main menu and then Add Layer > Text.
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Select the Contents tab and enable the New Text Item button and add a text to the layer.
Click the Animation tab and click the Auto Animate button.
Select Write on, and choose Characters or Words from the drop-down menu to specify how 
the text should be written.
Drag the keys on the time scale to determine the rate at which the text is written on:
The white section to the right of the right most key corresponds to all the text written on, 
and the black section to the left of the left most key corresponds to 0%.
Click the OK button to set up the animations you have specified for the layer.

Auto animate automatically sets up the Opacity, Position, and Write on amount (text layers only).

19.3 Using The Keybars Panel

For each layer in a project, the Keybars panel shows a keybar for each of the features that can be 
animated, grouped into categories such as Compositing Options, Transform, Drop Shadow, and 
Trail. You can click the arrow to the right of each layer or category heading to collapse it into a 
single bar, or expand it to show the keybar for each feature.

The animations in each layer are summarized in an overview bar, and this allows you to move or 
scale the whole layer’s animation in a single operation.

Each category also provides an overview bar, and you can use this to scale or move all the 
animations in that category.

In image layers containing a movie the overview bar also shows the extent of the movie, and you 
can drag this to change the start time of the movie.

This section contains information on the following procedures:

To Display the Keybars List
To Collapse or Expand the Keybars List
To Move the Animation for a Layer or Category
To Scale the Animation for a Layer or Category
To Add a Key
To Change the Position of a Key
To Cut, Copy, Paste, or Delete a Key
To Delete All Keys on a Keybar
To Delete All Keys for a Layer
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19.3.1 To Display the Keybars List
Click the Keybars tab.

19.3.2 To Collapse or Expand the Keybars List
Click the triangle to the right of the layer name or category name. Selecting a layer automatically 
collapses the keybars for the other layers.

19.3.3 To Move the Animation for a Layer or Category
Drag the layer or category overview bar.

19.3.4 To Scale the Animation for a Layer or Category
Drag the yellow triangle at either end of the layer or category overview bar.

19.3.5 To Add a Key
Either:

Right-click the keybar and click Add Key on the pop-up menu:

Or:

Click to position the marker where you want to add the key.
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Click the Add Key button:

A key is also added automatically at the current frame position, when you change the setting of 
any feature that can be animated.

19.3.6 To Change the Position of a Key

Drag it along the keybar with the mouse pointer. The cushion bars on either side of the key are 
scaled in proportion to the distance to the key and the keys on either side.

19.3.7 To Cut, Copy, Paste, or Delete a Key
Either:

Click on the key with the right mouse button and click the appropriate command on the 
pop-up menu:

Or:

Click the key to select it. The key turns red.
Click the appropriate button:

The cushion bars for the keys on either side are reset to their default positions.
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19.3.8 To Delete All Keys on a Keybar
Either:

Click the keybar with the right mouse button and click Clear Bar on the pop-up menu.

Or:

Click to position the marker in the keybar you want to clear.
Click the Clear Bar button.

19.3.9 To Delete All Keys for a Layer
Click any keybar with the right mouse button and click Clear Layer on the pop-up menu.

19.4 Getting Natural Motion
By default, Viz World Classic causes objects to move with a smoothly varying speed between 
keyframes. You can apply Smooth In/Out or Ease In/Out animation options to any key to achieve a 
more gradual acceleration or deceleration.

The following table summarizes the differences between the options:

 

Smooth In/Out: The rate of change of the property is constant through the key.
Ease In/Out:The rate of change of the property is stationary through the key.
For example, if the property being animated is an object’s position, with Ease In/Out the 
object slows down to a halt at the key, but with Smooth In/Out the object is moving with 
constant velocity through the key.

You can extend the cushion bars to increase the time either side of the key during which the 
object moves with constant velocity (Smooth In/Out) or decelerates and accelerates (Ease In/Out).

19.4.1 To Cushion Animation
Either:
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Click in the Keybars panel with the right mouse button and click the appropriate Smooth or 
Ease option on the pop-up menu:

Or:

Click the key to select it. The key turns red.
Click the appropriate button in the toolbar:

If you click on a key you can smooth or ease either or both handles for the key.

If you click between two keys you can smooth or ease the appropriate handles for both keys.

19.4.2 To Adjust the Cushion Bars
Point at the cushion bar with the mouse pointer, until the mouse pointer turns to a single-
headed arrow.
Drag the cushion bar to the appropriate position between the two keys:

Each cushion bar can be dragged as far as the adjacent key.

19.5 Displaying Detailed Information About A Feature
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You can display a graph showing the change in the value of any feature throughout the animation. 
You can manipulate the graph to change keys, cushion the animation, or add keys, as an 
alternative to working in the keybar.

19.5.1 To Display the Detail Graph
 Click the detail icon to the right of the feature name. The keybar expands to show the detail 

graph.

19.5.2 To Return to Keybar View
  Click the keybar icon to the right of the feature name.

19.6 Animating An Image, Movie, Text Item, Or Drawing 
Along A Path

Viz World Classic allows you to draw a smooth path, using Bezier curves, and animate an imported 
image, movie, text item, or drawing on a shape layer along the path.

This section contains information on the following topics:

To Create an Animation Path
To Convert the Path to a Curve
To Adjust the Path
To Align the Image, Text Item, or Drawing to the Angle of the Animation Path

19.6.1 To Create an Animation Path
Move to the first frame of the animation.
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Select the Path tool and drag the image, text item, or drawing to the initial location:

Move to the last frame of the animation.
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4. Drag the image, text item, or drawing to the ending position. A line is drawn to show the 
animation path, with dots indicating the position in each frame:
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19.6.2 To Convert the Path to a Curve

Move to an intermediate frame of the animation.
Drag the image, text item, or drawing. The path curves through the new position.
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19.6.3 To Adjust the Path

Drag one end of the tangent handles extending from a point on the curve:
Hold down CTRL to drag a tangent handle independently of the other one.
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19.6.4 To Align the Image, Text Item, or Drawing to the Angle of the 
Animation Path

Click the Match rotation to path button on the Properties panel for the image, text, or shape 
layer:

19.7 Leaving An Animation Trail
You can cause the map layer, text item on a text layer, image on an image/movie layer, or drawing 
on a shape layer to leave a trail as it animates by choosing the appropriate option from the Trail
drop-down menu in the Trail section of the Properties panel for the layer.

For example, you could leave a trail behind an image of a plane to show the route of a journey:
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19.7.1 To Leave an Animation Trail
Choose Behind, Ahead or Full from the Trail pop-up menu to leave a trail behind, ahead of, 
or on both sides of the path.
Use the Trail Width and Trail Color options to define the width and color of the trail, and 
select Trail Above to display the trail above the layer.
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20 Creating Tracking Paths
Viz World Classic includes a powerful tracking tool, which allows you to track features in a movie 
to create one or more tracking paths. These can then be used to automatically stabilize the 
tracked feature, or to match the tracking of another movie or image to that feature in creating a 
composite.

This section contains information on the following topics:

Creating a Track
Applying Tracking

The tracking tool lets you identify a distinctive feature in one frame of a movie, and then 
automatically track the feature throughout the movie to create a tracking path.

20.1 Creating Tracking Paths
You can create any number of tracking paths in a single movie, or across multiple movies. One 
track is needed to adjust for position, with two independent tracks the tracking tool can also 
adjust for scaling and rotation.

Additional tracks can be used to track independently moving objects. For example, if your video 
sequence shows two cars driving towards each other you can create a separate tracking path for 
each car, and then use these to superimpose a logo onto the side of each car.

You can also change the feature you are tracking mid-way through the movie. For example, if the 
feature goes out of view or behind an obstacle you can select an alternative feature, and then 
continue tracking from that point.

20.2 Applying Tracking Paths
Having created a tracking path you can apply it in several ways:

To the original movie to stabilize the image, keeping the tracked feature with the same 
position, scale, and rotation on the frame. For example this can be used to stabilize an 
interview filmed with a hand-held camera.
To a different image or movie to animate it, matching the movement, scaling, and rotation 
of the selected feature so that when the two sequences are composited they appear as a 
single, natural image.
To the points and shapes in a rotomatte, to match their movement, scaling, and rotation to 
the original movie.
To the position parameters of filters and effects; for example, to make a wipe follow a 
feature in a movie.
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20.3 Creating A Track
 On the Tools menu, click Tracker or click the Tracking button in the toolbar. The Tracker

dialog box is displayed to allow you to create one or more tracks.

20.3.1 To Create a Track
Click the + button to create a new track, and select it in the Tracks list.
Click the Edit Tracks button to indicate which feature of the image you want to track:

Two concentric squares are drawn in the Viewer with a + at their center.
Move the mouse pointer over the center square until it changes to a move symbol and drag 
the squares over the feature you want to track.
The center square acts as a magnifying glass to help you locate the feature accurately:

If necessary move the central + to the precise position you want to track. This is the pin 
position that determines the precise offset generated by the track. Usually, you leave this at 
the center of the inner square. The outer square determines the search area that the 
tracking tool scans at each frame when looking for the feature you have specified. Its size 
should be sufficient to cover the maximum movement in any direction from any frame in the 
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sequence to the next frame. It does not need to cover the area occupied by the feature of 
interest throughout the whole sequence.
Adjust the Presoften value to blur the image before matching the target; this helps tracking 
if the image is noisy, or includes a random feature such the rain.

20.3.2 To Start Tracking

Click the Track Next Frame  button to step forward a frame at a time, tracking the 
feature.

Click the Track Forward  button to start automatically tracking the feature from the 
current frame.

As tracking proceeds the Tracker dialog box plots a graph showing the quality of the track:

Higher values indicate a good match.

The tracking paths are shown in the Viewer as a white line with red dots at each track position:

20.3.3 To Correct a Tracking Path
The automatic tracking procedure may occasionally lose the feature being tracked. To correct for 
this:

Go to the last frame where the track was correct (or another earlier frame).
Hold down SHIFT and drag the tracking box. This leaves the tracking point itself unchanged, 
so that the points added to the motion path continue on the same track, but it uses a 
different area for subsequent detection. It is important to choose a different area which is 
moving in the same way.
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Click the Track Forward  button to continue tracking from that point. For example, if the 
feature being tracked goes out of sight or behind another object, you need to select another 
feature to track. When tracking an actor’s eye it may be necessary to manually position the 
tracking tool if the actor blinks. You can also track backwards or track the previous frame 
using the appropriate controls.

20.3.4 To Lock a Track

Click the lock icon to the left of the track name in the Tracks list. This is useful once you are 
satisfied with a track, to protect it from changes during subsequent tracking actions.

20.4 Applying Tracking
After creating one or more tracking paths you can apply these to any layer in your project. In 
addition, in a shape layer you can apply a tracking path to individual shapes in the layer.

20.4.1 To Stabilize a Movie
One application of tracking is to stabilize the movie that was used to generate the tracking path.

Select the movie layer in the Layers list, and click the Properties tab to display the Properties
panel for the movie.

In the Automation section click the Apply Track Data button:
The Apply Track Data Wizard is displayed to lead you through the steps needed to 
apply the track data to the image layer.



Viz World Classic User Guide -  23.0

Copyright © 2023  Vizrt                                                          Page  304

•

3.

4.

5.

•
•
•

6.

The first panel lets you specify the transformations you want to track:

Select Position, Rotation, and/or Scaling as required, and click the Next button to continue. 
If you have only recorded one track Rotation and Scaling are not available. The next panels 
let you select the tracks to use.
Select the first track and click the Next button to continue. If you are adjusting rotation and/
or scaling you are prompted to select a second track.
Select the track and click the Next button to continue. The next panel lets you choose how 
the transformations are applied:

Absolute: Aligns the pin position of the object with the current track position.
Relative: Displaces the object by the track position.
Stabilize: Applies the recorded tracks to the layer to stabilize it:

Click the OK button to apply the track information to the current image layer.
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21 Rendering A Project
This section explains how to render your project as a preview image or movie, or as a finished 
image or movie. It also describes the options for exporting an image or a 3D model from a project.

This section contains information on the following topics:

Rendering the Project
Displaying a Live Video Output
Exporting 3D Models
Creating GIF Images

21.1 Rendering The Project
Viz World Classic allows you to render your project as a movie or as a sequence of still images, 
one per frame, as separate sequentially numbered files. Alternatively you can render a single layer, 
or its layer mask.

This section contains information on the following topics and procedures:

Movie Formats
Image Sequence Formats
To Render the Animation
To Specify the Output Format

Frame Size
Timing
Format Options
Field Render

To Render a Single Layer

21.1.1 Movie Formats
The movie formats provide all the frames of the animation in a single file, optionally using 
compression to make the file smaller and improve playback rates. A number of different movie 
formats are supported, some of which are designed for playback on specific video output boards. 
The range of output formats available on your system depends on the operating system, the 
version of Viz World Classic you are using, and the presence of any optional video hardware.

Viz World Classic requires a QuickTime player for playing QuickTime movies on your computer 
monitor, and a Video Output player which can play QuickTime movies on the video output of 
compatible QuickTime video boards. Other video devices may be supplied with their own playback 
applications for movies rendered in their own native formats.

21.1.2 Image Sequence Formats
The image sequence formats provide a sequence of numbered files, one frame per file (for 
example, myanim0001.bmp, myanim0002.bmp etc.). The files can be in any of the formats 

http://www.apple.com/quicktime/download/
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supported by Viz World Classic. This can be a very useful format for exchanging images with other 
applications, many of which support single frame per file sequences.

When you first choose a file to render you are presented with a name untitled0000. This renders a 
sequence with four digits for the frame number as above. If you want to change the number of 
digits, edit the name (for example, untitled000 would use three digits for the frame number).

You can change the default filename format using the Numbering option in the File Formats
section of the Options dialog box:

21.1.3 To Render the Animation
On the File menu, click Render Project... or Render Project Preview....

Render Project Preview: Renders a low-quality version without anti-aliasing, and with 
no lighting effects.
Render Project: Produces a finished, high-quality version of the animation.

The Render dialog box is displayed to allow you to specify the output format and filename for the 
rendered movie, and specify the output settings:
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21.1.4 To Specify the Output Format
Choose the appropriate format from the Output dropdown menu.
Select Whole Project to render the whole project, or Part of the Project to render the range of 
frames specified in the Start, End and Dur fields.
Click the Frame Size..., Timing..., Format Options..., or Field Render... buttons to set up the 
corresponding options.

To render with an alpha (mask) channel select Render RGBA Movie (Millions of 
Colors+) and specify how the alpha channel should be treated by selecting one of the 
options from the drop-down menu.
Premultiplied alpha effectively superimposes the image on a black background; 
transparent areas of the image appear black, and semi-transparent areas of the image 
are mixed with black in proportion with their transparency.
Straight Alpha leaves the image unchanged.

Click the Render button to render the animation with the settings you have specified. While 
the animation is being rendered the progress bar in Viz World Classic’s status bar shows the 
progress of each frame, and the viewer shows the frame currently being rendered.

Frame Size
Allows you to set the frame size for the rendered movie:
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The default project sizes in Viz World Classic are square pixel versions of the popular PAL and 
NTSC video formats, suitable for displaying on a computer screen. When rendering final output Viz 
World Classic automatically scales the output images to the corresponding video formats (PAL 
video, NTSC video) to ensure that the images continue to look correct (video pixels are a different 
shape to computer pixels) on a video monitor. If you are outputting for further manipulation or 
use on a computer (in another software package) you should deselect Scale correctly for PAL 
(Video) output.

Timing
Allows you to set the frame rate for the rendered movie:

 
Note that changing the frame rate does not change the total time of the animation. For example, 
rendering a 25 FPS animation at 30 FPS simply generates more intermediate frames to ensure the 
animation plays out at the same speed.

Format Options
Allows you to change the compression and quality settings for the movie. The options available 
depend on the output format you have selected.

Field Render
Field rendering is a technique used to create smoother looking animations when creating output 
for video or broadcast. It takes advantage of the fact that most video is interlaced, each frame 
consisting of two fields displayed in turn:
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Enabling field rendering can produce a considerable improvement for certain types of animations, 
when played back on suitable video equipment such as a video output board or video tape. 
Rendering times are significantly increased however, as every frame requires two separate fields to 
be rendered and then combined. Animations for playback on a computer are generally rendered 
without field rendering.

The Upper field first and Lower field first options determine the field ordering for the rendered 
output.

Animations rendered with incorrect field ordering can appear jumpy and distorted. The correct 
setting can vary with your desired output type (PAL or NTSC) and the video equipment you are 
using.

The Flicker Filter option applies a small amount of softness to the rendered output. This can help 
to prevent slight flickering which can sometimes be a side-effect of field rendering.

To Render a Single Layer
Rendering a layer outputs the layer as it appears in the project at project size, including the layer’s 
transformation and any filters.

Select the layer you want to render.
On the Layer menu, click Render Layer... or Render Layer Preview....
Proceed as described in To Render the Animation.

21.2 Displaying A Live Video Output
The image displayed in the Viewer can be transferred directly to the video outputs of supported 
video cards, for previewing images on a broadcast monitor, or transferring single frame images 
directly to video.
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21.2.1 To Select Live Video Output
On the Video menu, click Video Device setup.... The Video Board option in the Video section 
of the Options dialog box is displayed:

Select your video board from the drop-down menu.
Select Show live video output.

The Apply flicker filter option adds a slight vertical blur to the image, to prevent flickering of very 
fine horizontal images such as roads and rivers.

21.3 Exporting 3D Models
An option is available to allow you to output a 3D model of the land relief in a specified 3D object 
file format to allow you to import it into a suitable 3D package such as Maya, Softimage XSI, 3D 
Studio Max, ORAD CyberGraphics, or Discreet Frost. Alternatively you can export the 3D model to 
Viz Artist.

The texture can be output at the same time, to color the relief, and this can optionally be scaled 
up to provide more detail on the resulting 3D model:
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This section contains information on the following procedures:

To Export the Currently Selected Map Layer as a 3D Model
To Preview the 3D Model
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21.3.1 To Export the Currently Selected Map Layer as a 3D Model
On the File menu, click Export 3D Model. The 3D Export dialog box allows you to specify the 
filenames for the model and texture, and optionally preview the result in the 3D Viewer:

Select the 3D object file format from the Export 3D Model to drop-down menu.
In the 3D Model Export section, click the Browse... button, and specify a name for the 3D 
model.
If required, edit the Grid Resolution and Smoothing, to determine the mesh used for the 3D 
model.
In the Texture Export section leave Export Texture for Model selected if you want to export a 
texture bitmap, and select Export Material File if you also want to export the texture as a 
material file.
Choose the format from the Format drop-down menu.
Click the Browse... button, and specify a name for the texture file.

The Frame Size... button gives you the option of scaling the image to a different frame 
size; for example to provide greater detail on the resulting model. Note that this 
produces a true optical scaling of the image, whereas changing the project size leaves 
features, such as road and river line thicknesses, unchanged.
For certain formats the Format Options... button gives you control over of the 
parameters of the format.

Select Preview Result in 3D Viewer to preview the exported files in a 3D viewer.
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Click the Export button to export the model.

21.3.2 To Preview the 3D Model
If you checked Preview Result in 3D Viewer in the 3D Export dialog box, the 3D model is displayed 
in the 3D Viewer for previewing.

Drag the model to change the viewpoint.
Hold down CTRL and drag up and down to zoom in and out respectively.
Hold down SHIFT and drag up and down to increase or decrease the scale of the relief.
Hold down ALT and drag left and right to rotate the model about the viewpoint.
Click the Play button in the toolbar, or choose Play from the File menu, to rotate the model 
continuously.

21.4 Creating GIF Images
Viz World Classic cannot create or render GIF format images by default. It works with some 
commercially available third-party GIF creation applications to allow creation of GIF images.

Supported applications are as follows:

Platform Application
PC FCoder 2GIF
Mac Lemke Software Graphic Converter

21.4.1 To Set up Viz World Classic for GIF Image Creation
Purchase and install one of the supported GIF creation applications. If you are running Viz 
World Classic on Windows, then you must specify the location of the 2GIF application.
On the View menu, click Options....
In the File formats section click Gif.
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4. Click the Browse... button and select the path of the 2GIF application:

The GIF file format and associated options are then available in image save, export, and 
render windows.


	Introduction
	Document Structure
	Related Documents
	Feedback and Suggestions

	About Viz World Classic
	Comprehensive Map Database
	Street Data Configured Ready for Use
	Projects, Layers and Other Elements
	Establish House Styles for Consistency Across Projects
	Shapes
	Rotoscoping with Shapes
	Animation
	Compositing and Animation
	Painting and Effects
	Sophisticated Lighting and Filtering Effects
	High-quality Output

	Installing Viz World Classic
	To Download the Software
	To Install Viz World Data
	To Install Viz World Classic
	To Add the License File
	To Add the License File Using Viz World Classic

	Quick Tour
	Getting Started with Viz World
	Creating a New Project
	Changing the Project Settings

	Toolbar
	View Options
	To Turn the Layers List, Panels, or Navigator into a Floating Palette
	To Hide the Layers List, Panels, or Navigator

	Viewer
	Keyboard Shortcuts

	User Interface Font
	To Change the User Interface Font

	Layers List
	To Display the Composite of All Layers
	To Display an Individual Layer
	To Show or Hide a Layer
	To Create a New Layer
	To Select a Layer
	To Rearrange the Order of Layers
	To Cut or Copy a Layer
	To Paste a Layer
	To Delete a Layer
	To Duplicate a Layer
	To Pin a Layer to a Map
	To Lock Two Map Layers Together
	To Rename a Layer

	Using the Content Manager
	To Display the Content Manager
	To Copy Content
	To Create a Luminance Mask
	To Key an Image Using a Mask
	To Create a Composite

	Controlling Layer Compositing
	To Specify the Compositing Options
	To Specify the Composite Mask Options
	To Use the Layer’s Paint Mask as a Key
	To Specify whether the Current Layer Obeys the Composite Mask
	To Specify whether the Current Layer Affects the Composite Mask
	To Specify How the Current Layer Affects the Composite Mask
	To Make an Image Go behind Selected Features in a Scene

	Animation Controls
	To Show or Hide the Animation Controls
	To Specify the Time Display Format
	To Move to a Specific Frame
	To Move to the Next or Previous Key
	To Expand the Slider Scale
	To Show the Whole Project

	Move/Pan Tool
	To Resize an Object
	To Rotate an Image, Text Item, or Drawing
	To Temporarily Select the Zoom Tool
	To Move the Pin Position

	Path Tool
	To Change the Animation Path
	To Change the Curvature of the Animation Path
	To Move the Tangent Handles Independently
	To Move the Tangent Handles Symmetrically

	Text Tool
	Zoom Tool
	To Zoom in
	To Zoom out
	To Temporarily Select the Move/Pan Tool
	To Move the Pin Position

	Map Rectangle Tool
	Browse Map Tool
	Browse Street/Shape Data Tool
	To Add a Section of a Street

	Ruler Tool
	To Measure a Distance
	To Specify the Distance Units

	Pick Color Tool
	Navigator
	Panels
	Properties
	Contents
	Lighting
	Layer Fx
	Keybars


	Working with Maps
	Creating a Map Layer
	To Create a New Project with a Map Layer
	To Add a Map Layer
	To Insert a Map Layer between Existing Layers

	Map Rectangle
	To Display the Map Rectangle
	To Resize the Map Rectangle
	To Move the Map Rectangle

	Setting the Map Properties
	Compositing Options
	Transform Options
	Drop Shadow Options
	Frame Options
	Trail Options
	Locator
	Map Legend
	Projection
	Automation

	Locating Features by Country or Region
	To Scroll to Any Country in the List
	To List Only Countries Visible in the Current Map View
	To Show/Hide Regions
	To Display a List of Features Contained in a Country or Region
	To Display the Currently Listed Features on the Map
	To Scroll Directly to a Feature

	Locating Features by Name
	Search Parameters
	To Display the Currently Listed Features

	Adding Map Details
	To Specify How Labels Scale with the Map
	To Reorder the Map Details
	To Remove a Map Detail
	To Add a Feature from the Explorer or Search Panel to the Details List
	To Add a Country or Region from the Map to the Details List
	To Redraw the Map to Fit a Feature
	To Center the Map on a Map Detail

	Adding Features to the Map Database
	To Define a New Feature on the Map
	To Define a New Feature from the Explorer

	Locating Features in Street Data
	Locating Features in Imported Data
	Adding Shape Overlays to Map Layers
	Adding Satellite Imagery
	To Add Satellite Imagery to the Base Map

	Adding Symbols
	To Add Symbols
	To Manage Symbols

	Defining the Style of Details
	To Apply a Predefined Style to a Detail
	To Redefine the Style Applied to a Map Detail
	To Override the Style of a Map Detail
	Color Panel
	Text Panel
	Strap Panel
	Texture CC Panel

	Setting the Properties for Details
	To Create Multi-line Detail Labels
	To Select an Alternative Label
	To Specify the Order of Alternative Place Names

	Setting Map Features
	To Display the Map Features Dialog Box

	Displaying Disputed Regions
	To Change the Assignment of Disputed Regions

	Using the Navigator
	To Choose a View
	To Change the View
	To Choose a Preset View
	To Define a Preset View
	To Edit the Name of a Preset
	To Delete a Preset
	To Enter a GPS Location

	Measuring Distances on the Map
	To Measure a Distance
	To Specify Distance Units


	Working with Styles
	How Stylesheets Work
	Multiple Stylesheets

	Creating, Saving, and Loading Stylesheets
	To Display the Styles Editor
	To Create a New Stylesheet
	To Rename a Stylesheet
	To Delete a Stylesheet
	To Copy Stylesheets from Another Project
	To Export an Individual Stylesheet
	To Import a Stylesheet

	Styles Panel
	Predefined Styles
	Strap Panel
	Texture CC Panel

	Topography
	To Specify the Topography
	Shading Panel
	Relief Color Panel
	Natural Earth Panel
	Natural Sea Panel
	Ocean Contours Panel

	Markers Panel
	To Load an Image for Use as a Marker
	To Edit the Name of a Marker
	To Delete or Replace a Marker
	To Edit a Marker

	Textures Panel
	To Load an Image for Use as a Texture
	To Edit the Name of a Texture
	To Delete or Replace a Texture
	To Display a Texture

	Lighting Panel
	Map Features Panel
	Global Map Data
	Local Street Data
	Scale Roads/Rail with Map

	Options Panel
	Using Imported Relief Data
	To Import CDM Relief Data
	To Import Relief Data
	To Obtain DEM Data
	To Undo DEM Imports
	To Use Multiple DEM Databases


	Reusing Design Elements
	Introduction
	Importing from a Project
	To Import from a Project

	Reusing Style Sheets
	To Share a Stylesheet between Projects and Users

	Using Templates
	To Create a Project Template
	To Specify a Template as the Starting Point for a Project
	To Set the Default Project Template
	To Share Project Templates

	Reuse Design Elements
	Reuse of Stylesheets
	Reuse of Layers
	Reuse of Navigator Presets

	Using Color Palettes
	To Edit the Color Palette
	To Select a Color
	To Pick a Color from the Viewer
	To Add the Current Color to the Palette
	To Delete a Color from the Palette
	To Create a New Palette
	To Save or Load Palettes

	Sharing Databases
	To Share User Map Details, Alternate Place Names
	Editing User Map Details or Alternate Place Names


	Working with Street Maps
	Using Street Data
	Loading Street Data
	To Specify the Location of Street Data
	To Load Street Data
	To Use Street Data
	To Display Street Data
	To Highlight Individual Features
	To Label a Feature

	Tracing Street Data

	Working with Images and Movies
	Curious Multi-Resolution Format
	Cineon Files
	Importing an Image or Movie
	To Import an Image or Movie
	To Convert an Image to a CMR Format
	To Convert Multiple Geo-referenced Images to a Single CMR Image
	Using Geo-referenced Images
	To Add Geo-referenced Images
	To Add Satellite Images

	Moving, Resizing, or Rotating an Image
	To Move an Image
	To Resize an Image
	To Rotate an Image

	Specifying the Contents of the Image
	Controlling Image Transparency
	To Set the Start Time and Looping

	Using the Keyer
	To Key an Image or Movie
	To View the Effect of the Keyer
	To Render the Keyer Matte
	To Cut an Image from a Blue Screen
	To Remove the Color Cast

	Image Rotoscoping
	To Create an Animated Shape
	To View the Effect of the Roto Matte
	To Render the Roto Matte

	Setting the Image Properties
	Compositing Options
	Transform Options
	Drop Shadow Options
	Frame Options
	Edging Options
	Trail Options
	Export Producer Options
	Instant Maps Export Options
	Automation Options
	Mask Options


	Painting
	Paint and Image Processing Tools
	Paint Controls
	Overlays
	Undo and Restore Options for Painting

	Painting Onto an Image
	To Paint the Image or Mask
	To Choose How the Mouse Cursor Displays while Painting
	Specifying the Brush Settings
	Creating and Editing Brushes
	Defining the Brush Source
	Defining Brush Filter Effects
	Defining Brush Profiles
	Managing Painted Materials

	Adding Graphics to Images
	To Draw a Quick Shape
	To Define the Drop Shadow
	To Flood Fill Areas of the Image or Mask


	Adding Image Effects
	Adding Image Effects to a Layer
	To Apply One or More Image Effects to a Layer
	To Add an Effect to a Layer
	To Determine the Order in which the Effects Are Applied

	Adding Paint Effects
	To Preview a Paint Effect
	To Apply the Paint Effect Permanently to the Image Layer
	To Restore the Image to its Previous State
	To Reset the Paint Effect Parameters to their Default Settings

	Image Effects
	Backgrounds
	Blurs
	Color Correctors
	Distort
	Effects
	Filters
	Grain
	Sharpen
	Transition
	Video
	Adobe After Effects Plug-ins


	Extracting Masks
	Introduction
	To Extract a Mask

	Mask Extract Tools
	Component Extract
	Luma Extract
	Chroma Extract
	Foreground Extract
	Background Extract
	Color Extract
	Hue Extract


	Automating with Macros
	Using Macros
	To Record a Macro
	To Replay a Macro
	To Save a Macro
	To Load a Macro

	Working with Shapes
	Introduction to Shapes
	Shape Layers
	Shape Overlays in Map Layers

	Creating Shapes on a Shape Layer
	To Create Shapes on a Shape Layer
	To Show or Hide a Shape on a Shape Layer
	To Edit a Shape on a Shape Layer
	To Rename a Shape on a Shape Layer

	Creating Shape Overlays
	To Create Shape Overlays
	To Rename a Shape
	To Change the Order of Shapes
	To Delete a Shape
	To Copy a Shape
	To Edit a Shape Overlay

	Shape Tools
	To Draw a Polygon, Bezier, or B-Spline Shape
	To Complete the Shape to Make an Area Shape
	To Complete the Shape to Make a Line Shape
	To Draw a Freehand Shape
	To Draw a Geometric Shape

	Cutting/Pasting and Exporting/Importing Shapes
	To Cut or Copy a Shape
	To Paste a Shape
	To Export a Shape
	To Import a Shape

	Editing Shapes
	To Move a Shape
	To Resize a Shape
	To Rotate a Shape
	To Move the Pin Position
	To Open a Shape
	To Divide a Shape
	To Join Two Shapes into One

	Editing Points
	To Activate or Deactivate a Point
	To Move One or More Points on the Shape Outline
	To Adjust the Curvature at a Point on a Bezier Curve
	To Adjust the Curvature at a Point on a B-Spline Curve
	To Add Points
	To Delete Points
	To Soften the Edge of a Shape

	Defining the Appearance of Shapes
	Appearance Options
	Transform Options
	Drop Shadow Options (not Rotoshapes)
	Motion Blur Options

	Animating Shapes
	To Fix a Shape
	To Remove the Keys
	To Animate an Individual Shape
	To Animate Individual Points on a Shape
	To Show the Keybars for a Shape

	Specifying How Shapes are Displayed
	Setting the Shape Layer Properties
	Compositing Options
	Transform Options
	Drop Shadow Options
	Trail Options

	Animating Shape Layers
	To Auto-animate the Entire Shape Layer
	To Animate the Entire Shape Layer

	Adding Shape Overlays to a Map Layer
	To Define the Properties of Shape Overlays
	To Draw Shape Overlays as Land, Water, etc.
	To Clip a Shape Overlay to Land
	To Draw Shapes by Tracing Map Features
	To Zoom or Pan while Tracing


	Working with ESRI Shape Files
	Setting up ESRI Shape File Data
	To Create a Data Set Definition
	To Edit the Data Set
	To Add Subsets to a Data Layer
	To Define the Style for Data Layers or Subsets

	Using ESRI Shape File Data
	To Load a Data Set Definition
	To Load the Data
	To Use Imported Map Data
	To Add Labels to Imported Data Features


	Adding Text to a Project
	Creating Text on a Text Layer
	To Create Text on a Text Layer
	To Create Additional Text Items
	To Define the Default Text Properties

	Manipulating Text Items
	To Move Text
	To Resize a Text Item

	Editing Text
	To Edit the Text
	To Specify Text Alignment
	To Create Outlined Characters
	To Add a Keyline around Characters

	Defining the Text Layout
	To Move a Text Item
	To Scale Text
	To Rotate Text
	To Adjust the Letter Spacing
	To Align Several Text Items
	To Space Several Text Items Evenly

	Defining the Appearance of Text Items
	Appearance Options
	Spacing Options
	Transform Options
	Drop Shadow Options
	Frame Options
	Trail Options
	Instant Maps Export

	Animating Text Items
	Defining the Properties of the Entire Text Layer
	Compositing Options
	Animation Options


	Working with Cutouts
	Creating Cutouts
	To Cut a Section of an Image
	To Cut an Object Defined by a Mask
	To Create a Cutout Using the Magic Wand Tool
	To Stick a Cutout to an Image/Movie Layer

	Moving and Transforming Cutouts
	To Move a Cutout
	To Flip a Cutout about the Vertical or Horizontal Axis
	To Convert a Cutout to a Layer
	To Use a Cutout for a Brush or Profile
	To Save a Cutout as an Image

	Defining the Appearance of Cutouts
	Appearance Options
	Transform Options
	Drop Shadow Options


	Lighting and Effects
	Using Lighting
	Setting the Lighting Options
	To Add a Light to a Layer

	Changing the Position, Size, or Angle of the Light
	To Move the Light
	To Change the Size of the Beam
	To Stretch the Beam in One Direction
	To Change the Angle of the Light
	To Specify the Parameters of a Light Numerically

	Animating a Light
	Using Style Lights
	To Revert Style Lights to Stylesheet-defined Settings 

	Add Image Effects to a Layer
	To Apply One or More Image Effects to a Layer
	To Add an Effect to a Layer
	To Determine the Order of Effects
	Layer Fx


	Controlling Animation
	Using the Animation Controls
	To Specify the Time Display Format
	To Move to a Specific Frame
	To Move Frame by Frame
	To Move to the Start or End of the Animation
	To Move to the Next or Previous Key
	To Expand the Slider Scale
	To Show the Whole Project
	To Select Continuous Playback

	Automatically Animating a Layer
	To Automatically Animate a Layer
	To Animate the Position of the Layer
	To Animate the Opacity of the Layer
	To Animate the Writing of Text

	Using the Keybars Panel
	To Display the Keybars List
	To Collapse or Expand the Keybars List
	To Move the Animation for a Layer or Category
	To Scale the Animation for a Layer or Category
	To Add a Key
	To Change the Position of a Key
	To Cut, Copy, Paste, or Delete a Key
	To Delete All Keys on a Keybar
	To Delete All Keys for a Layer

	Getting Natural Motion
	To Cushion Animation
	To Adjust the Cushion Bars

	Displaying Detailed Information About a Feature
	To Display the Detail Graph
	To Return to Keybar View

	Animating an Image, Movie, Text Item, or Drawing Along a Path
	To Create an Animation Path
	To Convert the Path to a Curve
	To Adjust the Path
	To Align the Image, Text Item, or Drawing to the Angle of the Animation Path

	Leaving an Animation Trail
	To Leave an Animation Trail


	Creating Tracking Paths
	Creating Tracking Paths
	Applying Tracking Paths
	Creating a Track
	To Create a Track
	To Start Tracking
	To Correct a Tracking Path
	To Lock a Track

	Applying Tracking
	To Stabilize a Movie


	Rendering a Project
	Rendering the Project
	Movie Formats
	Image Sequence Formats
	To Render the Animation
	To Specify the Output Format

	Displaying a Live Video Output
	To Select Live Video Output

	Exporting 3D Models
	To Export the Currently Selected Map Layer as a 3D Model
	To Preview the 3D Model

	Creating GIF Images
	To Set up Viz World Classic for GIF Image Creation



